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Introduction
This guide describes how to set up and manage Siebel eSales for selling over the 
Web.

Although job titles and duties at your company might differ from those listed in the 
following table, the audience for this guide consists of employees in these 
categories:

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications

Siebel Application 
Developers

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications
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How This Guide Is Organized
How This Guide Is Organized
Siebel eSales Administration Guide describes the tasks involved in implementing 
and configuring Siebel eSales using the following general organization: 

■ Performing setup and customization tasks necessary for using Siebel eSales

■ Creating and managing catalogs

■ Creating, customizing, and administering order management processes

■ Setting up and managing integrations to third-party software

An appendix provides detailed descriptions of the Shopping Service business 
service methods.

What’s New in This Release
The following topics are new for this release.

■ Microsite Management. Application administrators can now use templates to 
create portal pages to which you can add text as well as links to HTML pages 
and documents that can reside on any file server or Web server. Portal pages are 
useful for displaying marketing collateral, news articles, group news, financial 
information, press releases, and other kinds of unstructured content.

■ Category Display Templates. The number of catalog category display templates 
has been increased to five to give more options for how information can be 
displayed. The new templates are called Category Only and Multiselect 
Checkbox.

■ Product Availability Information. If you integrate with an external availability-to-
promise engine, consumers can check product availability information before 
making a purchase. The Shopping Cart displays the available dates and 
quantities for the selected products.

■ Enhanced Ordering Templates. Consumers create templates to store groups of 
products that they may want to buy in the future. They can now add products 
to existing templates from the Shopping Cart and catalog.
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What’s New in This Release
■ Integration Capabilities. You can display content from other Web sites. For 
example, you can display stock quotes or searches from another Web site on the 
same page as Siebel application data.

■ Shipment Tracking. If you integrate with an external shipment tracking system, 
consumers can track the shipment status of their orders through your Siebel 
eSales Web site.

■ Credit Check. If you integrate with a third-party accounts receivable or credit 
management application, you can check the credit standing of business 
customers who want to pay with a purchase order.

■ Improved Purchase Order Handling. A Web Corporate User can now place an order 
without having to enter a purchase order number. When this happens, the order 
is routed to the Web Purchasing Manager for the number to be added. Also, the 
ability to approve purchase orders can now be set for individual contacts. 
Previously, this ability could only be set for accounts.

■ Asset Management. Consumers can register their products, and manage product 
maintenance and warranties, through your Siebel eSales Web site.

■ Persistent Shopping Cart. Anonymous users (users who have added items to their 
Shopping Cart but who have not yet registered) will now be recognized when 
they return to your Siebel eSales Web site.

■ Deletion of Anonymous Shopping Carts. Anonymous Shopping Carts can now be 
automatically deleted after a set time.

■ Tax Calculation for Customizable Products. You can now automatically calculate tax 
on the individual components of a customizable product, allowing them to be 
taxed at different rates. Previously, a single tax rate was applied to the entire 
customizable product. This feature requires integration with Taxware 
applications.

■ Delegated User Responsibility. You can now select which responsibilities are 
visible to Web Delegated Customer Administrators.

■ Country Codes. More country codes have been added. If a country code that you 
want to use does not appear in a list of values drop-down list, you will need to 
activate it. For information about how to activate language codes, see 
Application Administration Guide.
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Siebel eSales Overview 1
This chapter provides an overview of Siebel eSales and the Siebel eSales Web site.
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Siebel eSales
Siebel eSales
Siebel eSales allows business-to-business and business-to-consumer selling over the 
Web. It offers:

■ Hierarchical multimedia product catalogs

■ Product search tools, including full-text search and parametric search based on 
product attributes

■ User-specified product comparison

■ Distributed catalog administration, allowing multiple-vendor catalogs

■ A history bar for easier catalog navigation

■ Customer profiling and personalization, using Siebel Personalization

■ Customizable order management processes, using Siebel Business Process 
Designer

■ Online Shopping Carts, quotes, and orders, which include:

■ A favorites lists of items, allowing customers to find and rebuy favorites

■ Quote templates for faster ordering

■ Order approval processes

■ Streamlined checkout processes

■ Integration with third-party taxation, credit checking, and payment 
processing applications

■ Integration with third-party fulfillment engines

■ The following optional modules:

■ Siebel eAdvisor for Web-based needs analysis

■ Siebel eAuction for dynamic pricing and auction creation and management

■ Siebel eConfigurator for Web-based product configuration

■ Siebel ePricer for one-to-one pricing and promotions using custom price lists
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The Siebel eSales Web Site
The Siebel eSales Web Site
When customers log in to a Siebel eSales Web site they see a home page like that 
in Figure 1. The home page provides an overview of the Web site and displays the 
accessible catalogs, auctions (if using the optional Siebel eAuction module), and 
recommended products. Registered users can also access their account information.

The Web site uses the templates provided with Siebel customer applications. One 
use of these templates is to create portal pages to which you can add text as well as 
links to HTML pages and documents. Portal pages are useful for displaying 
marketing collateral, news articles, group news, financial information, press 
releases, and other kinds of unstructured content.

For information on customizing Web pages, see Siebel Tools Reference. 

Figure 1. Siebel eSales Home Page
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The Siebel eSales Web Site
Customers link to other pages by clicking tabs or hyperlinks on the home page. The 
following pages display more detailed information:

■ Catalog. The Catalog page provides access to the products and services on your 
company’s Siebel eSales Web site.

■ Auctions. The Auctions page is where customers can view, create, and participate 
in auctions, provided your Web site uses the optional Siebel eAuction module.

For more information on auctions, see Siebel eAuction Guide.

■ Shopping Cart. The Shopping Cart stores the products and services selected by 
customers. Each line item in the Shopping Cart displays the reference price of 
the item, as well as the customer’s personalized price.
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The Siebel eSales Web Site
■ My Account. The My Account page allows end users to update their user profiles, 
as well as view their favorites, saved quotes, saved orders, and registered 
products. 

By registering and tracking their products, end users can receive product news 
or alerts, track warranty agreements, receive recommendations on scheduled 
services, and submit and track service requests related to their products.

Through the My Account page, end users can check their outstanding order 
status. They can also reorder items from their favorites list, templates, and 
orders.

Registered users with delegated customer administration privileges can add 
other users and edit user profiles. Delegated customer administrators can set the 
roles of other users within their accounts. The role indicates whether a registered 
user has both purchasing and administrative responsibilities.

All quotes and orders for a user are visible to that user on the My Account page, 
including those created in Siebel Sales, Siebel Call Center, and Siebel eAuction.

NOTE: If you do not want a user to be able to order a particular item from his or 
her favorites list or templates, you must delete the item from the appropriate 
price list or make it inactive. Removing the item from the catalog will not prevent 
the user from ordering that item.

NOTE: If your company also has a license for Siebel Orders, depending on your 
configuration, asset records may be created automatically. This does not prevent 
end users from registering products that they did not buy from your company. 
For more information about registered products, see Siebel eService 
Administration Guide.

■ Parametric Search. Parametric search allows users to take advantage of the class 
system by searching for products based on values of the attributes of those 
products. Instead of entering free-form search strings into a full-text search 
engine, users of parametric search can select from known attributes (for 
example, color, size, shape, and maximum temperature) of a particular class of 
products. They can then compare the products that result from their search.
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The Siebel eSales Web Site
■ Contact Us. The Contact Us page allows customers to contact your company for 
customer service or sales by email, mail, and fax. It also allows customers to 
locate the nearest branches of your company. See Siebel eService Administration 
Guide for additional information.
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Setup Tasks 2
This chapter describes how to set up Siebel eSales. It includes information about 
customizing the user interface, controlling user access, setting up responsibilities, 
and setting up price lists.
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Introduction
Introduction
Before Siebel eSales can be used, certain setup tasks must be performed. These 
include:

■ Installing Siebel applications

■ Customizing the user interface

■ Controlling user access to your Siebel eSales Web site, as well as to views, 
catalogs, categories, and products within the Web site

■ Setting up Siebel Personalization

■ Defining products, including classes and attributes

■ Setting up searching

■ Setting up shipping charge calculation

■ Encrypting credit card data using RSA

■ Customizing email notifications
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Installing Siebel Applications
Installing Siebel Applications
To install and use Siebel eSales, you must have the following:

■ Siebel Web Engine and Related Components. To deploy information on the Web, 
you must install Siebel Web Engine and the components on which it depends. 
These include a Web server, Siebel Gateway Server, and Siebel Server.

■ Siebel Applications. To perform administrative tasks such as server 
administration, creating catalogs, and managing Siebel Business Process 
Designer processes, you must install a Siebel employee application with the 
Siebel eSales license key provided.

For information about installing Siebel components, see the Siebel Server 
Installation Guide for the operating system you are using. For information about 
installing Siebel clients, see the appropriate client installation guide.
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Customizing the Framed and Unframed User Interface
Some of the modifications that you might want to perform to change the look and 
feel of your Siebel eSales Web site are the following:

■ Modifying Web templates

■ Changing colors

■ Modifying the behavior caused by clicking a button

■ Adding or removing applets

■ Changing controls

■ Making fields in forms required

■ Deploying Siebel eSales without using frames

For information on customizing the user interface, see Siebel Tools Reference.

Removing the Siebel eAdvisor Applet from Siebel eSales Web Pages
As an example of a user interface customization, if you are not using Siebel 
eAdvisor with Siebel eSales, it is necessary to remove the Siebel eAdvisor applet 
from the views listed in Table 1.

To remove the Siebel eAdvisor applet from a view

1 In Siebel Tools, lock the appropriate project.

Table 1. Views From Which to Remove the Siebel eAdvisor Applet

View Project in Siebel Tools

Product Catalog View (eSales) eCatalog

Product Catalog Category Detail View (eSales) eCatalog

Product Catalog Category Detail View - Product Basic (eSales) eCatalog

Home Page View (eSales) eSales

Product Detail - Features View (eSales) eSales - Quote
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2 Select the View object.

3 Query for the appropriate view.

4 Expand the View object, and then select View Web Template.

5 Select Base, expand the View Web Template object, and then select View Web 
Template Item.

The View Web Template Items list appears.

6 Delete eAdvisor GotoView Applet (eSales) from the View Web Template Items 
list.

7 Save the project.

8 Compile the .srf file, selecting the Locked projects radio button.

Implementing Siebel eSales Without Frames
Customer and partner applications use HTML frames for optimum compatibility 
when running with browser-based applications. HTML frames allow portions of the 
browser window to scroll independently of the rest of the window. For example, 
with HTML frames it is possible to place the main navigation in one frame and 
content in another frame. You can scroll the content while the main navigation 
remains in a fixed location.

Customer and partner applications can also be unframed. Siebel employee 
applications require frames and cannot be unframed.

Before choosing to unframe your application, consider the following limitation to 
using unframed applications with browser-based applications. In an unframed 
application, all UI elements exist in the same window. Therefore, the contents list 
may scroll off the page as a user scrolls down. This is a limitation of the unframed 
HTML environment and a factor in choosing to frame applications.

If you want to use a frameless deployment, refer to Technical Note Implementing 
Siebel Standard Interactivity Applications with a Non-Framed Banner on Siebel 
SupportWeb.
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Creating a Multilingual Web Site
Siebel eSales Web sites can be deployed in more than one language. For information 
about deploying Siebel applications in a multilingual environment, see Global 
Deployment Guide.
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Controlling User Access
You might want to perform some of the following tasks to control user access in 
your Siebel eSales Web site. 

■ Using external authentication, such as LDAP

■ Creating database users for LDAP to use in database access

■ Defining visibility for the following:

■ Views (see “Setting Up Default Responsibilities and User Types” on page 30)

■ Catalogs and categories (see “Defining Access Groups” on page 32)

■ Products (see “Setting Up Price Lists” on page 33)

■ Assigning the proxy employee

■ Creating users through registration or user administration

■ Associating users with accounts

■ Allowing various levels of access:

■ Anonymous

■ Implicit login

■ Explicit login

■ Customizing access to home and login pages

■ Using single sign-on functionality

■ Allowing another system to log in

■ Adding fields to registration forms

For information on controlling user access, see Security Guide for Siebel eBusiness 
Applications.
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Setting Up Default Responsibilities and User Types
Responsibilities control which views are visible to the user. Views, in turn, affect 
links and tabs. For example, if a user has a responsibility that does not permit access 
to My Company's Orders, no link will appear in the My Account view that allows 
access to that view. If no views within a business object are visible, the screen tab 
that maps to that business object will not be visible.

The responsibilities predefined for Siebel eSales are the following:

■ Web Anonymous User. Used to grant view visibility to anonymous users. Allows 
the user to access views that do not have the Requires_Explicit_Login flag set to 
TRUE.

■ Web Registered User. End user of the application in a business-to-consumer 
model.

■ Web Corporate User. End user of the application in a business-to-business model. 
Also acts as the base responsibility for Web Purchasing Manager and Web 
Delegated Customer Administrator.

Web Corporate Users are associated with an account and must be authorized by 
the Web Delegated Customer Administrator to access the site. A Siebel 
Administrator can also add new Web Corporate Users.

■ Web Purchasing Manager. Power user in the buying organization. Web Purchasing 
Managers have the ability to approve or reject orders placed by Web Corporate 
Users. They also have the ability to view all company quotes and orders, as well 
as to create, edit, and delete addresses in the corporate address book.

This responsibility only has views for access to company orders and quotes and 
company address book. Web Purchasing Managers must also have Web 
Corporate User responsibility to access Siebel eSales or Siebel eCustomer.

■ Web Delegated Customer Administrator. Power user in the buying organization. 
Web Delegated Customer Administrators have the ability to add and remove 
Web Corporate Users, Web Purchasing Managers, and other Web Delegated 
Customer Administrators within your organization.

This responsibility only has views for access to user administration. Web 
Delegated Customer Administrators must also have Web Corporate User 
responsibility to access Siebel eSales or Siebel eCustomer. For purchase order 
approval and corporate address book privileges, they must also be given Web 
Purchasing Manager responsibility.
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Web Purchasing Managers and Web Delegated Customer Administrators must have 
at least two responsibilities to see all of the views that they need, as described above 
in this section. In Siebel eSales, workflow logic and other application logic can 
depend on the job role of the user, so where a user has more than one responsibility, 
a separate field called User Type must be set at the same time as the responsibilities. 
Workflows and other application logic use this field for decision making in place of 
a responsibility. The user type should be set for the highest level of view access 
needed for each job role, according to Table 2.

NOTE: If you want to add a new responsibility that will be visible to Web Delegated 
Customer Administrators, you must set the Web Access field to Yes in the 
Responsibilities view of the Applications Administration screen. For more 
information about the Web Access feature, see Siebel eService Administration Guide.

For information on setting up responsibilities, see Security Guide for Siebel eBusiness 
Applications.

Table 2. Responsibilities and User Type

Job Role Responsibilities User Type

Web Anonymous User Web Anonymous User None

Web Registered User Web Registered User Web Registered User

Web Corporate User Web Corporate User Web Corporate User

Web Purchasing Manager ■ Web Corporate User

■ Web Purchasing 
Manager

Web Purchasing Manager

Web Delegated Customer 
Administrator

■ Web Corporate User

■ Web Delegated 
Customer Administrator

Web Delegated Customer 
Administrator
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Defining Access Groups
Access groups are defined in the Access Groups view under Group Administration.

An access group is a collection of any combination of positions, organizations, 
divisions, accounts, and user lists. For example, an access group could consist of 
several business-to-business (B2B) customers to whom you want to grant access to 
a particular catalog.

The members of an access group are instances of party types other than Person. In 
other words, its members cannot be individual people. A user is associated with an 
access group by being associated with a position, organization, division, account, 
or user list that is a member of the access group.

Once you have defined access groups, you can associate them with catalogs and 
categories. Access groups determine which catalogs and categories are visible to the 
user. When displaying a list of products, for example, in the catalog, the user will 
see only those products that are in categories accessible to that user.

For information on defining access groups, see Security Guide for Siebel eBusiness 
Applications.
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Setting Up Price Lists
Price lists set reference prices and promotional prices, and filter available products 
for a group or account.

When a customer logs in to the Siebel eSales Web site, the price list associated with 
the account is activated. The customer will only be able to view products that are 
both on the activated price list, and in catalogs and categories associated with the 
same access groups with which the customer is associated.

If the customer is not associated with a price list by being associated with an 
account, or if the account is not associated with a price list, the default price list is 
activated. For more information, see “Setting the Default Price List for the Siebel 
Application” on page 34.

For more information about price lists, see Pricing Administration Guide. For 
information on associating price lists with accounts for B2B customers, see 
“Associating Price Lists with Accounts” on page 148.
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Setting the Default Price List for the Siebel Application
In a business-to-consumer (B2C) setting, a customer might not be associated with 
an account, or his account might not have a default price list. Customers browsing 
your Web site anonymously cannot be identified, and hence cannot be associated 
with an account. For these customers, it is necessary to set a default price list that 
determines prices and product visibility.

To set a default price list for the Siebel application, you must:

■ Find the row ID of the price list.

■ Enter that row ID into the PRICER_MASTER_PRICE_LIST_ID list of values 
(LOV).

NOTE: You must update the existing PRICER_MASTER_PRICE_LIST_ID seed data 
row. Do not make the existing row inactive and then create a new one.

Finding the Row ID of a Price List
You can find the row ID of a price list in the Pricing Administration screen.

To find the row number of a price list

1 Navigate to Pricing Administration.

2 Select a price list.

3 Click the menu button and select About Record.

The About Record dialog box appears.

4 Record the row ID (Row #) of the price list.
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Setting the Default Price List
The price list row ID supplied as seed data in your Siebel application must be 
changed to the row ID of a price list that you have created. This is done in the List 
of Values view in the Application Administration screen.

NOTE: You must clear the LOV cache for the new price list to take effect.

To set the default price list

1 Navigate to Application Administration > List of Values.

The List of Values appears.

2 Query for the type PRICER_MASTER_PRICE_LIST_ID.

3 Enter the row number of the default price list in the Display Value field.

4 Click the menu button, and then choose Clear LOV Cache.
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Using Siebel Personalization
Siebel Personalization enhances your Siebel eSales Web site by showing to 
customers information that is specific to their profile, interests, and history. 
Personalized content includes greeting users by name, presenting them with 
content targeted to their needs and interests, showing them recommended 
products, and sending email messages addressed to them.

Siebel Personalization allows you to define rules to show and hide content 
dynamically during a user’s experience with Siebel eSales.

Personalization deployment rules can depend on data such as users’ personal 
profile information, date ranges, their company, products or services they have 
already purchased, or geographical information. User data can also be captured 
dynamically while the customer is browsing the Siebel eSales Web site.

The home page in Siebel eSales includes the salutation in the upper left corner, as 
shown in Figure 1 on page 19. This typically includes a personal greeting, but can 
be configured to provide targeted content such as product promotions, 
announcements, birthday greetings, and service request update notifications. The 
home page also contains a personalized list of recommended items.

Conditional expressions can be used to hide applets under certain conditions. The 
applets listed in Table 3 are hidden depending on the application, the type of user, 
and whether the applets have any records in them.

Table 3. Applets That Can Be Hidden

Applet Screen Effect of Conditional Expression

My Company Applet (eSales) My Account Hides corporate purchase information 
from customers who are not B2B power 
users (that is, do not have Web 
Purchasing Manager or Web Delegated 
Customer Administrator responsibility)

Quote Empty Form Applet 
(eSales)

Shopping Cart Shows Empty form when Shopping Cart 
is empty

Quote Form Applet - Current 
(eSales)

Shopping Cart Hides Shopping Cart header form when 
Shopping Cart is empty
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Personalization is principally managed using the Personalization Administration 
screen in your Siebel application. For information about administering 
personalization, see Personalization Administration Guide.

Quote Item List Applet 
(eSales)

Shopping Cart Hides Shopping Cart when empty

Recommended Product List 
Applet (eSales)

Home Page, 
Shopping Cart

Hides Recommended Products applet 
from Siebel eEvents and Siebel eTraining 
users

Table 3. Applets That Can Be Hidden

Applet Screen Effect of Conditional Expression
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Defining Products
Products are defined in the Product Administration screen in your Siebel 
application. Some of the tasks involved in defining products are:

■ Setting up the class system

■ Creating dynamic attributes

■ Defining product lines

■ Creating products

■ Associating literature and images with products

■ Defining related products

■ Creating customizable products

NOTE: You can also create new products using the Catalog Administration screen. 
For more information, see “Associating Products with Categories” on page 59.

For information on defining products, see Product Administration Guide.
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Full-Text Search
Siebel eSearch is the deployment of Siebel Search used for customer applications. It 
allows users to scan database tables and documents for pertinent information. 
Siebel Search uses Hummingbird SearchServer, a high-performance indexing and 
retrieval search engine. Siebel Search is included with every license of a Siebel 
application.

Siebel eSales includes a Siebel eSearch form that uses the Hummingbird 
SearchServer engine to scan database tables and documents in the Siebel File 
System. Users can perform searches from any screen.

Database records and documents in the Siebel file system that contain the criterion 
text are returned in the Search Results list. Search results are ranked according to 
relevance and sorted according to rank. Users can click on a linked field to see the 
detail for a record.

Implementing Siebel eSearch
Implementing Siebel eSearch includes:

■ Installing Hummingbird SearchServer

■ Setting up a directory for the search indices

■ Setting up ODBC drivers

■ Creating and indexing the search tables

For information about the installation and administration of Siebel Search, see 
Siebel Search Administration Guide.
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Predefined Search Definitions for Siebel eSales
Search definitions are created in Siebel Tools. By default, Siebel eSearch in Siebel 
eSales searches the business components shown in Table 4. This can be extended 
by creating additional search indices.

For information about creating search definitions for Siebel Search, see Siebel Tools 
Reference.

Table 4. Siebel eSales Predefined Search Definitions

Business Component Display Name Search Fields

Catalog Category Categories Description, Extended Description, Id, Name

eAuction Auction Item Auction Items Auction Name, Description, Featured

Product Products Description, Id, Name, Organization Id, 
Vendor, Vendor Part Number
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Setting Up Shipping Charge Calculation
Shipping charges are calculated for quotes as part of the checkout process. Siebel 
eScripts are used for the calculations and have been provided as templates. You 
should modify the scripts to reflect your shipping processes.

Shipping Calculation Process Workflow
The Shipping Calculation Process workflow is shown in Figure 2.

When the Shipping Calculation Process workflow is called by the eSales - Complete 
Checkout Process workflow (Figure 14 on page 103), the following events happen:

■ Siebel data is passed to the Shipping Cost Service (eScript) business service by 
the EAI Siebel Adapter business service, using the business service method 
argument SiebelMessage.

■ The Siebel eScripts in the Shipping Cost Service business service calculate the 
shipping charges based on the cost, the carrier, and the shipping method.

■ The results are passed to the Siebel database by the EAI Siebel Adapter business 
service, using the business service method argument SiebelMessage.

Figure 2. Shipping Calculation Process
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Business Services
Two business services are used as part of the Shipping Calculation Process 
workflow (Figure 2 on page 41), one of them twice:

■ EAI Siebel Adapter, in step 1: Get data from Siebel and step 3: Write data into 
Siebel

■ Shipping Cost Service (eScript), in step 2: Calculate Shipping Cost

The call to the Shipping Cost Service (eScript) business service sets the business 
service method argument values shown in Table 5.

Table 5. Business Service Method Argument Values

Business Service Method Argument Value

MapName CalculateShippingCost

SiebelMessage SiebelMessage is what is passed back and forth 
between the business service and the workflow. It 
contains the input and output information in a 
structured format.

Input Integration Object Name If you want to use this business service for another 
business component, you must create a new input 
integration object and define it’s value here. The 
value should match the equivalent value for the 
business service in the workflow. 

Output Integration Object Name If you want to use this business service for another 
business component, you must create a new output 
integration object and define its value here. The 
value should match the equivalent value for the 
business service in the workflow. 
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Integration Objects
Integration objects are used to pass static or dynamic values to business services. 
The architecture is modular, in that different integration objects can be created and 
used for the same core business service.

Shipping charge calculation uses the following integration objects:

■ ShippingCost - Quote (Siebel Output). Its integration components are shown in 
Table 6.

■ ShippingCost - Quote (Siebel Input). Its integration component is Quote, with the 
following fields:

■ Freight

■ Quote Number

Table 6. ShippingCost - Quote (Siebel Output) Integration Components

Integration Component Fields

Quote Account Id

Carrier Priority

Currency Code

Current Quote Ship To City

Current Quote Ship To Country

Current Quote Ship To Postal Code

Current Quote Ship To State

Quote Number

Shipping Method

Quote Item Line Total

Part Number

Quantity

Sales Product Flag
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For more information on integration objects, see Integration Platform Technologies: 
Siebel eBusiness Application Integration Volume II and Siebel Tools Reference.

Business Service Scripts
The following scripts are used in the Shipping Cost Service (eScript) business 
service:

■ (declarations). Sets the following values: Lower Ranges, Upper Ranges, Base 
Costs, and Rates. Associates the Type of carrier, Priority of the service, and Cost 
of the service.

■ CalculateShippingCost. Calculates the shipping cost based upon the information 
passed from the quote and the other scripts in the business service.

■ GetShippingMethodCost. Determines the shipping method and shipping carrier 
costs to use.

■ GetShippingRate. Determines the shipping rate to use.

For more information on business services, see Siebel Tools Reference.

Modifying Shipping Charge Calculations
Shipping charge calculations are customized in Siebel Tools by modifying the scripts 
that make up the Shipping Cost Service (eScript) business service.

For more information on Siebel eScripts, see Siebel Tools Online Help.

To modify shipping charge calculations

1 In Siebel Tools, lock the EAI Credit Card project.

2 Select the Business Service object.

3 Query for Ship*.

The Shipping Cost Service (eScript) business service appears.

4 Right-click Shipping Cost Service (eScript), and then choose Edit Server Scripts.

The server script editor appears.
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5 Edit the scripts, and then close the edit window.

6 Compile the .srf file, selecting the Locked projects radio button.
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Encrypting Credit Card Data Using RC2 Encryption
Credit card information is encrypted with RC2 encryption technology from RSA. The 
encrypted fields used in Siebel eSales are shown in Table 7.

CAUTION: Make sure that you back up the key file regularly. If the key file is lost, 
credit card data cannot be retrieved.

NOTE: If you are upgrading to Siebel 7.5, you must convert Siebel Systems’ 
proprietary encryption for these fields to RC2 encryption. To do this you must run 
an encryption upgrade script after the main upgrade script but before the Unicode 
upgrade.

For general information about RSA encryption, see Siebel Server Administration 
Guide and Siebel Tools Reference.

For more information about running the upgrade script, see the Upgrade Guide for 
the operating system you are using.

Table 7. Encrypted Fields in Siebel eSales

Business Component Field Table Column

Personal Payment Profile Account Number S_PER_PAY_PRFL PAY_ACCT_NUM

Quote Credit Card 
Number

S_DOC_ORDER CC_NUMBER

Order Entry - Orders Credit Card 
Number

S_SRC_PAYMENTS CC_NUM
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Customizing Notifications
Siebel eSales sends an email notification to a user when the status of that user’s 
order is changed to Confirmed or Shipped. Notifications of other events are also 
sent, for example when the orders of business-to-business customers are approved 
or rejected.

The tasks involved in customizing notifications for Siebel eSales are the following:

■ Setting up communications driver profiles

■ Modifying email workflows

■ Modifying email templates

For information on creating notifications, see Siebel Communications Server 
Administration Guide and Application Administration Guide.

Setting Up Communications Driver Profiles
Communications drivers send messages. They are accessed using communications 
driver profiles, which set parameters that can override those of the driver.

Communications drivers are part of the Siebel eSales application. Profiles are 
created in the Communications Drivers and Profiles view under the 
Communications Administration screen.

For information about setting up communications driver profiles, see Siebel 
Communications Server Administration Guide.

Modifying Email Workflows
Notifications in Siebel eSales are controlled by workflows. Workflows can be 
modified and new ones can be created.

For more information about Siebel eSales workflows for email notifications, see 
“Notifications” on page 112. For more information about defining rules to enable 
automatic email notification, see Siebel Business Process Designer Administration 
Guide.
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Modifying Email Templates
Templates provide the content for automated messages, such as confirmations of 
orders being placed and shipped.

To modify an email template

1 Navigate to Communications Administration > All Templates.

The All Templates view appears.

2 Select a template, for example Order Confirmation.

3 Make modifications to the template text.

You can also copy and paste available substitutions, such as [Street Address].

4 Click the Template Items tab to add preformatted files, such as a standard header 
or footer.
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This chapter describes how to work with catalogs and categories.
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Siebel Catalog
Siebel catalog provides core functions that are used by a number of applications to 
organize master data, for both administrative and display purposes. The data types 
used by some applications are shown in Table 8.

In Siebel eSales, catalogs allow customers to browse for products and literature of 
interest. If you also want your customers to be able to browse for training courses 
or event information, your company must also have licenses for Siebel eTraining or 
Siebel eEvents, respectively.

Siebel Sales Catalog, which allows employees to browse for products and literature, 
is available for use with the Siebel Quotes or Siebel Order modules of the Siebel 
Partner Relationship Management, Siebel Sales, and Siebel Call Center applications.

A catalog is a collection of items arranged in a logical hierarchy of categories. Many 
different kinds of content items can be grouped in catalogs in your Siebel 
application. Siebel catalog uses products and auction items. A schematic showing 
the relationships between a catalog, categories, and products is shown in Figure 3.

Table 8. Applications That Use Catalog Functions

Application Master Data Type

Siebel eSales ■ Products

■ Literature

Siebel Sales Catalog ■ Products

■ Literature

Siebel eTraining Training courses

Siebel eEvents Events

Siebel eAuction Auctions

Siebel eService ■ Solutions

■ Smartscripts

■ Literature

■ Resolution Items
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■ Categories can contain content items and other categories (called 
subcategories).

■ Each category can belong to only one catalog and one parent category.

■ Products can be associated with multiple categories.

Catalogs are created and managed using the following steps:

■ Setting up the catalog

■ Setting up its categories

■ Building the catalog hierarchy

Figure 3. Catalog Hierarchy
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Setting Up Catalogs
The tasks involved in setting up catalogs are:

■ “Creating Catalogs”

■ “Assigning Access to Catalogs” on page 54

■ “Selecting Languages for Catalog Translation” on page 55

Creating Catalogs
You create catalogs on the Catalogs page in the Catalog Administration screen.

To create a catalog

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Add a new record.

The Catalogs form appears under the More Info tab.

3 Fill in the fields listed in the following table using the form under the More Info 
tab.

Field Description

Name Required.

Description Brief description of the catalog.

Private Check the box if you want the catalog to be visible only 
to users who belong to the access groups associated with 
it.

If the catalog is private, all of its categories will also be 
private.

Effective Start Date Date when the catalog becomes visible to end users.

Effective End Date Date when the catalog stops being visible to end users.
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4 Fill in a number in the Sequence field in the Catalogs list.

Catalogs are displayed on the Siebel eSales Web site in ascending order by their 
Sequence field.

5 Click Save.

Active Select the check box to make the catalog visible to end 
users.

Catalog Type Choose Buying from the drop-down list if you want the 
catalog to be displayed on the Web site and in the 
employee application.

Catalog Type can be used to control what is displayed by 
setting search specifications on applets. For example, 
you could create two catalog types named Customer and 
Partner. You could then create a view with an applet that 
has a search specification to display only catalogs of 
type Partner and a second view with an applet that has 
a search specification to display only catalogs of type 
Customer.

Allow 3rd Party Listers No or Yes.

This is used for catalogs that will contain auction items.

For more information on auctions, see Siebel eAuction 
Guide.

Interactive Designer Project Siebel Interactive Designer project with which to 
associate the catalog.

This is used to place a Get Advice hyperlink next to the 
name of a catalog in the Product Catalog View (eSales) 
view. For more information about how to create a Siebel 
eAdvisor pageset, see Siebel Interactive Designer 
Administration Guide.

Image Image file associated with the catalog.

Field Description
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Assigning Access to Catalogs
Access groups control which groups of users can see particular catalogs. Access 
groups are associated with catalogs under the Access Groups tab in the Catalog 
Administration screen.

For information on creating access groups, see Security Guide for Siebel eBusiness 
Applications.

To associate an access group with a catalog

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Select a catalog in the Catalogs list.

3 Click the Access Groups tab.

The access groups associated with the catalog appear.

4 Add a new record to the Access Groups list.

A dialog box appears.

5 Select an access group, and then click Add.

The access group appears under the Access Groups tab.
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Selecting Languages for Catalog Translation
You can set up your catalogs in multiple languages. This is done under the Catalog 
Translations tab in the Catalog Administration screen.

For more information on creating multilingual Web sites, see Global Deployment 
Guide.

To choose a language for translation

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Select a catalog in the Catalogs list.

3 Click the Catalog Translations tab.

4 Add a new record to the Catalog Translations list.

5 Click the Code field select button.

The Language Name dialog box appears.

6 Select a language, and click OK.

The language name and code appear in the Catalog Translations list.

7 In the Description field, type a description of the catalog in the new language.
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Setting Up Categories
Categories group content items, such as products, literature, and auctions. The tasks 
involved in setting up categories are the following:

■ Creating categories

■ Associating products with categories

■ Associating auctions with categories

■ Updating the category item count (and removing it if necessary)

■ Setting display templates for categories

■ Assigning access to categories

■ Selecting languages for category translation
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Creating Categories
Categories are created in the Catalog Administration screen under Categories. They 
are displayed on the Siebel eSales Web site in ascending order by their Sequence 
field.

To create a category

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Click the Name hyperlink for the catalog to which you wish to add categories.

The Categories list displays the categories belonging to that catalog.

3 Add a new record.

The Categories form appears under the More Info tab.
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4 Fill in the fields listed in the following table, and then click Save.

Field Description

Name Required.

Display Name Required. Name that the Siebel eSales Web site visitor sees.

Sequence Sequence in which categories are displayed, in ascending order 
starting with 0.

Description Brief description of the category.

Effective Start Date Date when the category becomes available for use.

Effective End Date Date when the category stops being available.

Active Check the box to make the category available.

Private Check the box if you do not want the category to inherit access 
properties from its parent category.

If the parent category has been marked private, this category 
also must be private.

Usage Type of category. Choose one from the picklist.

Display Template Template for displaying the category on the Siebel eSales Web 
site. Choose one from the drop-down list.

For more information, see “Setting Display Templates for 
Categories” on page 65.

Image Image file associated with the category.
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Associating Products with Categories
You add products to catalogs by associating them with categories that belong to 
those catalogs. This is done using the Products tab in the Categories view under the 
Catalog Administration screen.

NOTE: The Siebel eSales customer will only be able to view products that are both 
on the activated price list and in catalogs and categories associated with the same 
access groups with which that customer is associated. For more information, see 
“Setting Up Price Lists” on page 33.

For information on defining products, see Product Administration Guide.

To associate products with a category

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Click the Name hyperlink for a catalog.

The Categories list displays the categories belonging to that catalog.

3 Select a category with which to associate products.

4 Click the Products tab.

The products associated with the category appear.

5 Add a new record to the Products list.

A query pop-up window appears.

6 Enter query terms, and then click Go or Cancel.

The Add Internal Products dialog box appears with query results if you clicked 
Go, or with a list of products if you clicked Cancel.

7 Select products, and then click OK.

The products are associated with the category and appear under the Products 
tab.
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8 You can also click New in the dialog box.

This adds a new record under the Products tab, where you can enter information 
about the new product.
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Associating Literature with Categories
You can make literature available for consumers to view on your Web site by 
creating catalog categories and associating documents with them. Consumers 
would click the Literature Catalog link to access the catalog and documents. You 
can also create new applets for your Web site to display literature.

To add a document and associate it with a category

1 Navigate to the Catalog Administration Screen.

2 In the Catalogs list, select the eService Catalog catalog.

3 Click the eService Catalog hyperlink in the Name field.

4 Select a category or add a new one.

5 In the Literature list, click New.

The Literature form appears.

6 In the File Name field, click the select button and in the dialog box that appears, 
browse to the document.

7 Click Add.

8 Select a Literature Type and complete other optional fields.

Make sure that the Name field is unique.

For more information about working with literature, see Siebel eService 
Administration Guide.
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Associating Auctions with Categories
An auction must be associated with at least one category for it to be created. 
Auctions can be associated with categories using Siebel eSales, Siebel Sales, or 
Siebel Call Center.

Within Siebel eSales, a lister can create a new auction and associate it with the 
appropriate category using the Create Auction wizard. In the employee applications, 
an administrator can navigate to the appropriate category and create an auction 
using the Catalog Administration views.

For information on creating auctions, see Siebel eAuction Guide.
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Updating the Category Item Count
The category item count displayed at run time reflects the total number of items in 
each category. You must update it after adding new products to categories.

To update the category item count

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Click the name of a catalog.

The Categories list displays the categories belonging to that catalog.

3 Select a category.

4 Click the menu button under the Categories tab, and then choose Update Count.

The category item count is updated for that category.

Removing the Category Item Count
The category item count reflects the total number of items in the category. Certain 
users might not have access to all of the items in a category. If so, the count would 
not be accurate for those users.

If this does not meet your needs, you can use Siebel Tools to remove the display of 
the count from the following applets by making the count inactive:

■ Product Catalog RootSubCategory List Applet (eSales)

■ Product Catalog SubCategory List Applet (eSales)

To remove the category item count

1 In Siebel Tools, lock the eCatalog project.

2 Select the Applet object.

3 Query for the appropriate applet.
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4 Select Base, expand the Applet Web Template object, and then select Applet Web 
Template Item.

The Applet Web Template Items list appears.

5 In the Count row, select the Inactive check box.

The Count record text turns red.

6 Save the project.

7 Compile the .srf file, selecting the Locked projects radio button.
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Setting Display Templates for Categories
Display templates allow you to choose how categories and their products are 
displayed on the Siebel eSales Web site. They are associated with categories when 
the categories are created or edited. 

There are five display templates. Use Table 9 to help decide when to use a particular 
template.

The following procedure assumes that the category already exists. For information 
on creating new display templates, see “Creating New Display Templates for 
Categories” on page 71.

To set a display template for a category

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Click the name of a catalog.

The Categories list displays the categories belonging to that catalog.

3 Select a category.

Table 9. Category Templates

Template Comments

Add to Cart Use this when you want customers to move items from a list to 
the Shopping Cart one at a time. 

Category Only Use this for categories that have subcategories but no products.

Multiselect Checkbox Use this when you want the customer to select items from a list 
and move all selected items to the Shopping Cart at one time.

Product Basic Use this to include the name of the product, a description, and 
quantity.

Product Rich Use this basic template to include just the name of the product 
and a description.
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4 In the More Info form, select a template from the Display Template drop-down 
list.

The selected template will be used to display the category contents in the Siebel 
eSales catalog.
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Assigning Access to Categories
Access groups control which groups of users can see particular categories. Access 
groups are associated with categories under the Access Group tab.

To associate an access group with a category

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Click the name of a catalog.

The Categories list displays the categories belonging to that catalog.

3 Select a category.

4 Click the Access Groups tab.

The access groups associated with that category appear.

5 Add a new record to the Access Groups list.

A dialog box appears.

6 Select an access group, and then click Add.

The access group appears under the Access Groups tab.

For more information about creating access groups, see Application Administration 
Guide.
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Selecting Languages for Category Translation
You can choose the languages for which to translate category information. 

For more information on creating multilingual Web sites, see Global Deployment 
Guide.

To choose a language for translation

1 Select a category.

2 Click the Category Translations tab.

Languages for translation appear.

3 Add a new record to the Category Translations list.

4 Click the Code field select button.

The Language Name dialog box appears.

5 Select a language, and then click OK.

The language name and code appear in the Category Translations list.

6 Fill in the remaining fields in the following table, and then click Save.

Field Description

Display Name Name in the new language that the Siebel eSales Web site 
visitor sees.

Description Brief description of the category in the new language.

Extended Description More detailed description of the category in the new language.
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Building Catalog Hierarchies
Catalog hierarchies determine the structure and navigation paths of catalogs. 
Hierarchies are built and modified using the buttons in the Categories list. Table 10 
shows the four buttons that are used to promote, demote, move up, and move down 
categories.

To create subcategories

1 Navigate to Catalog Administration.

The Catalogs list appears.

2 Click the name of a catalog whose hierarchy you wish to modify.

The Categories list displays the categories belonging to that catalog.

3 Use the move up and move down buttons to place a category you wish to make 
a subcategory beneath the category you wish to make its parent.

4 With the child category selected, click the demote one level button.

The subcategory appears in a tree as a node below its parent. The tree can be 
expanded and collapsed.

5 Arrange other categories below the parent category as necessary.

Table 10. Buttons For Modifying Category Hierarchies

Button Function

Demote one level

Promote one level

Move up

Move down
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6 Select each category in turn and click the demote one level button.

The subcategories are placed in the tree below the other subcategory. The 
Sequence field can be used to display the subcategories in the correct order on 
the Categories page and on the Siebel eSales Web site.

7 Use the buttons as necessary to extend the catalog hierarchy.

Subcategories are displayed under categories on the Siebel eSales Web site in 
ascending order by sequence, and then in alphabetical order by display name.
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Creating New Display Templates for Categories
You create and edit display templates in Siebel Tools, and then add them to the 
Siebel eSales application using your employee application’s administration screens.

Use the following process to create a new display template:

■ Create a category detail view.

■ Add the view to the Siebel eSales Catalog screen.

■ Create drilldown objects for the view.

■ Edit its Web layout.

■ Add it to the Siebel eSales application.

NOTE: You must also add the view to the appropriate responsibilities, for example 
Siebel Administrator and Web Registered User.

The example shown in this section uses a display template called Product New, 
which uses a view called Product Catalog Category New Detail View (eSales).

For more information on creating Siebel views and applets, and on dynamic 
drilldown behavior, see Siebel Tools Reference.

Creating a Category Detail View
You create the view and add it to the Siebel eSales Catalog screen using Siebel Tools.

To create a detail view for the new display template

1 In Siebel Tools, lock the eCatalog project.

2 Select the View object.

3 Query for Product Catalog Category Detail View (eSales).

4 Copy the record, and then give the copy a new name, for example Product 
Catalog Category New Detail View (eSales).

5 Select the Screen object.
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6 Query for eSales Catalog Screen.

7 Expand the Screen object, and then select Screen View.

8 Add Product Catalog Category New Detail View (eSales) to the Screen Views list.
72 Siebel eSales Administration Guide Version 7.5, Rev. A



Creating and Managing Catalogs

Creating New Display Templates for Categories
Creating Drilldown Objects for the View
You create drilldown objects for the view using Siebel Tools.

To create drilldown objects for the view

1 In Siebel Tools, select the Applet object.

2 Query for Product Catalog RootSubCategory List Applet (eSales).

3 Expand the Applet object, and then select Drilldown Object.

The Drilldown Objects list appears.

4 Copy the Product Basic record.

5 In the new record, fill in the fields shown in the following table, leaving the rest 
the same as in Product Basic.

6 Expand Drilldown Objects, and then select Dynamic Drilldown Destination.

The Dynamic Drilldown Destinations list appears.

7 Copy the Product Basic record.

8 In the new record, fill in the fields shown in the following table, leaving the rest 
the same as in Product Basic.

Field Value

Name Product New

View Product Catalog Category New Detail View (eSales)

Field Value

Name Product New

Field Display Template Lang Indep Name

Value Product New

Sequence 3
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9 Repeat Step 6 through Step 8 on page 73 for the Product Basic and Product Rich 
drilldown objects.

10 Repeat Step 2 on page 73 through Step 9 for Product Catalog SubCategory List 
Applet (eSales).

Editing the Web Layout of the New Display Template
You edit the Web layout of the new display template using Siebel Tools, and then 
compile the project.

For more information on editing Web layouts, see Siebel Tools Reference.

To edit the Web layout of the new template

1 In Siebel Tools, select the View object.

2 Query for Product Catalog Category New Detail View (eSales).

3 Right-click on the view record, and then choose Edit Web Layout.

The Web layout appears.

4 Edit the layout, and then save it.

5 Compile the .srf file, selecting the Locked projects radio button.

Adding the New Display Template to the Application
To add the new display template to the application, you must do the following in 
the Application Administration screen:

■ Add the display template to the List of Values.

■ Add its view to the Views list.

■ Add its view to the appropriate responsibilities in the Responsibilities list.

To add the new display template and view to the application

1 Navigate to Application Administration > List of Values.

The List of Values appears.
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2 Add a new record.

3 Fill in the fields in the following table.

4 Choose Views from the Show drop-down menu.

The Views list appears.

5 Add a new record.

6 Fill in the fields in the following table.

7 Choose Responsibilities from the Show drop-down menu.

8 Add Product Catalog Category New Detail View (eSales) to the appropriate 
responsibilities, for example Siebel Administrator.

9 Restart the Siebel Server.

Field Value

Type PROD_CTGY_DISPLAY_TEMPLATE

Display Value Product New

Language Independent Code Product New

Language English-American

Field Description

View Name Product Catalog Category New Detail View (eSales)

Description Product Catalog Category New Detail View (eSales)

Local Access Check the check box.
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Creating Unstructured Content
Portal Pages containing unstructured content can be quickly created by application 
administrators to provide information such as announcements and press releases, 
and links to documents and HTML pages.

Siebel eSales includes one preconfigured portal page template, which is called 
Catalog Content View - News. It is a view that contains four empty applets. You are 
expected to modify this template to suit your needs.

To access the Catalog Content View - News template

1 Navigate to Microsite Administration.

2 From the Show drop-down list, select Page Administration.

3 In the Page List, select Web About Us.

4 Click the Web About Us hyperlink to access the page designer.

For more information about how to create and display portal pages that include 
unstructured content, see Siebel Employee Relationship Management 
Administration Guide.
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Users can also choose to search for products based on values of the attributes of 
those products. This is known as parametric search.

Parametric search allows users to take advantage of the class system. Instead of 
entering free-form search strings into a full-text search engine, users of parametric 
search can select from known attributes (for example, color, size, shape, and 
maximum temperature) of a particular class of products.

Users access parametric search by clicking the link next to the magnifying glass in 
the Links applet of the Siebel eSales home page.

This brings up the Parametric Search form. The user selects a product family. 
Attributes specific to the product family appear on the form below the product 
family. Search results appear to the right of the form.

The search can be narrowed by selecting attribute values from the drop-down 
menus under the attributes belonging to the selected product family.

NOTE: Parametric search returns only products that match the search criteria and 
have read-only attribute values. These products must also be on the active price list 
and be visible through access groups. For more information, see “Determining 
Which Products Are Returned from a Parametric Search” on page 79.

Making Classes Searchable
Product families are those classes that have been made searchable. Subordinate 
classes in the hierarchies of searchable classes are also searchable.

To make a class searchable

1 Navigate to Application Administration.

2 From the Show drop-down list, select Class Administration.

3 In the Classes list, select the class.

4 Place a check mark in the Searchable column.
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See Product Administration Guide for more information on the class system.
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Making Attributes Searchable
You can choose which attributes are searchable.

To make an attribute searchable

1 Navigate to Application Administration > Class Administration.

The Classes list appears.

2 Select a class, and then click its name.

The Classes list shows the dynamic attributes of the selected class.

3 Select an attribute that is not searchable.

4 Check the check box under Search.

The attribute is now searchable.

Determining Which Products Are Returned from a Parametric Search
Parametric search returns only those products that match the search criteria and 
whose attributes are read-only. Attributes for a product are made read-only when 
their values are set in the Dynamic Attributes view under the Product 
Administration screen.

See Product Administration Guide for information on setting attribute values.
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Initiating Parametric Search with a Product Family Selected
You might want to have the product family selected when the user accesses the 
Parametric Search page from the Know What You Want applet. This is done by 
passing class information to the Parametric Search form so that it appears with a 
default product family. This customization is done in Siebel Tools.

To set the parametric search product family

1 In Siebel Tools, lock the Parametric Search project.

2 Select the Applet object, and then query for Parametric Search GotoView Applet.

3 Expand the Applet object, and then select Applet User Prop.

The Applet User Properties list appears.

4 Make Class Name active and Instructions inactive.

NOTE: Instructions is normally active, in which case there will be no default class.

5 In your Siebel employee application, from the application level menu, choose 
View > Site Map > Application Administration > List of Values.

6 In the List of Values list, query for PARAMETRIC_SEARCH_CLASS_NAME.

7 Change the display value to the Class Name (not class Display Name) of the 
class you want to be the default.

8 Compile the .srf file, selecting the Locked projects radio button.

NOTE: If both user properties are enabled, Instructions takes precedence.

Removing the List Price Field from Parametric Search
You can remove the List Price field from a parametric search.

To remove the List Price field

1 In Siebel Tools, select the Business Component in the Object Explorer. 
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2 Query for the business component Parametric Search XA Object Attributes.

3 In the Object Explorer, select Business Component User Prop.

4 Select the Show List Price Attribute user property.

5 Change the Value from Y to N.
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Modifying Order Workflows 4
This chapter describes the seed-data workflows provided by Siebel eSales. You can 
use these workflows as starting points for workflow customization, based on your 
company’s business needs.
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Introduction
Siebel Business Process Designer provides a graphical interface for designing and 
implementing business processes and user interactions. Siebel eSales uses Siebel 
Business Process Designer to control order management processes.

Workflows are created using the Process Designer in the Workflow Processes view 
of the Business Process Administration screen. To access the Process Designer, click 
the name of a workflow. You can also select the process and click the Process 
Designer tab.

For information on creating and managing workflows, see Siebel Business Process 
Designer Administration Guide.
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The following features are among those built using Siebel Business Process 
Designer:

■ Rapid Checkout. Automatically associates primary address and credit card 
information with the order during the checkout process. If the user does not 
have primary information stored within the application, the process will direct 
that user to submit such information.

■ Purchase Approval Process. Applies an approval process in a business-to-business 
environment under the following conditions:

■ The account is approved to pay by purchase order and a purchase order is 
used as the payment method.

■ The amount of the order is greater than the auto-approval limit.

■ A user of type Web Corporate User placed the order.

■ Email Notifications. Sends an email notification to a user when that user’s order 
is accepted, awaiting approval, rejected, or shipped.

The following Siebel eSales processes use Siebel Business Process Designer:

■ Quotes and Templates

■ eSales - Edit Quote Process on page 88

■ eSales - Order Quote Process on page 89

■ eSales - Reprice Process on page 90

■ eSales - Save Cart Process on page 91

■ eSales - Add To Template Process on page 92

■ eSales - Delete Old Anonymous Quotes on page 94

■ Checkout

■ eSales - Checkout Process on page 95

■ Credit Check - Quotes on page 97
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■ eSales - Enter Shipping Details Process on page 99

■ eSales - Enter Payment Details Process on page 101

■ eSales - Complete Checkout Process on page 103

■ eSales - Authorize Order Process on page 105

■ eSales - Save Credit Card on page 107

■ eSales - Save Shipping Address on page 108

■ eSales - Save Account Shipping Address on page 109

■ eSales - Set Primary Account Address on page 109

■ eSales - Setting PO Status on page 110

■ eSales - Current User Type on page 111

■ Shipping Calculation Process on page 111

■ Notifications

■ Send Order Accepted Email (eSales)

■ Send Order Awaiting Approval Email (eSales)

■ Send Order Failed Email (eSales)

■ Send Order Rejected Email (eSales)

■ Send Order Shipped Email (eSales)

■ Purchase approval

■ eSales - Approve Order Process on page 113

■ eSales - Reject Order Process on page 114

■ Order modification

■ eSales - Cancel Order Process on page 116

■ eSales - Modify Order Process on page 117

■ eSales - Reorder Process on page 119
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■ Error messages and views

■ eSales - Display Error Process on page 121

■ eSales - Login View on page 122

■ eSales - Order Confirmation View on page 123

■ eSales - Shopping Cart View on page 124

■ Auctions

eSales - Silent Authorize Order Process

The following sections describe the major workflows involved in order management 
in Siebel eSales.

Quotes and Templates
A quote is an offer to sell a set of items at particular prices for a defined period of 
time. A template is a group of items that are frequently purchased together.

The Shopping Cart can be saved as a quote or a template. Saved quotes can be 
edited at any time. If a quote has not expired, it can also be ordered directly.
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eSales - Edit Quote Process
The workflow for editing a saved quote is shown in Figure 4.

The eSales - Edit Quote Process is called when a user clicks Edit Quote in the Saved 
Quote Detail view. The following events happen:

■ The process determines whether the Shopping Cart is empty.

■ If it is empty, the quote is moved to the Shopping Cart.

■ If it is not empty, the Edit Quote Confirmation pop-up view appears. The user 
has three choices:

■ Cancel. The process determines whether the quote is for an existing 
customer. If it is, the Customer Quote Detail View appears and the process 
ends. If it is not, the Saved Quote Detail View (eSales) view appears and the 
process ends.

Figure 4. eSales - Edit Quote Process
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■ Discard Cart. The Shopping Cart is emptied and the quote to be edited is 
moved to the Shopping Cart.

■ Save. If there is an error, the eSales - Display Error Process (see Figure 28 on 
page 121) is called, and then the user is sent back to the Edit Quote 
Confirmation pop-up view. For example, this would happen if the user tried 
to save a quote with a name that was already being used.

If there is no error, the Shopping Cart is saved as a quote and the quote to be 
edited is moved to the Shopping Cart (see “eSales - Save Cart Process” on 
page 91).

■ The Shopping Cart is repriced and displayed.

eSales - Order Quote Process
The workflow for turning saved quotes into orders is shown in Figure 5.

The eSales - Order Quote Process is called when a user chooses to order a saved 
quote in the Saved Quote Detail view in Siebel eSales. The following events happen:

Figure 5. eSales - Order Quote Process
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■ The process determines whether the quote has expired. If it has not expired, the 
eSales - Checkout Process (see Figure 10 on page 95) is called.

■ If the quote has expired, the process determines whether the Shopping Cart is 
empty.

■ If the Shopping Cart is empty, the quote is moved into the Shopping Cart and 
repriced. The user is sent to the Shopping Cart view.

■ If the Shopping Cart is not empty, the user has three choices:

❏ Cancel. The process determines whether the quote is for an existing 
customer. If it is, the Customer Quote Detail View appears and the process 
ends. If it is not, the Saved Quote Detail View (eSales) view appears and 
the process ends.

❏ Discard Cart. The current contents of the Shopping Cart are discarded. The 
quote is moved into the Shopping Cart and repriced, and then the user is 
sent to the Shopping Cart view.

❏ Save. The current contents of the Shopping Cart are saved as a quote. If 
there is an error, the eSales - Display Error Process (see Figure 28 on 
page 121) is called, and then the user is sent back to the Order Quote 
Confirmation view. For example, this would happen if the user tried to 
save a quote with a name that was already being used.

If there is no error, the quote is moved into the Shopping Cart and 
repriced, and then the user is sent to the Shopping Cart view.

eSales - Reprice Process
The workflow for repricing a quote is shown in Figure 6.

The items in the quote are repriced based upon the current price in the appropriate 
price list.

Figure 6. eSales - Reprice Process
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The eSales - Reprice Process is called by the eSales - Modify Order Process (see 
Figure 26 on page 117). Repricing a quote is its own process because the
eSales - Reprice Process is based on the Catalog business object, while the eSales - 
Modify Order Process is based on the Order Entry (Sales) business object.

eSales - Save Cart Process
The workflow for saving a Shopping Cart is shown in Figure 7.

The eSales - Save Cart Process is called when a user clicks Save As Quote. The 
following events happen:

■ The process determines whether the user has logged in explicitly.

■ If not, the user is sent to the Login view. The Pending Request flag is set so that 
after the user has logged in, the eSales - Save Cart Process is restarted.

■ If so, the Save Shopping Cart view appears, where the user has two choices:

■ Cancel. The user is returned to the Shopping Cart.

Figure 7. eSales - Save Cart Process
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■ Save As Quote. The Shopping Cart is saved as a quote. The process checks for 
error messages.

If there is an error message, the eSales - Display Error Process (see Figure 28 
on page 121) is called, and the user is sent back to the Save Shopping Cart 
view. This would happen, for example, if the user tried to save a quote with 
a name that was already being used. 

If there is no error message, the process determines whether the quote is for 
an existing customer. If it is not, the My Quotes view appears. If it is, the 
process determines whether the customer is a power user.

❏ If the customer is not a power user, the Customer Quotes View appears.

❏ If the customer is a power user, the eSales - Power Customer Quotes View 
process is called.

A power user is a delegated customer administrator or purchasing manager.

eSales - Add To Template Process
Customers create templates to store groups of products that they may want to buy 
in the future. The eSales - Add To Template workflow is used to add:

■ The entire contents of the shopping cart to a template.

■ Individual products from a catalog to a template.
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The workflow is shown in Figure 8.

The eSales - Add To Template Process is called when a user clicks the Add To 
Template button in the shopping cart or catalog product detail view. The following 
events happen:

■ The process establishes whether the customer has explicitly logged in. If the 
customer has not logged in, the eSales - Login View process is called to allow 
the customer to log in. If the customer has logged in, the process checks whether 
the customer has one or more existing templates. If the customer:

■ Has one or more templates, the Pick Quote Template View (eSales) appears 
and the customer either picks a template or chooses to create a new template.

■ If the customer chooses to create a new template, or does not have a 
template, the New Quote Template View (eSales) appears and the customer 
creates a template.

Figure 8. eSales - Add To Template Process
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■ If the workflow was launched from the Shopping Cart the line items from the 
Shopping Cart are added to the template. If the workflow was launched from a 
product catalog, the selected product is added to the template.

■ The template is saved. If there is an error, an error message appears and the 
Shopping Cart View is returned.

eSales - Delete Old Anonymous Quotes
The workflow for deleting old anonymous quotes is shown in Figure 9.

The Delete Old Anonymous Quotes process is called by a repeating server request 
according to the rules that you set up. For more information, see Chapter 6, 
“Administrative Tasks.”

Checkout
The following workflows are associated with checking out in Siebel eSales.

Figure 9. eSales - Delete Old Anonymous Quotes
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eSales - Checkout Process
The workflow that begins the checkout procedure is shown in Figure 10.

When a user clicks Check Out on the Shopping Cart, the eSales - Checkout Process 
is called. The following events happen:

■ The process determines whether the user is anonymous. Anonymous users are 
sent to the Login view using the eSales - Login View process (see Figure 29 on 
page 122). The Set Pending Request method of the Shopping Service business 
service is used to return users to the eSales- Checkout Process after they log in.

■ The process determines whether the Shopping Cart (quote) is associated with a 
contact ID. If it is not associated with a contact, the process ends.

Figure 10. eSales - Checkout Process
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■ The process retrieves the quote ID and, if there is no error, reprices the quote as 
needed. If there is an error, the Display Error Process is called (See Figure 28 on 
page 121) and the Current Quote view appears.

■ It determines whether the items on the quote are active products on the price 
list associated with the user. If not, the Quote Invalid Item view appears. The 
customer can choose to remove the invalid items and continue with the 
checkout process, in which case repricing is performed again. Alternatively, the 
customer can cancel, in which case the Current Quote view appears. 

■ For quotes that are valid, the process updates the quote record by entering the 
contact name in the Recipient Name field.

■ The process gets the application name. For certain applications, address 
validation is skipped in the Enter Shipping Details subprocess that follows.

■ Three subprocesses are called in succession: 

■ eSales - Enter Shipping Details Process (see Figure 12 on page 99)

■ eSales - Enter Payment Details Process (see Figure 13 on page 101)

■ eSales - Complete Checkout Process (see Figure 14 on page 103)

NOTE: The eTraining Enrollment subprocess is for use with Siebel eTraining. For 
more information see Siebel eTraining Guide.
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Credit Check - Quotes
The workflow for performing a credit check is shown in Figure 11.

The Credit Check process is called from the eSales - Authorize Order Process. The 
following events happen:

■ The process checks that the payment will be made with a PO. If it is not, the 
status of the credit check will be set to Not Applicable.

■ For orders that will be paid for using a PO, the process determines whether the 
Skip Credit Check check box is selected for the ordering account. If it is, the 
credit check is skipped. If it is not, the process determines whether the amount 
of the order is below the amount of the credit check threshold for the account 
(if one is set). If it is, the credit check is skipped. If the credit check is skipped, 
the Credit Status for the order is set to approved.

For more information about configuring credit checks, see Chapter 8, “Using 
Purchase Order Credit Checking Applications.”

■ The process checks that the billing information is complete. If not, the credit 
check status is set to Indeterminate. If there is enough information, the credit 
check is performed.

Figure 11. Credit Check Process
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To modify the Credit Check - Quotes Workflow

1 If you are using credit checking for Siebel eSales and Siebel Orders, and you 
want to use different logic for the two, make a copy of the Credit Check - Quotes 
workflow, and save it with a different name.

2 Modify the workflow.

3 Modify the eSales - Authorize Order Process so that it calls the new, modified 
credit check workflow.
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eSales - Enter Shipping Details Process
The workflow for selecting, entering, and modifying shipping information is shown 
in Figure 12.

Figure 12. eSales - Enter Shipping Details Process
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When shipping information needs to be entered or validated, the eSales - Enter 
Shipping Details Process is called. The following events happen:

■ If there is an error in the workflow, the eSales - Display Error Process workflow 
(see Figure 28 on page 121) is called.

■ If there is no error, the process determines whether the user has already selected 
an address. If so, it skips the address selection and entering steps.

■ If necessary, the process determines whether the customer has a User Type value 
of Web Registered User. Web Registered User users can choose personal shipping 
addresses from their address books or enter new shipping addresses. Users that 
do not have the Web Registered User Type choose account shipping addresses. 
If the account has no associated address, the number of account addresses is 
counted. If the address book is empty, the Account Shipping View appears, 
allowing the customer to enter an address. If there is more than one address, the 
Select Account Address View appears, allowing the customer to select a shipping 
address.

■ The process determines whether the address needs to be validated. For certain 
applications, such as Siebel eEvents Management, Siebel eTraining, Siebel 
Marketing, and Siebel Sales, it does not need to be validated. If necessary, the 
address selected or entered is validated, that is, checked to see that the required 
fields are completed. If it is invalid, an error message appears to the user and the 
process starts over again.

■ For customers who are associated with accounts, the process determines 
whether the account address should be saved and calls the Save Account 
Shipping Address subprocess (see Figure 18 on page 109), followed by the 
eSales - Set Primary Account Address subprocess (see Figure 19 on page 109). 
The latter process sets a primary address the first time an account user checks 
out.

■ For customers who are not associated with accounts, the eSales - Save Shipping 
Address workflow (see Figure 17 on page 108) is called.
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eSales - Enter Payment Details Process
The workflow for selecting, entering, and modifying payment information is shown 
in Figure 13.

When payment information needs to be entered, the eSales - Enter Payment Details 
Process is called. The following events happen:

■ If there is an error in the workflow, the eSales - Display Error Process (see 
Figure 28 on page 121) workflow is called.

Figure 13. eSales - Enter Payment Details Process
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■ If there is no error, the process determines whether payment has already been 
selected (that is, it has been called from the Order Summary view) or not (that 
is, it has been called from the Shopping Cart).

■ If the process was called from the Shopping Cart, it determines whether a 
payment method has already been selected (for example, if the user 
previously began the checkout process but did not complete it).

❏ If the payment method has already been selected, the process skips to the 
validation steps.

❏ If not, the user must select or enter payment information.

■ If the process was called from the Order Summary view, the user must 
reselect or re-enter payment information.

■ If necessary, the process determines whether the customer is a B2B user 
associated with an account approved for using purchase orders (POs). B2B 
customers with PO accounts are sent directly to the Select Payment view.

For customers without PO accounts, the process determines whether they have 
credit card information saved in their profiles.

■ If no credit card information exists, payment information must be entered 
and validated.

■ If credit card information exists, the customer is sent to the Select Payment 
view.

■ In the Select Payment view, PO-approved B2B customers choose either PO or 
credit card. Customers who are not approved to pay by PO can pay with a 
credit card by selecting an existing card or entering a new one.

■ If payment is made by credit card, the credit card is validated. Validation consists 
of checking that the credit card number is valid (using the Mod 10 algorithm), 
that the expiration date is in the future, and that all required fields are 
completed.

If the number is not valid, an error message appears and the payment process is 
restarted.

■ New credit card numbers can be added to user profiles if users indicate that the 
numbers should be stored for future use.
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eSales - Complete Checkout Process
The workflow for checkout completion is shown in Figure 14.

In the eSales - Checkout Process, after shipping and payment information have been 
added to the order, the eSales - Complete Checkout Process is called. The following 
events happen:

■ Shipping charges are calculated using the Shipping Cost Service (eScript) 
business service.

Figure 14. eSales - Complete Checkout Process
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■ Sales taxes are calculated using the Tax Calculator and Taxware Adapter Service 
business services. See Chapter 9, “Using Third-Party Taxation Applications,” for 
more information about tax calculation. 

If there is a tax calculation error, the customer must enter shipping address 
information again. This is because tax rates depend on having a valid shipping 
address. 

If non-ASCII characters are entered in any field that is passed to Taxware, the 
process checks whether the field is required. If it is required, the process sets the 
error message to the quote header and copies it to the order. The customer sees 
an error message stating that the information required to calculate taxes could 
not be processed but that the order will be placed and they will receive an email 
with the total cost of the order.

The customer can then confirm the order. The process copies the error message 
to the order so that an administrator can query for the order with the problem.

■ The customer is sent to the Quote Summary view, where the customer can edit 
shipping and payment information, cancel the checkout process, or confirm the 
order.

■ Entering new shipping information causes shipping charges and taxes to be 
recalculated.

■ Choosing to cancel checks the quote type. If Quotation, the customer is sent 
to the home page. If Persistent Cart, the customer is sent to the Shopping 
Cart. For more information on quote types, see “Quote Types Used in Siebel 
eSales” on page 131.

■ Choosing to confirm the order calls the eSales - Authorize Order Process (see 
Figure 15 on page 105).
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eSales - Authorize Order Process
The workflow for authorizing credit card payments and purchase orders is shown 
in Figure 15.

Confirming the order in the Order Summary view calls the eSales - Authorize Order 
Process. The following events happen:

■ The process determines which payment method was selected, PO or credit card.

■ If the PO method was selected, the process:

■ Performs a credit check by calling the Credit Check - Quotes process. If the 
credit check fails, the order is still created, but the Credit Status is set to a 
value such as Declined or Over Limit.

■ Checks for auction items in the order.

Figure 15. eSales - Authorize Order Process
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❏ If none, the purchase order is created using the CreateOrder method of the 
Shopping Service business service, the Setting PO Status workflow is 
called (see Figure 20 on page 110), and then the Order Confirmation view 
is shown using the eSales - Order Confirmation View process (see 
Figure 30 on page 123).

❏ If there are auction items, a PO cannot be used. This is because once an 
auction has been won, it cannot be rejected by a purchasing manager. The 
order is created, order acceptance email is sent, the Order Confirmation 
view is shown, and the Credit Card Verification Number is deleted.

■ If credit card, the credit card is authorized using the workflow Credit Card 
Transaction Service.

■ If authorization is successful, an order is created using the CreateOrder 
method of the Shopping Service business service. Order acceptance email is 
sent, the Order Confirmation view appears, and the Credit Card Verification 
Number is deleted. 

■ If authorization fails, the eSales - Enter Payment Details Process (see 
Figure 13 on page 101) is called. Credit card authorization is performed again 
and if it is successful, the order is created.

See Chapter 7, “Using Third-Party Payment Applications,” for more information on 
credit card authorization.

NOTE: It is not recommended that you use purchasing order approval processes with 
auction sites. This is because if a purchasing manager can reject an order, it 
compromises the validity of the bidding process.
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eSales - Save Credit Card
The workflow for saving credit card information is shown in Figure 16.

When the eSales - Save Credit Card process is called by the eSales - Enter Payment 
Details Process (see Figure 13 on page 101), the following events happen:

■ The process saves the credit card information to the Personal Payment Profile 
business component.

■ The process determines whether the user has a primary credit card already set.

■ If so, the process ends.

■ If not, the current credit card is set as the primary.

■ Any error generates an exception.

Figure 16. eSales - Save Credit Card
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eSales - Save Shipping Address
The workflow for saving shipping address information is shown in Figure 17.

When the eSales - Save Shipping Address process is called by the eSales - Enter 
Shipping Details Process (see Figure 12 on page 99), the following events happen:

■ The process determines whether the address needs to be saved. If it does, it 
saves the shipping address information to the Personal Address business 
component.

■ After saving the address, or if the address does not need to be saved, the process 
determines whether the user has a primary account address already set.

■ If so, the process ends.

■ If not, the current address is set as the primary.

■ Any error generates an exception.

Figure 17. eSales - Save Shipping Address
108 Siebel eSales Administration Guide Version 7.5, Rev. A



Modifying Order Workflows

Siebel eSales Order Workflows
eSales - Save Account Shipping Address
The workflow for saving the account shipping address is shown in Figure 18.

When the eSales - Save Account Shipping Address workflow is called by the eSales 
- Enter Shipping Details Process (see Figure 12 on page 99), it saves the account 
shipping address to the business address business component.

eSales - Set Primary Account Address
The workflow for setting the primary account address is shown in Figure 19.

When the eSales - Set Primary Account Address workflow is called by the eSales - 
Enter Shipping Details Process (see Figure 12 on page 99), it determines whether 
the B2B user has a primary account address.

■ If so, nothing is done.

■ If not, the current address is saved to the User Profile (eApps) business 
component as the primary address for that B2B user.

Figure 18. eSales - Save Account Shipping Address

Figure 19. eSales - Set Primary Account Address
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eSales - Setting PO Status
The workflow for setting the status of a purchase order is shown in Figure 20.

When the eSales - Setting PO Status workflow is called by the eSales - Authorize 
Order Process (see Figure 15 on page 105), the following events happen:

■ The process determines whether the PO is pending. 

■ If it is, the order status is set to Awaiting Approval and the Send Order 
Awaiting Approval Email (eSales) process is called.

■ If it is not, the process determines the user type.

■ If the user is a power user, the Send Order Accepted Email (eSales) process (see 
“Notifications” on page 112) is called.

■ If the user is of another type, the process determines whether the order amount 
is over the auto-approval limit.

■ If it is not over the auto-approval limit, the Send Order Accepted Email 
(eSales) process is called.

Figure 20. eSales - Setting PO Status
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■ If it is over the limit, the order status is set to Awaiting Approval and the Send 
Order Awaiting Approval Email (eSales) process is called.

For more information about PO status, see Chapter 6, “Administrative Tasks.”

eSales - Current User Type
The workflow for looking up the current user type from the contact record is shown 
in Figure 21.

The eSales - Current User Type workflow is called by the eSales - Approve Order 
Process (see Figure 23 on page 113) and the eSales - Reject Order Process (see 
Figure 24 on page 114).

Shipping Calculation Process
For information on the Shipping Calculation Process, see “Setting Up Shipping 
Charge Calculation” on page 41.

Figure 21. eSales - Current User Type
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Notifications
The following workflows send email to users about the status of their orders:

■ Send Order Accepted Email (eSales). Sent to all users who place an order 
successfully.

■ Send Order Awaiting Approval Email (eSales). Sent to the purchasing manager for 
an account when an order with a status of Awaiting Approval needs to be 
reviewed.

■ Send Order Failed Email (eSales). Sent to a user when an auction is silently closed 
and turned into an order, but the credit card used cannot be authorized.

■ Send Order Rejected Email (eSales). Sent to a corporate user when the purchasing 
manager or delegated customer administrator has rejected that corporate user’s 
order.

■ Send Order Shipped Email (eSales). Sent to a user when that user’s order has been 
shipped.

This workflow is triggered by the Send Order Shipped Email (eSales) workflow 
policy action, which is triggered by the Send Order Shipped Email Policy (eSales) 
workflow policy when the order status is changed to Shipped.

All five processes take the form shown in Figure 22. Either email is sent or an error 
generates an exception.

For more information on email notifications, see “Customizing Notifications” on 
page 47. For information on workflow policies and workflow policy actions, see 
Siebel Business Process Designer Administration Guide.

Figure 22. Email Notification Workflow
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Purchase Approval
A purchase order must be either approved or rejected by either a purchasing 
manager or a delegated customer administrator if the order is over the auto-
approval limit.

eSales - Approve Order Process
The workflow for approving purchase orders is shown in Figure 23.

The eSales - Approve Order Process is called when a delegated customer 
administrator or purchasing manager clicks Approve in the My Orders view. The 
following events happen:

■ The process calls the eSales - Current User Type workflow (see Figure 21 on 
page 111) to determine the user type.

■ If the customer is not a power user, the process ends.

Figure 23. eSales - Approve Order Process
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■ If the customer is a power user, the process determines whether the PO status is 
Pending because no PO number was entered. If the PO status is Pending, the 
eSales - Display Error Process workflow is called, an error message is generated, 
and the customer is returned to the Order Approval view where the customer 
can enter the PO number. 

■ If the PO status is not Pending, the process determines the order status.

■ If the order status is Awaiting Approval, the PO status is set to Approved and 
the Send Order Accepted Email (eSales) workflow (see “Notifications” on 
page 112) is called.

■ If the order status is not Awaiting Approval, the process ends.

eSales - Reject Order Process
The workflow for rejecting purchase orders is shown in Figure 24.

The eSales - Reject Order Process is called when a delegated customer administrator 
or purchasing manager clicks Reject in the My Orders view. The following events 
happen:

Figure 24. eSales - Reject Order Process
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■ The process calls the eSales - Current User Type workflow (see Figure 21 on 
page 111) to determine the user type.

■ If the user is not a power user, the process ends.

■ If the user is a power user, the Add Comments view appears, where the user can 
explain why the order has been rejected. The user then has two choices:

■ Cancel. The comments are not saved, and the Order Approval view appears. 
The status of the order is unchanged; it is still Awaiting Approval.

■ Continue. The comments are saved and the order status is set to Rejected. The 
Send Order Rejected Email (eSales) workflow (see “Notifications” on 
page 112) is called and the Order Approval view appears.
Version 7.5, Rev. A Siebel eSales Administration Guide 115



Modifying Order Workflows

Siebel eSales Order Workflows
Order Modification
Orders can be canceled, modified, and reordered.

eSales - Cancel Order Process
The workflow for canceling orders is shown in Figure 25.

The eSales - Cancel Order Process is called when a customer clicks Cancel in the 
Order History Summary view. The following events happen:

■ The process displays the Cancel Order Confirmation view.

If the user confirms the cancellation, the order status is set to Canceled and the 
Order History Summary view appears.

If the user decides not to cancel the order, the user is returned to the Order 
History Summary view.

Figure 25. eSales - Cancel Order Process
116 Siebel eSales Administration Guide Version 7.5, Rev. A



Modifying Order Workflows

Siebel eSales Order Workflows
eSales - Modify Order Process
The workflow for modifying orders is shown in Figure 26. Modifying an order 
cancels the original order and creates a new shopping cart with the same items in 
its place. The items in the shopping cart can then be modified and a new order 
created to replace the original order.

The eSales - Modify Order Process is called when a customer clicks Modify in the 
Order History Summary view. The following events happen:

■ The process determines whether the Shopping Cart is empty.

■ If it is empty, a new quote (Shopping Cart) is created from the order, the order 
is canceled, and the Shopping Cart appears.

■ If it is not empty, the Modify Order Confirmation view appears, where the user 
has three choices:

Figure 26. eSales - Modify Order Process
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■ Cancel. The process determines whether the quote is for an existing 
customer. If it is, the Customer Order Detail View appears and the process 
ends. If it is not, the Order History Summary View appears and the process 
ends.

■ Discard Cart. The Shopping Cart is emptied and a new one is created from the 
order. The new Shopping Cart is repriced, the old order is canceled, and then 
the Shopping Cart appears. The eSales - Shopping Cart View process (see 
Figure 31 on page 124) is used to display the Shopping Cart.

■ Save Cart. If there is an error, the eSales - Display Error Process (see Figure 28 
on page 121) is called, and then the user is sent back to the Modify Order 
Confirmation view. For example, this would happen if the user tried to save 
a quote with a name that was already being used.

If there is no error, the Shopping Cart is saved as a quote (see “eSales - Save 
Cart Process” on page 91) and a new Shopping Cart is created from the order. 
The new Shopping Cart is repriced, the old order is canceled, and then the 
Shopping Cart appears. The eSales - Shopping Cart View process is used to 
display the Shopping Cart.
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eSales - Reorder Process
The workflow for reordering is shown in Figure 27. It works similarly to modifying 
an order.

Figure 27. eSales - Reorder Process
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The eSales - Reorder Process is called when a customer clicks Reorder in the Order 
History Summary view. The following events happen:

■ The process determines whether the Shopping Cart is empty.

■ If it is empty, a new quote (Shopping Cart) is created from the order and the 
eSales - Checkout Process (see Figure 10 on page 95) is called.

■ If it is not empty, the Reorder Confirmation view appears, where the user has 
three choices:

■ Cancel. The process determines whether the quote is for an existing 
customer. If it is, the Customer Order Detail View appears and the process 
ends. If it is not, the Order History Summary View appears and the process 
ends.

■ Discard Cart. The Shopping Cart is emptied and a new Shopping Cart is 
created from the order. The eSales - Checkout Process is called.

■ Save Cart. If there is an error, the eSales - Display Error Process (see Figure 28 
on page 121) is called, and then the user is sent back to the Reorder 
Confirmation view. For example, this would happen if the user tried to save 
a quote with a name that was already being used.

If there is no error, the Shopping Cart is saved as a quote (see “eSales - Save 
Cart Process” on page 91) and a new Shopping Cart is created from the order. 
The eSales - Checkout Process is called.
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Error Messages and Views
The following processes display error messages and views that do not use the same 
business object as the workflow that called them.

eSales - Display Error Process
The process used for displaying error messages is shown in Figure 28. It is called by 
the following workflows:

■ eSales - Edit Quote Process (Figure 4 on page 88)

■ eSales - Save Cart Process (Figure 7 on page 91)

■ eSales - Enter Shipping Details Process (Figure 12 on page 99)

■ eSales - Checkout Process (Figure 10 on page 95)

■ eSales - Enter Payment Details Process (Figure 13 on page 101)

■ eSales - Modify Order Process (Figure 26 on page 117)

■ eSales - Reorder Process (Figure 27 on page 119)

Figure 28. eSales - Display Error Process
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When the eSales - Display Error Process is called, the following events happen:

■ The process sets the error message.

■ It displays the error message in the General Error Message view.

■ It returns to the original workflow.

eSales - Login View
The process for displaying the Login view is shown in Figure 29.

This process is called by the eSales - Checkout Process (see Figure 10 on page 95) 
when an anonymous user tries to check out. The eSales - Login View process is 
necessary because the Login view is based on the Login business object, while the 
eSales - Checkout Process is based on the Catalog business object.

Figure 29. eSales - Login View
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eSales - Order Confirmation View
The process for displaying the Order Confirmation view is shown in Figure 30.

This process is called by the eSales - Authorize Order Process (see Figure 15 on 
page 105). The eSales - Order Confirmation View process is necessary because the 
Order Confirmation view is based on the Order Entry (Sales) business object, while 
the eSales - Authorize Order Process is based on the Catalog business object.

Figure 30. eSales - Order Confirmation View
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eSales - Shopping Cart View
The process for displaying the Shopping Cart is shown in Figure 31.

This process is called by the eSales - Modify Order Process (see Figure 26 on 
page 117). The eSales - Shopping Cart View process is necessary because the 
Shopping Cart is based on the Catalog business object, while the eSales - Modify 
Order Process is based on the Order Entry (Sales) business object.

Figure 31. eSales - Shopping Cart View
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Auctions
Quotes of type Auction Quote, that is, winning bids, are converted to orders 
automatically after a given period of time. This is done using a workflow policy such 
as Complete Auction Order, which converts the quote to an order after two days by 
triggering the Silent Authorize Order workflow policy action.

For more information on auction quotes, see “Quote Types Used in Siebel eSales” 
on page 131 and Siebel eAuction Guide. For information on workflow policies, see 
Siebel Business Process Designer Administration Guide.

The eSales - Silent Authorize Order Process, shown in Figure 32, is triggered by the 
Silent Authorize Order workflow policy action.

When this workflow is triggered, the following events happen:

■ The Shipping Calculation Process is called. For more information, see Chapter 2, 
“Setup Tasks.”

■ The Calculate Tax business service is called.

■ The process determines the payment method. If a credit card is used, the card is 
authorized.

■ An order is created.

Figure 32. eSales - Silent Authorize Order Process
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■ If credit card authorization fails, the order status is set to Credit Failure and an 
email message is sent to the customer indicating the problem.

■ The quote status is set to Order Placed.
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Workflows are modified using the Process Designer in the Workflow Processes view 
of the Business Process Administration screen.

Among the modifications you can make are the following:

■ Adding and deleting steps.

■ Changing the branching behavior of a step.

■ Customizing user registration, checkout, and order approval.

■ Displaying error messages. For this, you can use a subprocess call to the
eSales - Display Error Process (see Figure 28 on page 121).

For detailed information on modifying workflows, see Siebel Business Process 
Designer Administration Guide. For information on configuring views, see Siebel 
Tools Reference.
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This chapter describes the Shopping Cart and introduces the Shopping Service 
business service.
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The Shopping Cart is used to store items selected by customers. When a Siebel 
eSales customer selects an item for the first time during a session by clicking Add 
to Cart, a quote record is created. The CurrentQuoteId user profile attribute is set to 
the ID of this quote.

A customer can have only one Shopping Cart in a session. If the customer changes 
the Shopping Cart to another quote, for example in the Edit Quote workflow, 
CurrentQuoteId is set to the ID of the new quote record.
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New quote types have been created to support anonymous users, persistent 
Shopping Carts, and Siebel eAuction. The quote types used in Siebel eSales are:

■ Anonymous Quote. Allows anonymous users to add items to the Shopping Cart. 
When an anonymous user logs in or registers, the quote type of the current 
quote is checked and converted to Persistent Cart. This preserves the Shopping 
Cart after login.

Workflows can be used to delete Anonymous Quote records if they last for more 
than a specified period of time, such as 48 hours. This would apply if the 
anonymous user chose not to log in.

■ Persistent Cart. The persistent Shopping Cart. Each user can have only one quote 
record of type Persistent Cart.

The persistent Shopping Cart works as follows:

■ When a user logs in, the run-time event WebLogin triggers the action set 
eSales Web Login Action Set, which invokes the Shopping Service method 
SetShoppingCart.

■ SetShoppingCart finds the quote with type Persistent Cart associated with 
that user and sets CurrentQuoteId to the ID of this quote.
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■ Auction Quote. Created when a user wins a bid. Allows users to add auction items 
to the Shopping Cart.

Auction items cannot be added to a quote of type Persistent Cart and Auction 
Quote cannot be converted to Persistent Cart, because it is necessary to convert 
auction quotes to orders automatically after a given period of time. This is done 
using a workflow policy such as that shown in Table 11, which converts the 
quote to an order after two days.

For information on workflow policies, see Siebel Business Process Designer 
Administration Guide.

■ Quotation. When a user clicks Confirm Order on the Order Summary page, the 
quote type is changed from Persistent Cart or Auction Quote to Quotation and 
the status is changed to Order Placed.

Table 11. Workflow Policies

Workflow Policy Fields Action

Complete Auction Order Quote Status = In Progress Silent Authorize Order

Quote Type = Auction Quote
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The Shopping Cart is implemented through the Shopping Service business service. 
The Shopping Service business service is based on the class CSSShoppingService, a 
subclass of CSService. Some of its methods are invoked through the user interface. 
Others are invoked by workflows or applications such as Siebel eAuction, Siebel 
eEvents Management, and Siebel eTraining.

Customizing the Shopping Service
The Shopping Service business service is written in C++ and cannot be modified. 
If you wish to change any of the methods in the Shopping Service, it will be 
necessary to write a new business service in Siebel eScript. However, these methods 
are modular and can be used in new workflows that are designed when the 
application is customized.

The following sections provide more information on the Shopping Service and other 
processes used in Siebel applications to support the Shopping Cart.

For more information on writing scripts, see Siebel Tools Online Help.
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The Shopping Service has many business service methods. Those used by the 
Shopping Cart in Siebel eSales and are described in Table 12.

For detailed descriptions of these methods, see Appendix A, “Shopping Service 
API.”

Table 12. Shopping Service Business Service Methods

Method Description Used In Workflow

AddItem Adds an item to the Shopping Cart or Favorites.

CreateAuctionQuote Creates a quote that contains auction items.

AddAuctionQuoteItem Adds the auction item to the quote created in 
CreateAuctionQuote.

CommitAuctionQuote Commits the auction quote.

CreateOrder Converts a quote to an order. Also confirms 
training class and event registrations.

eSales - Authorize Order Process

DiscardCart Deletes the current Shopping Cart and sets 
CurrentQuoteId to empty, but only when the 
Quote Type equals Persistent Cart.

eSales - Edit Quote Process

eSales - Reorder Process

GetShoppingCartStatus Gets the status of the current Shopping Cart, 
which can be one of the following:

■ Empty. CurrentQuoteId is empty or Quote 
Type equals Persistent Cart.

■ Not Empty.

■ No Save.

Also returns information such as Quote Item 
and Item Count.

eSales - Edit Quote Process

eSales - Modify Order Process

eSales - Reorder Process

OrderQuote Creates an order based on the quote. eSales - Checkout Process

eSales - Order Quote Process

Reorder Creates a quote based on an existing order.

RepriceQuote Reprices quotes, for example when a customer 
orders a saved quote that has expired.
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SaveCartAsQuote Saves the current Shopping Cart as a quote:

■ Finds the quote record whose Id equals 
CurrentQuoteId.

■ Saves it as a quote, that is, sets the quote 
status to Quotation.

■ Sets CurrentQuoteId to empty (empties the 
Shopping Cart).

eSales - Edit Quote Process

eSales - Reorder Process

eSales - Save Cart Process

SaveCartAsTemplate Saves the current Shopping Cart as a template, 
but keeps the Shopping Cart.

Ordering from a template copies the template 
items to the Shopping Cart.

eSales - Save Cart Process

SelectPrimary Uses the contact Primary ID field to copy the 
primary personal address, primary personal 
account address, and primary payment profile 
from the pick field to the current quote 
(Shopping Cart).

SetApplicationName Sets the ApplicationName dynamic user profile 
attribute. Triggered by the application’s 
WebLogin event.

Used in run-time events to support the different 
Shopping Cart behavior between Siebel eSales 
and other Siebel applications.

Table 12. Shopping Service Business Service Methods

Method Description Used In Workflow
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SetPendingRequest Allows workflows to continue after anonymous 
users are sent to the Login view to register.

eSales - Checkout Process

eSales - Save Cart Process

SetShoppingCart Supports the persistent Shopping Cart and 
allows anonymous users to add items to the 
Shopping Cart. Triggered by the application’s 
WebSessionStart event.

When a session begins, the method does the 
following:

■ If an anonymous user, does nothing.

■ If CurrentQuoteId is not empty (that is, the 
user already has a Shopping Cart), checks if 
the Shopping Cart quote type is 
Anonymous Quote.

If Anonymous Quote, converts it to 
Persistent Cart and sets Contact Id to the 
login Id of the user.

■ If CurrentQuoteId is empty, tries to find an 
existing quote of type Persistent Cart (user’s 
Shopping Cart from the previous session) 
and set CurrentQuoteId to that quote ID.

If there is no such quote, the user did not 
leave a Shopping Cart (for example, saved it 
as a quote or checked out).

Table 12. Shopping Service Business Service Methods

Method Description Used In Workflow
136 Siebel eSales Administration Guide Version 7.5, Rev. A



Shopping Cart

Run-Time Events
Run-Time Events
Tracking run-time events allows Siebel applications to respond in real time to user 
actions. Business managers can configure the actions in response to any event.

When a run-time event occurs that is associated with one or more action sets, the 
personalization engine performs the specified actions. These actions modify content 
and user profile attributes, with the potential of triggering personalization rules.

Run-time events and action sets are created and managed in the Run-time Events 
Administration screen. You do not need to reconfigure or recompile business 
objects, because the interaction occurs between Siebel Personalization and the user 
interface.

Siebel eSales uses two action sets to configure Shopping Cart behavior:

■ eSales WebSessionStart Action Set. Triggered by the WebSessionStart run-time 
event. This action set contains one action:

SetApplicationName. Sets the ApplicationName dynamic user profile attribute, 
which supports the different behavior of the Shopping Cart among the various 
Siebel applications.

The following applications use this action set:

■ Siebel Call Center

■ Siebel Partner Relationship Management

■ Siebel eCustomer

■ Siebel eEvents Management

■ Siebel eSales

■ Siebel eService

■ Siebel eTraining

■ Siebel Marketing

■ eSales WebLogin Action Set. Triggered by the run-time event WebLogin. It 
contains the following actions:
Version 7.5, Rev. A Siebel eSales Administration Guide 137



Shopping Cart

Run-Time Events
■ SetPriceList. Sets the price list for the session when a user logs in. Invokes 
the Pricing Manager business service method SetPriceList, which sets the 
price list according to the following:

❏ If the user belongs to an account, the price list associated with that 
account is used.

❏ If the user does not belong to an account or belongs to an account that is 
not associated with a price list, the price list whose row ID is in the 
PRICER_MASTER_PRICE_LIST_ID list of values is used. For more 
information, see “Setting Up Price Lists” on page 33.

■ SetShoppingCart. Determines when a user logs in whether that user has a 
Shopping Cart from a previous session or from browsing as an anonymous 
user. Invokes the Shopping Service business service method 
SetShoppingCart, which checks the user profile attribute CurrentQuoteId for 
the following:

❏ If CurrentQuoteId is null, SetShoppingCart finds the quote record of type 
Persistent Cart, if any, and sets CurrentQuoteId to this record’s ID.

❏ If CurrentQuoteId is not null, and the user has a quote record of type 
Anonymous Quote, SetShoppingCart calls the ConvertAnonymousQuote 
method to change the quote type to Persistent Cart.

Three applications use the eSales WebLogin Action Set:

■ Siebel Partner Relationship Management

■ Siebel eCustomer

■ Siebel eSales

For more information on run-time events, see Personalization Administration Guide.
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Object Manager Support
Siebel applications use object manager parameters to support different Shopping 
Cart requirements. The default values of object manager parameters are defined in 
Siebel Tools but these can be overridden by individual applications. The method of 
overriding the parameter values is different for the Siebel Web client and Siebel 
mobile client.

Viewing Default Object Manager Parameters
You can view the default object manager parameters in Siebel Tools.

To view the default object manager parameters

1 In Siebel Tools, if the Server Component Type object is not shown in the Object 
Explorer:

a Select View > Options.

b In the Development Tools Options dialog box, click the Object Explorer tab.

c Select the Server Component Type object in the left pane and move it to the 
right pane.

2 In the Object Explorer, select Server Component Type.

3 Query for InfraShoppingService.

4 In the Object Explorer, expand Server Component Type and select Server 
Component Parameter.

The default server component parameters are displayed.

Modifying Object Manager Parameters in the Web Client
You can see or change the definitions of overrides in the Web client.

To see or change the definitions of overrides

1 Navigate to the Server Administration screen.

2 In the Show drop-down list select Components.
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3 Select the appropriate component.

For example, if you want to see the eSales component, select eSales Object 
Manager.

4 Click the Component Parameters view tab.

5 Examine the component parameters that are listed in Siebel Tools.

Siebel Sales and Siebel Call Center use the default parameters. Siebel eSales 
overrides the parameters shown in Table 13.

Siebel Partner Relationship Management overrides the parameters shown in 
Table 14.

Table 13. Parameters for Siebel eSales

Parameter Condition Value

ProductDetailView = Product Detail - Features View (eSales)

ShoppingCartView = Current Quote View (eSales)

AnonymousQuote = TRUE

PersistentShoppingCart = TRUE

Table 14. Parameters for Siebel Partner Relationship Management

Parameter Condition Value

ProductDetailView = FALSE

ShoppingCartView = Current Quote View 
(eSales)

AnonymousQuote = TRUE

PersistentShoppingCart = TRUE
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Modifying Object Manager Parameters in the Mobile Web Client
For users of the Siebel Mobile Web Client, the application configuration files, shown 
in Table 15, are used to change object manager parameters.

Table 15. Application Configuration Files

Application Configuration File

Siebel eSales esales.cfg

Siebel Partner Relationship Management scw.cfg

Siebel Call Center uagent.cfg

Siebel Sales siebel.cfg
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Administrative Tasks 6
This chapter describes administrative tasks used to maintain Siebel eSales. These 
tasks include setting up quote expiration dates, setting up customer accounts, and 
modifying credit card charges.
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Setting Quote Expiration Dates
Quote expiration dates are set in the List of Values view under the Application 
Administration screen.

NOTE: You must clear the LOV cache for the new expiration date to take effect.

To set quote expiration dates

1 Navigate to Application Administration > List of Values.

The List of Values appears.

2 Query for the type QUOTE_EXPIRATION_PERIOD.

3 Set the Display Values field to the number of days you want quotes to be 
effective.

4 Click the menu button and choose Clear LOV Cache.
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Managing Anonymous Shopping Carts
Customers are treated as anonymous users until they register with your Siebel 
eSales Web site. Registered users returning to your Web site, and who have not yet 
logged in, are recognized as anonymous users rather than registered users if:

■ They have deleted previously stored cookies.

■ They elected for the Web site not to remember their user IDs, in which case they 
lack the cookie that enables implicit login.

When an anonymous user places an item in the Shopping Cart, an anonymous 
quote is created and a cookie is placed on the customer’s computer. The cookie 
identifies the quote. If the Internet connection is lost, or if the customer leaves your 
Web site before checking out, the cookie is used to load the customer’s quote when 
the customer returns. 

If the customer does not return to the Web site for a specified number of days, the 
anonymous quote is deleted. 

If the customer logs in later, and before the quote is deleted, the persistent 
anonymous quote is converted to a persistent quote, and the cookie is cleared. The 
cookie is replaced by another one that will enable implicit login when the customer 
returns to your site.

You can set both the frequency with which anonymous quotes are deleted and the 
age of the quotes to be deleted. The deletions are then performed automatically by 
a repeating server request. By default, anonymous shopping carts 30 days or older 
will be deleted weekly. For information about how to set up repeating server 
requests, see Siebel Business Process Designer Administration Guide.

To set the age for anonymous quotes deletion

1 Navigate to the Business Process Administration screen.

2 Select the eSales - Delete Old Anonymous Quotes workflow.

3 Click Revise to change the Status to In Progress.

4 In the Process Properties list, edit the Default String field for the Days Old 
process property.
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5 Make any other changes to the workflow that are necessary for your 
implementation.

6 Click Activate to activate the workflow.
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Setting Up Customer Accounts
The tasks involved in setting up customer accounts are the following:

■ “Creating Accounts”

■ “Associating Users with Accounts” on page 148

■ “Associating Price Lists with Accounts” on page 148

■ “Allowing Accounts and Contacts to Use Purchase Orders” on page 149

■ “Setting PO Auto-Approval Limits for Accounts” on page 151

■ “Setting the Credit Auto-Approval Limit For an Account” on page 151

■ “Setting the Skip Credit Check Field For an Account” on page 151

Creating Accounts
You create accounts in the My Accounts view under the Accounts screen.

For more information on creating accounts, see Siebel Sales User Guide.

To create an account

1 Click the Accounts tab.

The My Accounts view appears.

2 Add a new record.

The Accounts form appears.

3 Fill in the fields, and then click Save.
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Associating Users with Accounts
You associate users with accounts in the My Accounts view under the Accounts 
screen.

To associate a user with an account

1 Click the Accounts tab.

The My Accounts view appears.

2 Click the Contact Admin tab below the Accounts list.

You might have to scroll the tab bar to see the Contact Admin tab.

3 Add a new record.

The Add Contacts dialog box appears.

4 Query for a user or add a new user.

Clicking New adds a new record to the Contact Admin list.

For more information on contact user administration, see Siebel Sales User Guide 
and Application Administration Guide.

Associating Price Lists with Accounts
You associate price lists with accounts in the My Accounts view under the Accounts 
screen.

To associate a price list with an account

1 Click the Accounts tab.

The My Accounts view appears.

2 Select an account.

3 Click the show more button under the More Info tab.

The full Account Detail form appears.

4 Click the icon in the Price List field.
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5 From the drop-down list that appears, select a price list.

6 Click OK, allowing Accounts and Contacts to Use Purchase Orders

Allowing Accounts and Contacts to Use Purchase Orders
Corporate customers can use purchase orders to buy from your Siebel eSales Web 
site. Web Corporate Users who want to make purchases may not have the authority 
to assign a purchase order number and approve the purchase for their company. 
Siebel eSales allows Web Corporate Users to complete the checkout process without 
providing a purchase order number. When this happens, the PO Status is set to 
Pending and the Order Status is set to Awaiting Approval. This happens even if the 
order amount is less than the Auto-Approval Limit set on the account. The order is 
then routed through the order approval process.

The Web Purchasing Manager within the buying organization can review orders 
that are awaiting approval through the My Company’s Orders screen. The Web 
Purchasing Manager can then provide a purchase order number and change the 
Order Status to Approved.
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To enable Web Corporate Users to buy with purchase orders, the PO Approved flag 
must be set for both:

■ The account

■ All contacts associated with the account who should be able to buy with a 
purchase order.

There is no inheritance from an account to its contacts.

NOTE: The Web Purchasing Manager must also be assigned a user type of Web 
Purchasing Manager and the Web Corporate User responsibility. For more 
information, see “Setting Up Default Responsibilities and User Types” on page 30.

To set the purchase order approval flag for an account

1 Click the Accounts tab.

2 Select an account.

3 Click the show more button on the Account Detail form under the More Info tab.

4 Select the PO Approved check box.

The Web Delegated Customer Administrator in the buying organization can set 
purchase order approval for particular users within the buying organization through 
the User Administration view. In the selling organization, an employee can also set 
the purchase order approval flag in the Account Detail - Contacts view.

To set the purchase order approval flag for a user

1 Navigate to the User Administration screen.

2 From the Show drop-down list, select Users.

3 In the All Users list, select a user.

4 In the More Info form, select the PO Approved check box.
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Setting PO Auto-Approval Limits for Accounts
The PO auto-approval limit is the maximum amount that can be ordered by a 
corporate customer using a purchase order without approval from the purchasing 
manager in the purchaser’s company.

You set auto-approval limits on the Account Detail form in the My Accounts view.

To set the auto-approval limit for an account

1 Navigate to the Accounts screen.

2 Select an account.

3 Click the show more button on the More Info form.

4 Type the auto-approval amount into the PO Auto-Approval Limit field.

Setting the Credit Auto-Approval Limit For an Account
The credit auto-approval limit is the maximum amount that can be ordered by a 
corporate customer using a purchase order without requiring an automatic credit 
check using the External Credit Check ASI.

For example, if you set the limit to $1000, any order greater than $1000 will 
automatically receive a credit check.

To set the credit auto-approval limit for an account

1 Navigate to the Accounts screen.

2 Select an account.

3 In the Credit Profile form, type the auto-approval amount into the Credit Auto 
Approval Limit field.

Setting the Skip Credit Check Field For an Account
The Skip Credit Check field allows you to skip automatic credit checking for a 
particular account. Automatic credit checking uses the External Credit Check ASI 
for customers paying with a purchase order.
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To skip credit checks for an account

1 Navigate to the Accounts screen.

2 Select an account.

3 In the Credit Profile form, select or clear the Skip Credit Check check box.
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Modifying Credit Card Charges
Credit card charges can be modified in your Siebel application by call center or sales 
professionals. This is done in the Order Entry - Payment View (Sales).

Cardholder information is displayed, as well as the fields listed in Table 16.

The modifications allowed to credit card charges are the following:

■ Authorize. Allocates to the merchant a specific amount of the credit available to 
the cardholder, typically for one week. No funds are transferred.

The merchant authorizes a credit card to make sure of the following:

■ The customer has the funds to pay for the purchase.

Table 16. Field Description Table

Field Description

Total Order total.

Transaction Amount Amount that is sent with the call to CyberSource.

Payment Status This field is editable.

Authorization Code Authorization code returned by CyberSource. This field is 
editable as it is used for both verbal authorizations and 
automatic authorizations. When an authorization code is 
entered manually, authorization is not reevaluated by 
CyberSource.

The Credit Management group sets the authorization code based 
on conversations with the customers’ bank.

Transaction Time Set each time a transaction occurs.

Transaction Type Any payment method, such as a refund or charge.

Transaction Message Displays messages that are set in the Create Order on Web user 
properties for the Credit Card business service.

Card Verification # The number that is printed (not embossed) on the back of a 
credit card and used to reduce credit-card fraud. This number is 
not displayed.
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■ These funds are reserved until the merchant is able to ship the product. 
Credit card companies typically state that a merchant should not settle until 
the product has been shipped.

■ Settle. Includes the authorization code and requests that funds be transferred 
from the cardholder's account to the merchant's bank account.

You will need to settle each order or develop a batch routine.

■ Authorize and Settle. Makes sure that the funds are available, reserves them, and 
requests that they be transferred in one call. This is done when fulfilling orders 
immediately (for example, digital downloads).

■ Refund. Takes place after a settlement when the merchant needs to transfer 
money back to the cardholder, as in the case of a return.
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Authorizing Charges
Authorization is done automatically in Siebel eSales as part of the eSales - Authorize 
Order Process, when the customer clicks Confirm Order on the Order Summary 
page.

Authorization can also be done manually. The Payment form is used by your 
employees, such as call center agents, to authorize charges.

To authorize a credit card charge

1 Navigate to Orders > My Sales Orders.

2 Select an order.

3 Click the Payments tab.

4 On the Payment Detail - Credit Card form, click Authorize.

For more information, see Siebel Order Management Guide.

Settling Charges
Use the Payment form to settle charges after an order has been authorized.

To settle a credit card charge

1 Navigate to Orders > My Sales Orders.

The My Sales Orders view appears.

2 Select an order.

3 Click the Payment tab.

The Payment form appears.

4 Modify the transaction amount if necessary.

5 Click Settle.

For more information, see Siebel Order Management Guide.

Combining the Authorization and Settlement of Charges
Use the Payment form to authorize and settle charges.
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To authorize and settle a credit card charge

1 Navigate to Orders > My Sales Orders.

2 Select an order.

3 Click the Payments tab.

4 In the Payment Lines list, add a new record and enter a transaction amount.

5 In the Payment Detail - Credit Card form, click Authorize and Settle.

Querying For Transactions With Error Messages
You can query for credit card authorizations that returned Siebel Response 
Messages without stopping the ordering process.

Siebel Response Messages that do not stop the ordering process are set in the Create 
Order on Web business service user property for the Credit Card Transaction Service 
business service. These messages are listed in Table 17.

For more information, see Chapter 7, “Using Third-Party Payment Applications.”

To query for Siebel Response Messages

1 Navigate to the Orders screen.

Table 17. Siebel Response Messages

Error Number Message

1 Transaction was successful.

18 You are not authorized to perform this transaction type.

19 Error happened in adapter business service. Please contact your 
application administrator.

20 Error happened in CyberSource. Please contact your application 
administrator.

21 The connection to CyberSource has timeout. Please try the operation 
later.
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2 From the Show drop-down list, select My Sales Orders.

3 Click the Payments view tab.

Returned Siebel Response messages are displayed in the Transaction Message 
column of the Payment Lines list.
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Giving Refunds
Use the Payment form to refund charges.

To refund a credit card charge

1 Navigate to Orders > My Sales Orders.

The My Sales Orders view appears.

2 Select an order.

3 Click the Payment tab.

The Payment form appears.

4 Modify the transaction amount if necessary.

5 Click Refund.

Reversing Charges
Releases the amount of money reserved by an authorization. This transaction is 
important because authorizations reserve part of a cardholder's credit and therefore 
reduce the total amount of credit available.

NOTE: Reversal of charges cannot be done using the CyberSource Internet 
Commerce Suite. Authorizations are allowed to expire after not being settled for a 
specified period of time, usually one week.
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This chapter describes how to set up and use CyberSource, a third-party payment 
application that is supported by Siebel eSales. To use the CyberSource application, 
you must buy a separate license from CyberSource. You can also use other third-
party applications for payment integration.
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CyberSource Internet Commerce Suite
Siebel eSales retrieves credit card information from CyberSource as part of the 
eSales - Authorize Order Process workflow (Figure 15 on page 105) when the 
customer clicks Confirm Order on the Order Summary page.

The CyberSource Internet Commerce Suite (ICS) is a set of third-party eCommerce 
applications. Siebel eSales uses the ICS to authorize credit card payments.

Siebel eSales accesses the ICS using an application programming interface (API), 
which is installed on the Web server. Messages are sent using CyberSource’s Simple 
Commerce Messaging Protocol (SCMP), which is based on Secure/Multipurpose 
Internet Mail Extensions (S/MIME), for authentication and encryption.

These messages contain a set of fields that describe the ICS application requests and 
provide information about the customer, the merchant, and the order form. SCMP 
messages are digitally signed and armored for transmission over an HTTP 
connection, allowing them to pass through firewalls and proxy servers.

For more information on the ICS, see Internet Commerce Suite Version 2 Application 
Programming Interface (API) Developer’s Guide, which is available from the 
CyberSource Support Center (http://www.cybersource.com/support).

NOTE: You will need to obtain a merchant ID from CyberSource to access the 
Support Center.
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Installing CyberSource Software
The steps to take for installing CyberSource are the following:

■ Obtain a merchant ID.

■ Download the compressed file for the CyberSource Developer Kit (CDK) for your 
platform.

■ Install the CDK on the Siebel Server.

■ Set system variables for the CDK and libraries.

For the versions of CyberSource software that were tested with this version of Siebel 
eSales, see the system requirements and supported platforms documentation on the 
Siebel Bookshelf. We recommend that you download and use the latest version of 
CyberSource software from http://www.cybersource.com. 

Obtaining a Merchant ID

NOTE: You must obtain a merchant ID to install CyberSource software. You can 
obtain a merchant ID for each division of your organization. The merchant IDs are 
set in the Divisions view under the Group Administration screen.

To obtain a merchant ID

1 In your Web browser, go to http://www.cybersource.com/register.

2 Fill in the required information, and then click Submit Registration.

A new merchant ID is generated, for example:

merchant id = esalestest

merchant id password = esalestest
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Downloading CyberSource onto Windows
Siebel supports the use of CyberSource software on the Windows NT and Windows 
2000 platforms.

To download CyberSource onto a machine running Windows

1 In your Web browser, go to http://www.cybersource.com/support.

2 Enter the merchant ID and password, which are case-sensitive.

3 Click Download APIs.

4 Click NT Perl/C.

5 Download the .zip file of the Perl/C CyberSource Developer Kit to the Siebel 
Server.

Installing CyberSource on Windows

NOTE: The drive on which you install CyberSource software must have a temporary 
directory, for example C:\temp. If the drive does not have a temporary directory, 
CyberSource will not function correctly.

To install CyberSource on Windows

1 Extract the .zip file to a directory called Cybersource on the same drive where 
the Siebel Server is installed, for example C:\Cybersource.

2 Choose Start > Programs > Command Prompt.

The Command Prompt appears.

3 Go to C:\Cybersource and type the following:

install <merchant ID> C:\Cybersource

The software is installed.

4 Choose Start > Settings > Control Panel > System.

The System Properties dialog box appears.
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5 On Windows NT, click the Environment tab. On Windows 2000, click the 
Advanced tab, and then click Environment Variables.

The Environment Variables dialog box appears.

6 Add the variable ICSPATH and set it to C:\CyberSource.

7 Add C:\CyberSource and C:\CyberSource\lib to the system Path variable.

8 Restart the Siebel Server.

Downloading CyberSource onto UNIX
Siebel supports the use of CyberSource software on the Solaris and AIX platforms.

To download Cybersource onto a machine running UNIX

1 In your Web browser, go to http://www.cybersource.com/support.

2 Enter the merchant ID and password.

They are case-sensitive.

3 Click Download APIs.

4 Click either AIX Perl/C or Solaris Sparc Perl/C under CyberSource Developer 
Kits, depending on your version of UNIX.

5 Download the .tar file of the Perl/C CyberSource Developer Kit for your version 
of UNIX.
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Installing CyberSource on UNIX
See the readme file for detailed installation instructions.

To install Cybersource on UNIX

1 Use the following command to extract the files from the .tar archive:

./tar xvf cdkperl*.tar

2 Run the installation program install.sh according to the instructions in the 
readme file.

3 Rename the library libics2.so to libics2api.so.

You can also modify the Vendor Dll user property of the CreditCard - 
Configuration (CyberSource) integration object in Siebel Tools.

4 Add to $LD_LIBRARY_PATH the full path to the directory that contains the 
library libics2api.so.

5 For the AIX platform, add to LIBPATH the full path to the directory that contains 
the library libics2api.so.

6 Make sure the <user's>directory is the current directory and add the following 
variable to the <user's>.cshrc file:

setenv ICSPATH “<full path to the directory containing CyberSource 
keys subdirectory>”
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Enabling Credit Card Transactions with CyberSource
To enable credit card transactions, Siebel Server object manager parameters must 
be set.

To enable credit card transactions with CyberSource

■ Navigate to Server Administration > Components > Component Parameters 
and set the following parameters for the eSales Object Manager:

CCAEnable = TRUE
CCAMerchantId = merchant_id
CCAServerHost = ics2test.ic3.com
CCAType = CyberSourceICS2
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CyberSource Integration with Siebel eSales
Integration of Siebel eSales with third-party payment applications involves three 
business services:

■ Credit Card Transaction Service (Universal Credit Card Service)

■ CyberSource Adapter Service

■ Shopping Service

Credit Card Transaction Service Business Service
The Credit Card Transaction Service business service controls the process shown in 
Figure 33:

■ Siebel EAI passes data from a quote record and the method name to a Siebel 
output integration object.

Figure 33. Credit Card Transaction Process Flow
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■ The Siebel Data Transformation Engine maps the Siebel output integration 
object to a CyberSource input integration object.

■ The Siebel EAI XML Converter converts the vendor input integration object into 
XML, using the CC XML Converter Business Service, and passes the XML data 
and method name to the CyberSource Adapter Service.

■ The CyberSource Adapter Service business service processes the data, converts 
it into Siebel eScript, and passes it to CyberSource using the CyberSource API.

■ The CyberSource Adapter Service gets the payment information from 
CyberSource in Siebel eScript via the CyberSource API.

■ The CyberSource Adapter Service formats the payment information into an XML 
string.

■ The Siebel EAI XML Converter converts the XML into a vendor output 
integration object.

■ The Siebel Data Transformation Engine maps the vendor output integration 
object to a Siebel input integration object.

■ Siebel EAI updates the quote record with the payment information.

Business Service Methods
The Credit Card Transaction Service has business service methods for each type of 
credit card transaction:

■ AuthCharge. Used to authorize and settle charges. Makes sure that the funds are 
available, reserves them, and requests that they be transferred in one call. This 
is done when fulfilling orders immediately (for example, digital downloads).

■ Authorization. Called from the eSales - Authorize Order Process workflow. 
Allocates to the merchant a specific amount of the credit available to the 
cardholder, typically for one week. No funds are transferred.

The merchant authorizes a credit card to make sure of the following:

■ The customer has the funds to pay for the purchase.
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■ These funds are reserved until the merchant is able to ship the product. 
Credit card companies typically state that a merchant should not settle until 
the product has been shipped.

■ Charge. Used to settle charges. A settlement request includes the authorization 
code and requests that funds be transferred from the cardholder's account to the 
merchant's bank account.

■ Process. Not used, but available to customers for calling other methods from the 
third-party adapter.

■ Refund. Takes place after a settlement when the merchant needs to transfer 
money back to the cardholder, as in the case of a return.

■ Reverse. Releases the amount of money reserved by an authorization. This 
transaction, not supported by CyberSource, is important because authorizations 
reserve part of a cardholder's credit and therefore reduce the total amount of 
credit available.

The arguments for these methods are:

■ Input:

■ Output:

■ Validate. Checks the credit card number, using the Mod 10 algorithm to make 
sure that it is valid, and the expiration date. This is done by Siebel during rapid 
checkout and after selecting and saving payment information, not by 
CyberSource.

The arguments for Validate are:

■ Row Id

■ Siebel Input Integration Object

■ Siebel Output Integration Object

■ Siebel to Vendor Map Name

■ Vendor to Siebel Map Name

■ Vendor Name

■ Credit Card Response Code

■ Credit Card Response Message
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■ Input:

■ Output: Error Message

Business Service User Properties
The business service user properties specify the adapter business service to call, the 
configuration object to use, the vendor integration objects to use, and the text of the 
error messages. The active business service user properties are shown in Table 18.

■ Credit Card Number

■ Credit Card Type

■ Expiration Month

■ Expiration Year

■ Return Error Code

Table 18. Credit Card Transaction Service User Properties

Business Service User Property Value

Create Order on Web 1, 18, 19, 20, 21

These response codes will not return an error. Administrators 
should query for orders with these message types and 
investigate them manually. For more information, see 
Chapter 6, “Administrative Tasks.”

CyberSourceICS2:Adapter Business Service CyberSource Adapter Service

CyberSourceICS2:AuthCharge Object 
(Vendor Input)

CreditCard - Authorization (CyberSource Input)

CyberSourceICS2:AuthCharge Object 
(Vendor Output)

CreditCard - AuthCharge (CyberSource Output)

CyberSourceICS2:Authorization Object 
(Vendor Input)

CreditCard - Authorization (CyberSource Input)

CyberSourceICS2:Authorization Object 
(Vendor Output)

CreditCard - Authorization (CyberSource Output)

CyberSourceICS2:Charge Object (Vendor 
Input)

CreditCard - Charge (CyberSource Input)
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CyberSourceICS2:Charge Object (Vendor 
Output)

CreditCard - Charge (CyberSource Output)

CyberSourceICS2:Configuration Object CreditCard - Configuration (CyberSource)

CyberSourceICS2:Refund Object (Vendor 
Input)

CreditCard - Refund (CyberSource Input)

CyberSourceICS2:Refund Object (Vendor 
Output)

CreditCard - Refund (CyberSource Output)

Response Message:1 Transaction was successful.

Response Message:2 Transaction was not successful. Please call your credit card 
company or try another credit card.

Response Message:3 Transaction was declined. Please select another credit card.

Response Message:4 There is a problem with this credit card. Please select another 
credit card.

Response Message:5 Your credit card has expired. Please select another card.

Response Message:6 Please check the credit card details or select another card.

Response Message:7 Your credit card is invalid. Please check the card details or 
select another credit card.

Response Message:8 Transaction declined by the bank. Please select another credit 
card.

Response Message:9 Your credit card number does not match the card type. Please 
check the card details or select another credit card.

Response Message:10 The billing address you entered does not match the billing 
address of your credit card. Please check the card details or 
select another card.

This response is given when CyberSource returns DAVSNO. 
For more information, see “Address Verification with 
CyberSource” on page 181.

Response Message:11 Please check to make sure you have entered complete credit 
card information.

Table 18. Credit Card Transaction Service User Properties

Business Service User Property Value
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The complete response messages, and not the codes, are shown in the Siebel eSales 
application.

For more information on modifying business service user properties, see Siebel Tools 
Reference.

Response Message:12 There is not enough available credit on this card. Please select 
another credit card.

Response Message:13 There was an error in processing. Please check the credit card 
information and try again or select another credit card.

Response Message:14 This type of credit card is not accepted. Please select another 
card.

Response Message:15 There is no corresponding, unused authorization record. 
Please authorize for this amount prior to settling.

Response Message:16 A credit or refund is only allowed when there is a 
corresponding settlement transaction referenced.

Response Message:17 Transaction has been settled, so it cannot be voided.

Response Message:18 You are not authorized to perform this transaction type.

Response Message:19 Error happened in adapter business service. Please contact 
your application administrator.

Response Message:20 Error occurred in CyberSource. Please contact your 
application administrator.

Response Message:21 The connection to CyberSource has timed out. Please try the 
operation later.

Table 18. Credit Card Transaction Service User Properties

Business Service User Property Value
Version 7.5, Rev. A Siebel eSales Administration Guide 171



Using Third-Party Payment Applications

CyberSource Integration with Siebel eSales
Integration Objects
Integration objects are used to pass values, static or dynamic, to the business 
service. The architecture is modular, in that different integration objects can be 
created and used for the same core business service.

The integration objects for the Quote and Order business components and 
CyberSource are detailed here. Integration objects also exist for the Auction Invoice 
business component.

Configuration
CreditCard - Configuration (CyberSource) has the user properties shown in 
Table 19.

Table 19. Credit Card - Configuration (CyberSource) User Properties

User Property Value Comments

VendorDll ics2api Do not use prefix and extension.

This is necessary for compatibility with 
Solaris.

customer_email nobody@nowhere.com CyberSource enforces the format.

customer_phone (000) 000-0000 CyberSource requires at least six digits.

ignore_avs no CyberSource needs “yes” or “no.”

This is only used for the AuthCharge 
transaction.

merchant_id ICS2Test CyberSource varchar(20), case-sensitive.

Change this to your merchant ID. You can 
obtain a merchant ID for each division of 
your organization. The merchant IDs are 
set in the Divisions view under the Group 
Administration screen.

server_host ics2test.ic3.com

server_port 80
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Authorization
■ CreditCard - Authorization (CyberSource Input). Its integration component is 

Invoice, with the following fields:

■ CreditCard - Authorization (CyberSource Output). Its integration component is 
Invoice, with the following fields:

timeout 90 In seconds. The default is 90.

decline_avs_flags N Comma-separated list of AVS codes that 
result in an AVS decline.

For more information, see “Address 
Verification with CyberSource” on 
page 181.

■ Amount ■ Bill To City ■ Bill To Country

■ Bill To State ■ Bill To Street Address ■ Bill To Street Address 2

■ Bill To Zipcode ■ Card Expiration Month ■ Card Expiration Year

■ Card Holder Name ■ Card Issue Number ■ Card Number

■ Card Start Month ■ Card Start Year ■ Card Verification Value

■ Currency Code ■ Duty Amount ■ Email Address

■ Ignore AVS ■ Ignore Bad CV ■ Merchant Id

■ National Tax ■ Phone Number ■ Product Code

■ Purchaser Code ■ Purchaser VAT Reg No ■ Quantity

■ Row Id ■ Ship From Zipcode ■ Ship To Country

■ Ship To Zipcode ■ Summary Commodity Code ■ Tax Amount

■ Tax Indicator ■ VAT rate

■ AVS ■ Application Resp Code

■ Application Resp Flag ■ Application Resp Msg

■ Authorization Code ■ Authorization Resp Code

■ Authorization Resp Flag ■ Authorization Resp Msg

Table 19. Credit Card - Configuration (CyberSource) User Properties

User Property Value Comments
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■ CreditCard - Payments. Its integration component is Credit Card Payments, with 
the following fields:

■ CreditCard - Quote - Authorization (Siebel Input). Its integration component is Quote, 
with the following fields:

■ CreditCard - Quote - Authorization (Siebel Output). Its integration component is 
Quote, with the following fields:

■ Authorization Response ■ Authorized Amount

■ Authorized Time ■ CV Result

■ Request Id ■ Row Id

■ Authorization Code ■ Bill To City

■ Bill To Country ■ Bill To State

■ Bill To Street Address ■ Bill To Street Address 2

■ Bill To Zipcode ■ Card Holder Name

■ Card Number ■ Card Type

■ Card Verification Number ■ Credit Card Response Code

■ Credit Card Transaction Amount ■ Credit Card Transaction ID

■ Credit Card Transaction Status ■ Credit Card Transaction Time

■ Credit Status ■ Credit Status Message

■ Currency Code ■ Expiration Month

■ Expiration Year ■ Merchant Id

■ Row Id ■ Transaction Id

■ Credit Card Authorization Code

■ Credit Card Transaction Amount

■ Credit Card Transaction ID

■ Credit Card Transaction Status

■ Quote Number

■ Amount ■ Bill To City

■ Bill To Country ■ Bill To State
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Settle (Charge)
■ CreditCard - Charge (CyberSource Input). Its integration component is Invoice, with 

the following fields:

L

■ CreditCard - Charge (CyberSource Output). Its integration component is Invoice, 
with the following fields:

■ Bill To Street Address ■ Bill To Street Address 2

■ Bill To Zipcode ■ Card Expiration Month

■ Card Expiration Year ■ Card Holder Name

■ Card Number ■ Card Type

■ Currency Code ■ Email Address

■ Home Phone ■ Quote Number

■ Work Phone

■ Amount ■ Auth Request Id

■ Authorization Code ■ Authorization Type

■ Currency Code ■ Duty Amount

■ Merchant Descriptor ■ Merchant Descriptor Contact

■ Merchant Id ■ National Tax

■ Product Code ■ Product Name

■ Purchaser Code ■ Purchaser VAT Reg No

■ Quantity ■ Row Id

■ Ship From Zipcode ■ Ship To Country

■ Ship To Zipcode ■ Summary Commodity Code

■ Tax Amount ■ Tax Indicator

■ VAT rate

■ Application Resp Code ■ Application Resp Flag

■ Application Resp Msg ■ Charge Resp Code

■ Charge Resp Flag ■ Charge Resp Msg

■ Charge Trans Ref Number ■ Charged Amount

■ Charged Time ■ Request Id
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Authorize and Settle (AuthCharge)
■ CreditCard - AuthCharge (CyberSource Output). Its integration component is 

Invoice, with the following fields:

■ CreditCard - Quote - AuthCharge (Siebel Input). Its integration component is Quote, 
with the following fields:

This integration object is not used out of the box. CreditCard - Quote - 
Authorization (Siebel Input) can be used for this method.

Refund
■ CreditCard - Refund (CyberSource Input). Its integration component is Invoice, with 

the following fields:

■ Row Id

■ AVS ■ Application Resp Code

■ Application Resp Flag ■ Application Resp Msg

■ Authorization Code ■ Authorization Resp Code

■ Authorization Resp Flag ■ Authorization Resp Msg

■ Authorization Response ■ Authorized Amount

■ Authorized Time ■ CV Result

■ Charge Resp Code ■ Charge Resp Flag

■ Charge Resp Msg ■ Charged Amount

■ Charged Time ■ Request Id

■ Row Id

■ Credit Card Transaction Amount

■ Credit Card Transaction ID

■ Credit Card Transaction Status

■ Quote Number

■ Amount ■ Bill Request Id ■ Bill To City

■ Bill To Country ■ Bill To State ■ Bill To Street Address
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■ CreditCard - Refund (CyberSource Output). Its integration component is Invoice, 
with the following fields:

For more information on integration objects, see Integration Platform Technologies: 
Siebel eBusiness Application Integration Volume II and Siebel Tools Reference.

■ Bill To Zipcode ■ Card Expiration Month ■ Card Expiration Year

■ Card Holder Name ■ Card Issue Number ■ Card Number

■ Card Start Month ■ Card Start Year ■ Currency Code

■ Duty Amount ■ Email Address ■ Merchant Descriptor

■ Merchant Descriptor 
Contact

■ Merchant Id ■ National Tax

■ Phone Number ■ Product Code ■ Purchaser Code

■ Purchaser VAT Reg No ■ Quantity ■ Row Id

■ Ship From Zipcode ■ Ship To Country ■ Ship To Zipcode

■ Summary Commodity 
Code

■ Tax Amount ■ Tax Indicator

■ VAT rate

■ Application Resp Code ■ Application Resp Flag

■ Application Resp Msg ■ Refund Amount

■ Refund Auth Response ■ Refund Resp Code

■ Refund Resp Flag ■ Refund Resp Msg

■ Refund Time ■ Refund Trans Ref Number

■ Request Id ■ Row Id
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Data Maps
Data maps are used to map fields in one integration object to another integration 
object. The data maps used in credit card transactions are specified in the call to the 
business service.

You can view data maps by navigating to Integration Administration > Data Map 
Browser.

The data maps used in credit card transactions are shown in Table 20.

Table 20. Data Maps Used in Credit Card Transactions

Data Map Source Integration Object Target Integration Object

Authorization from Quote

CreditCardAuthorization_ 
Quote2CyberSource

CreditCard - Quote - 
Authorization (Siebel 
Output)

CreditCard - Authorization 
(CyberSource Input)

CreditCardAuthorization_ 
CyberSource2Quote

CreditCard - Authorization 
(CyberSource Output)

CreditCard - Quote - 
Authorization (Siebel Input)

Authorization from Payments

CreditCardAuthorization_ 
Payments2CyberSource

CreditCard - Payments CreditCard - Authorization 
(CyberSource Input)

CreditCardAuthorization_ 
CyberSource2Payments

CreditCard - Authorization 
(CyberSource Output)

CreditCard - Payments

Charge from Payments

CreditCardCharge_ 
Payments2CyberSource

CreditCard - Payments CreditCard - Charge 
(CyberSource Input)

CreditCardCharge_ 
CyberSource2Payments

CreditCard - Charge 
(CyberSource Output)

CreditCard - Payments

AuthCharge from Quote

CreditCardAuthorization_ 
Quote2CyberSource

CreditCard - Quote - 
Authorization (Siebel 
Output)

CreditCard - Authorization 
(CyberSource Input)
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For more information on modifying integration objects and data maps, see 
Integration Platform Technologies: Siebel eBusiness Application Integration Volume 
II and Siebel Tools Reference.

CyberSource Adapter Service Business Service
The CyberSource Adapter Service business service does the following:

■ Receives input from the Credit Card Transaction Service business service in XML 
format.

■ Processes the data and uses Siebel eScript to call the CyberSource API.

■ Gets the payment information from CyberSource using the CyberSource API.

■ Passes XML data back to the Credit Card Transaction Service business service.

The CyberSource Adaptor Service consists of methods, user properties, and scripts 
written in Siebel eScript:

■ Methods:

CreditCardAuthCharge_ 
CyberSource2Quote

CreditCard - AuthCharge 
(CyberSource Output)

CreditCard - Quote - 
AuthCharge (Siebel Input)

AuthCharge from Payments

CreditCardAuthorization_ 
Payments2CyberSource

CreditCard - Payments CreditCard - Authorization 
(CyberSource Input)

CreditCardAuthCharge_ 
CyberSource2Payments

CreditCard - AuthCharge 
(CyberSource Output)

CreditCard - Payments

Refund from Payments

CreditCardRefund_ 
Payments2CyberSource

CreditCard - Payments CreditCard - Refund 
(CyberSource Input)

CreditCardRefund_ 
CyberSource2Payments

CreditCard - Refund 
(CyberSource Output)

CreditCard - Payments

Table 20. Data Maps Used in Credit Card Transactions

Data Map Source Integration Object Target Integration Object
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■ Authorization, with arguments inputXML and outputXML

■ Charge, with arguments inputXML and outputXML

■ Refund, with arguments inputXML and outputXML

■ Start, with argument outputXML

■ Scripts:

■ (declarations). Defines the variables used in the business service scripts.

■ CallCyberSource. Converts the XML to a property set, and then gets values 
from the property set to construct the message used by CyberSource. Calls 
CyberSource to get the result. Uses the result to construct a property set, and 
then converts it to XML.

■ FillOutIntObj. Used to construct the property set from the CyberSource result.

■ FillRequestObj. Used to construct the CyberSource message from the property 
set.

■ Initialize. Initializes the variables for the service. Variables to initialize are 
passed in by setting the values in the CreditCard - Configuration 
(CyberSource) integration object user properties.

■ LogMessage. Writes to the log file the buffers that are passed to CyberSource 
and received from CyberSource, if the Debug flag is set.

■ SendCmd. Used to call CyberSource with a different method.

■ Service_PreInvokeMethod. Starting point where the business service is called.

■ SetResponseCode. Used to map CyberSource error flags to Siebel response 
codes.

■ ThrowError. Generates the error messages that are set up in the Credit Card 
Transaction Service business service user properties.

To examine the Siebel eScripts in the CyberSource Adapter Service business 
service, right-click the business service in Siebel Tools, and then choose Edit 
Server Scripts.

For more information on Siebel eScripts, see Siebel Tools Online Help.
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Address Verification with CyberSource
Address Verification will fail when CyberSource returns DAVSNO as the reply code. 
When DAVSNO is returned, an authorization code will still be returned to your 
Siebel application. The values for the decline_avs_flags business service user 
property can be used to indicate which address verification results should result in 
DAVSNO being returned by CyberSource. From Siebel eSales, N is passed to 
CyberSource, indicating that when this result is received by CyberSource for the 
address verification check, DAVSNO will be returned to your Siebel application. To 
indicate that other address verification responses should result in DAVSNO being 
returned to your Siebel application, add the values to the decline_avs_flags business 
service user property. In the event that you want to authorize and settle at the same 
time, you can indicate that address verification results should be ignored by setting 
the ignore_avs business service user property to yes.
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Customizing Cybersource Integration
Siebel eSales integration with CyberSource can be customized. Some examples are 
modifying scripts, passing more fields to CyberSource, and performing credit card 
processing on data in other business components.

Modifying the Scripts in the CyberSource Adapter Service
As the scripts in the CyberSource Adapter Service are written in Siebel eScript, they 
can be readily modified.

For more information on Siebel eScripts, see Siebel Tools Online Help. For more 
information on debugging scripts, see Siebel Tools Reference.

To modify scripts in the CyberSource Adapter Service business service

1 In Siebel Tools, lock the EAI CreditCard project.

2 Select the Business Service object.

3 Select the CyberSource Adapter Service, copy it, and then rename the copy as a 
backup.

4 Right-click CyberSource Adapter Service, and then choose Edit Server Scripts.

The server script editor appears.

5 Edit the desired scripts, and then close the edit window.

6 Compile the .srf file, selecting the Locked projects radio button.

Passing Data from Other Fields in the Siebel Database
You can add data fields to those passed to CyberSource.

For more information on modifying integration objects, see Integration Platform 
Technologies: Siebel eBusiness Application Integration Volume II. For more 
information on modifying scripts, see Siebel Tools Reference.
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To add a data field

1 In Siebel Tools, add the field to the appropriate Cybersource input and output 
integration objects.

2 Modify the (declarations) script in the CyberSource Adapter Service business 
service to add the field to the correct output object, for example 
ICS2OBJS[“Authorization”].OutputFields.

3 In your Siebel application, navigate to Integration Administration > Data Map 
Editor.

4 Update the data map so that data from the appropriate Siebel field will be passed 
to the CyberSource integration object.

Passing Data from Fields Not in the Siebel Database
There are three ways to pass data from fields that do not exist in the Siebel database:

■ Add the field to the database, add it to the necessary integration object, and then 
update the data map.

■ Set an existing business service user property in the Credit Card Transaction 
Service business service, or create a new one, with a static value for all 
transactions. These values are read at initialization of the business service.

Any data passed dynamically using the integration objects will overwrite the 
value in the business service user property for that particular transaction.

■ Set a value for an integration object field by setting the value in the data map.

You cannot set a default value for an integration object user property because 
the Credit Card Transaction Service business service does not look for this value 
at initialization.

NOTE: The auth_cv_result reply field contains details of the card verification check. 
This data is not stored in the Siebel database but you can use it to store additional 
information or drive additional logic.
Version 7.5, Rev. A Siebel eSales Administration Guide 183



Using Third-Party Payment Applications

Customizing Cybersource Integration
Calling the Credit Card Transaction Service from Other Places in Siebel 
eSales

A business service can be called from any of the following:

■ Button, if the applet the button is in is of the CSSBCBase class

■ Workflow

■ Script, either Siebel eScript or Siebel VB

To call the Credit Card Transaction Service business service

1 Use the GetService() method to get an instance of the business service.

2 Use Service_InvokeMethod() to invoke a method of the business service.

3 Use SetProperty() to pass values for the business service method arguments that 
need to be set.

See “Business Service Methods” on page 167 for the business service method 
arguments of the Credit Card Transaction Service.

Calling the Credit Card Transaction Service from Other Business 
Components

The Credit Card Transaction Service business service can be called from other 
business components besides Quote, Order, and Auction Invoice.

To call the Credit Card Transaction Service from another business component

1 Choose where to call the business service (button, workflow, or script).

2 In Siebel Tools, create integration objects for the business component to pass the 
correct data to the business service.

3 In your Siebel application, navigate to Integration Administration > Data Map 
Editor.

4 Create integration object maps for the business component integration objects.
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Using Other Third-Party Payment Applications
Using other payment services requires modifying the CyberSource Adapter Service 
business service or writing a new one. Because the scripts in the CyberSource 
Adapter Service are in Siebel eScript, they can be readily modified.

For more information on Siebel eScripts, see Siebel Tools Online Help. For more 
information on business services and on debugging scripts, see Siebel Tools 
Reference.

NOTE: After creating the new payment business service, you must create or modify 
integration objects and data maps for it.

To create a new payment business service

1 In Siebel Tools, lock the EAI CreditCard project.

2 Select the Business Service object.

3 Select the CyberSource Adapter Service and copy it.

4 Rename the copy, for example New Payment Adapter.

5 Right-click New Payment Adapter, and then choose Edit Server Scripts.

The server script editor appears.

6 Modify the desired scripts, and then close the edit window.

7 Edit the business service user properties of the Credit Card Transaction Service 
Business Service to call the New Payment Adapter business service.

8 Compile the .srf file, selecting the Locked projects radio button.
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Applications 8
This chapter tells you how to set up the ability to check the credit standing of 
customers who want to pay with a purchase order.
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About Using Purchase Order Credit Checking 
Applications

Before an order for products or services can be completed through your Siebel 
eSales Web site, your company may want to assess whether the customer has a 
credit rating that is good enough for you to sell to them. Different applications are 
used to perform credit checks depending on the method of payment.

■ For customers paying with a credit card, credit checks are performed by a third-
party payment application. For more information about third-party payment 
applications, see Chapter 7, “Using Third-Party Payment Applications.”

■ For business customers paying with purchase orders, credit checks on the 
customer account are performed by a back-office, third-party accounts 
receivable or credit management application. This chapter describes how to set 
up these applications.

Third-party accounts receivable or credit management applications use logic to 
make a credit determination based on your company’s previous history with the 
customer account and other credit data.

Integration with third-party credit checking applications uses a specific, prebuilt 
Application Services Interface (ASI) named External Credit Check. Some 
configuration is required to set up this integration.

For information about how to extend these integration objects, see Integration 
Platform Technologies: Siebel eBusiness Application Integration Volume II.

Credit checks are performed as part of the process of checking out after the 
customer clicks the Check Out button.

Two workflows directly control the process of checking the credit status of business 
accounts. These are:

■ eSales - Authorize Order Process

■ Credit Check - Quotes
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For more information about the checking out process, including the details of these 
workflows, see Chapter 4, “Modifying Order Workflows.”

NOTE: Purchase order credit checks can also be made on a quote or order from an 
employee application, such as Siebel Sales or Siebel Call Center. These would be 
initiated by call center agents, sales administrators, and sales representatives. For 
information about how to set up a purchase order credit checking integration from 
an employee application, see Siebel Order Management Guide.

For more information about to how to set up, use, and modify integrations based 
on ASIs, see Integration Platform Technologies: Siebel eBusiness Application 
Integration Volume II.
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To set up the use of third-party credit check application, you must:

■ Verify the External Credit Check ASI user properties.

■ Configure the Web Service.

■ Activate the workflows.

Verifying the External Credit Check ASI User Properties
You must verify the External Credit Check ASI user properties.

To verify the External Credit Check ASI user properties

1 In Siebel Tools, select the External Credit Check business service.

2 Select Business Service User Prop.

3 Verify that the Names and Values of the User Properties match those in the 
following table.

Configuring Web Services
Web services are used to direct the inbound and outbound messages to and from:

■ The third-party credit checking application.

■ A demonstration script that can be used to test your integration setup.

■ Middleware or integration server that will integrate with your fulfilment engine.

You must make sure that the Web services are correctly configured.

Name Value

siebel_port_name Default

siebel_web_service_name External Credit Check

siebel_web_service_namespace http://siebel.com/asi/
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To configure the Web services

1 Navigate to the Web Services Administration screen.

2 From the Show drop-down list, select Outbound Web Services.

3 Select the row with External Credit Check in the Name field.

4 Verify that the fields in the Outbound Web Services list match those in the 
following table.

5 In the Service Ports list, click New, and enter the following values in the fields 
of the new record.

For more information about configuring Web Services and setting up demonstration 
scripts, see Integration Platform Technologies: Siebel eBusiness Application 
Integration Volume II.

Namespace Name Status

http://siebel.com/asi/ External Credit Check Active

Field Comments

Name Enter a name for the port.

Port Type Enter External Credit Check.

Transport Select from the drop-down list.

If you want to set up testing, for example when you are customizing 
applets or extending the ASI, select Local Business Service.

Address When you select a transport, the field will be populated with a 
template address. Edit the address based on where you are sending 
the data.

If you want to set up testing, enter Credit Check ASI Test.

Binding If a SOAP header is expected by the receiving application, select 
SOAP_RPC. 

If you are using Credit Check ASI Test, select Property Set.
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Activating the Workflows
You must activate the following workflows:

■ eSales - Authorize Order Process

■ Credit Check - Quotes

For information about activating workflows, see Integration Platform Technologies: 
Siebel eBusiness Application Integration Volume II.
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To set up the use of third-party credit checking systems, you may want to:

■ Modify the Credit Check Service business service user properties.

■ Turn off credit checking.

■ Customize when credit checks are performed.

■ Change the account credit auto-approval limit.

■ Skip credit checks for an account.

■ Restrict which employees can administer credit checking.

■ Extend the ASI.

Modifying the Credit Check Service Business Service User Properties
Some of the user properties of the Credit Check Service business service are used to 
map integration object fields to their related business component fields. For 
example the BC_CREDIT_DATE user property has a value of Credit Check Status As 
Of Date, which is the name of a business component field on the Quotes and 
Payments business components. The PROP_SET_CREDIT_DATE user property has 
a value of Credit Status As Of, which is the name of an integration object field. 
Together, these values show that the data in the Credit Status As Of integration 
object field is moved to the Credit Check Status As Of Date business component 
field. You should not need to modify these values.

You will need to modify the value of the ERROR_STATUS_CODE user property if it 
does not match the value of the error code returned from the middleware.

To modify the error status code

1 In Siebel Tools, select Business Service in the Object Explorer.

2 Query for the Credit Check Service business service.

3 Select Business Service User Prop in the Object Explorer.

4 Change the value of the ERROR_STATUS_CODE user property to match the 
middleware value.
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Turning Off Credit Checking
You can turn off credit checking by removing the Credit Check subprocess step from 
the eSales - Authorize Order Process workflow.

Customizing the Credit Check - Quotes Workflow
A credit check does not need to be performed on every order that will be paid for 
with a purchase order. You can customize the Credit Check - Quotes workflow to 
control under what circumstances credit check is performed.

For more information about this workflow, see Chapter 4, “Modifying Order 
Workflows.”

Changing the Credit Auto-Approval Limit For Accounts
You can control when a credit check is performed by changing the credit auto-
approval limit of particular accounts using:

■ Siebel Tools, in which you can set a pre-default value that will be applied to new 
accounts.

■ A batch eScript, to set a limit for all accounts.

■ Manual editing for individual accounts.

NOTE: Do not confuse the Credit Auto Approval Limit field with the PO Auto 
Approval Limit field.

Directions for the manual editing method are given in Chapter 6, “Administrative 
Tasks.”

Skipping Credit Checks For an Account
You can skip automatic credit checking for particular accounts by changing the 
value of the Skip Credit Check field. You can do this by manually editing this field 
for individual accounts.

For more information see Chapter 6, “Administrative Tasks.”
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Restricting Which Employees Can Administer Credit Checking
There are two ways to restrict which employees can administer credit checking on 
accounts.

■ Create a read-only version and a read-write version of the Account Detail - Credit 
Profile view. Give employees who should administer credit checking access to 
the read-write view. Give employees who should not administer credit checking 
access to the read-only view.

■ Add a rule or logic to restrict who can update fields related to credit checking. 
For example, only allow an account’s primary sales representative to update 
these fields.

Extending the Credit Check Interface Request
If you want to extend the Credit Check Interface Request, you must add fields to:

■ The following published interfaces:

■ Credit Check Interface Response

■ Credit Check Interface Request

■ The following internal objects:

■ Credit Check Interface Request - Quote

■ Credit Check Interface Request - Order
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This will create the necessary mapping between the credit check interface structure 
and the Siebel Quote and Order business components. Make sure that the 
Integration Component Field names of the internal and external integration objects 
match. Table 21 uses the Priority field as an example.

For information about how to extend the integration object, see Integration Platform 
Technologies: Siebel eBusiness Application Integration Volume II.

Table 21. Naming Fields

Object Name Name External Name

Credit Check Interface Request Priority none

Credit Check Interface Request - Quotes Priority <Mapping of the Priority field to the 
correct field on the Quotes 
Buscomp>

Credit Check Interface Request - Orders Priority <Mapping of the Priority field to the 
correct field on the Orders Buscomp>
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This chapter describes how to set up and use Taxware applications.
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Taxes are calculated on quotes as part of the eSales - Complete Checkout Process 
workflow. The Calculate Taxes step calls the Tax Calculator business service, which 
uses the Taxware Adapter Service business service to make a call to Taxware. The 
calculated sales tax from Taxware is copied to the quote. When the quote is turned 
into an order, the tax information is copied to the order.

NOTE: The preconfigured integration allows tax calculations for the many countries 
supported by Taxware. For the latest list of supported countries, see 
www.taxware.com.

Taxware Applications
Taxware International is a third-party service used to calculate the sales tax on 
orders. Siebel eSales is designed to work with the following Taxware modules:

■ Sales/Use. Calculates sales and use taxes on purchases made in the United States 
and Canada. Sales/Use can be configured for product-specific taxation. This is 
done by using the Taxware Sales/Use Toolkit to map the product’s part number 
in the Siebel application to its Tax Code in Sales/Use.

■ WORLDTAX. Calculates sales and use taxes on purchases made outside the United 
States and Canada. WORLDTAX can be configured for product-specific taxation. 
This is done by using the Taxware WORLDTAX Toolkit to map the product’s part 
number in the Siebel application to its Commodity/Service Code in WORLDTAX.

■ STEP. Enables sales tax exemptions and works in conjunction with the Sales/Use 
module. A Siebel eSales customer is exempt from sales tax if the Siebel account 
with which the customer is associated has a tax certificate lodged in the STEP 
module. This is done by entering the Siebel account ID (row ID) in the STEP 
Customer ID field on the STEP certificate entry form.

■ Universal Tax Link (UTL). Integrates external applications with the Sales/Use and 
WORLDTAX modules through a common gateway.

■ VERAZIP. Used for address verification. It matches state, ZIP Code, city, and 
county information to make sure that an address is correct and complete, so that 
the Sales/Use Tax System will be able to locate the correct taxing jurisdiction.
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For more information, see your Taxware documentation.

NOTE: A product’s part number can be found in the Products screen of your Siebel 
application. The row ID of an account is found by clicking the menu button and 
selection About Record with the account selected in the Accounts screen.
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Installing Taxware Applications on Windows
Siebel supports the use of Taxware software on the Windows NT and Windows 2000 
platforms.

For more information on installing Taxware, see your Taxware documentation. For 
information on which versions of Taxware are supported by Siebel applications, see 
the system requirements and supported platforms documentation for your Siebel 
application.

NOTE: The drive on which Taxware applications are installed should have at least
1 GB of free disk space. Over time, the sizes of Taxware applications increase as log 
files and tax certificates are generated.

Installing Sales/Use on Windows
The instructions given here assume that the drive with the Taxware installation
CD-ROM is E: and the drive on which Taxware is installed is C:.

To install Sales/Use

1 Create a C:\Taxware directory.

2 Run E:\32bitsys\toolInt3\install.exe.

The Welcome screen appears.

3 Click Next.

The Select Destination Directory screen appears.

4 Choose C:\Taxware\SalesUse as the installation directory, and then click Next.

The Ready to Install screen appears.

5 Click Next.

The Program Menu Folder dialog box appears.
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6 Type TAXWARE Applications Sales Tax, and then click OK.

Sales/Use is installed, and the Installation Completed screen appears.

7 Click Finish to exit the installer.

8 Copy all the files from E:\32bitsys\salestax\data and E:\32bitsys\verazip\data 
to C:\Taxware\SalesUse\indata.

9 Change the permissions of all parameter files (Param*) in 
C:\Taxware\SalesUse\indata to allow read and write access.

Installing STEP on Windows
The instructions given here assume that the drive with the Taxware installation
CD-ROM is E: and the drive on which Taxware is installed is C:.

To install STEP

1 Run E:\32bitsys\Stepfe32\install.exe.

The Welcome screen appears.

2 Click OK.

The Select Destination Directory screen appears.

3 Choose C:\Taxware\STEP as the installation directory, and then click OK.

The Select Group or Folder dialog box appears.

4 Type TAXWARE Applications STEP, and then click OK.

STEP is installed, and the STEP System Installation screen appears.

5 Click OK.

6 Copy all the files from E:\32bitsys\step\data to C:\Taxware\STEP\indata.

7 Change the permissions of all parameter files (Param*) in 
C:\Taxware\STEP\indata to allow read and write access.
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Installing UTL on Windows
The instructions given here assume that the drive with the Taxware installation
CD-ROM is E: and the drive on which Taxware is installed is C:.

To install UTL

1 Run E:\WorldTax\utlsetup.exe.

The Welcome screen appears.

2 Click Next.

The Choose Destination Location screen appears.

3 Choose C:\Taxware\UTL as the installation directory, and then click Next.

The Backup Replaced Files screen appears.

4 Select the Yes radio button, and then click Next.

The Select Backup Directory screen appears.

5 Choose C:\Taxware\UTL\BACKUP as the backup directory, and then click Next.

The Start Installation screen appears.

6 Click Next.

UTL is installed, and the Installation Complete screen appears.

7 Click Finish to exit the installer.
202 Siebel eSales Administration Guide Version 7.5, Rev. A



Using Third-Party Taxation Applications

Installing Taxware Applications on Windows
Installing WORLDTAX on Windows
The instructions given here assume that the drive with the Taxware installation
CD-ROM is E: and the drive on which Taxware is installed is C:.

To install WORLDTAX

1 Run E:\WorldTax\install.exe.

The Welcome screen appears.

2 Click Next.

The Select Destination Directory screen appears.

3 Choose C:\Taxware\WORLDTAX as the installation directory, and then click 
Next.

The Backup Replaced Files screen appears.

4 Select the Yes radio button.

5 Choose C:\Taxware\WORLDTAX\BACKUP as the backup directory, and then 
click Next.

The Select ProgMan Group screen appears.

6 Type TAXWARE Applications WORLDTAX, and then click Next.

The Ready to Install screen appears.

7 Click Next.

WORLDTAX is installed, and the Installation Completed screen appears.

8 Click Finish to exit the installer.
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Setting Up the Windows Environment
To set up the Windows environment, you must set the system Path variable.

To set the system Path variable

1 Choose Start > Settings > Control Panel > System.

The System Properties dialog box appears.

2 On Windows NT, click the Environment tab. On Windows 2000, click the 
Advanced tab, and then click Environment Variables.

The Environment Variables dialog box appears.

3 Add C:\Taxware\UTL to the system Path variable.

4 Restart the Siebel Server.
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Setting Up Taxware Applications on Windows
After installation, certain tasks must be performed, including:

■ Setting an administrator user name and password

■ Checking environment variables

■ Loading files

■ Putting your company information into the system

For more information on setting up Taxware applications, see your Taxware 
documentation.

Setting Up Sales/Use on Windows
The setup is done using the Sales/Use Tax System Toolkit.

For more information on using the Sales/Use Tax System Toolkit, see your Taxware 
documentation.

To set up Sales/Use

1 Choose Start > Programs > Taxware > Toolkit > toolkit.exe.

The Sales/Use Tax System Toolkit launches.

2 Click Security to set up an administrator user name and password, for example, 
sadmin/sadmin.

3 Close the application and relaunch it.

4 Click Environment to check the environment variables for Sales/Use Tax, STEP, 
and VERAZIP.

5 Click Tools, and then Load Files to load the Product Taxability File, Tax Master 
File, Zip Master File, and County File.

6 Click Nexpro to set up your company information.

7 Within Nexpro, click Nexus to set up the tax for some states, such as California.

8 Click Save to save the company information.
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9 Copy the files in C:\Taxware\SalesUse\toolkit\tlkout to 
C:\Taxware\SalesUse\outdata if the output directory for the Toolkit is different 
from the output directory for the Sales/Use Tax System.

Setting Up STEP on Windows
Setting up the STEP System is done in two parts. The first part of the setup is done 
from the Taxware installation CD-ROM.

For more information on using the STEP System, see your Taxware documentation.

To set up STEP

1 Run E:\STEP\toolkit\step.exe.

The STEP System launches.

2 Set up user names and passwords.

3 Check the environment variables.

4 Choose Utilities > Create Company ID to create several company IDs.

Use the same Company ID as for setting up the Company Nexus.

5 Choose Utilities > Load STEP Files to load the data files.

6 Choose Utilities > Load Reason Files to load the reason files.

7 Choose Files > Return to Certificate Screen to set up several company and 
customer certificates.

After you create several certificates, a transaction file called steptran is generated 
in C:\Taxware\STEP\stepfrnt.

8 Copy C:\Taxware\STEP\stepfrnt\steptran to C:\Taxware\STEP\indata.

The second part of the setup is done within the STEP System on the drive in which 
Taxware was installed.
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To load the transaction and reason files

1 Run C:\Taxware\STEP\toolkit\stepwin.exe.

The STEP System launches.

2 Choose Load/Update > Load Transaction File to load 
C:\Taxware\STEP\indata\steptran into C:\Taxware\STEP\outdata.

3 Choose Load/Update > Load Reason File to load the reason file.

Setting Up WORLDTAX on Windows
The setup is done using the WORLDTAX Toolkit.

For more information on using the WORLDTAX Toolkit, see your Taxware 
documentation.

To set up WORLDTAX

1 Run C:\Taxware\WORLDTAX\toolkit\wt200.exe.

The WORLDTAX toolkit launches.

2 Set up user names and passwords.

3 Check the environment variables.

4 Choose Tools > Load Files to load the Standard Information and Standard Rate 
Master File and Commodity/Service Master File.

This can take up to an hour and use 400 MB of disk space.

5 Choose Utilities > Company Information File to enter company information.

6 Choose Utilities > Commodity > Service Code Conversion to convert Siebel 
product numbers to Taxware Commodity/Service codes.
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Installing Taxware Applications on UNIX
Siebel supports the use of Taxware software on the Solaris and AIX platforms.

For information on installing Taxware, see your Taxware documentation. For 
information on which versions of Taxware are supported by Siebel applications, see 
the system requirements and supported platforms documentation for your Siebel 
application.

NOTE: The drive on which Taxware applications are installed should have at least
1 GB of free disk space. Over time, the sizes of Taxware applications increase as log 
files and tax certificates are generated.

To install Taxware on UNIX

1 Copy the installation tar file from Taxware to the Siebel Server, for example to 
siebel.tar.

2 Create a directory on the Siebel Server for installing Taxware, for example 
taxware.

3 Use the following command to extract the structure into the new directory just 
created:

tar xvf siebel.tar

4 Add the following variables to the .cshrc file:

setenv TAXWAREHOME = “<Taxware_directory>”

setenv TOOLKITEXE “$TAXWAREHOME/toolkit”

setenv TOOLKITOUT “$TAXWAREHOME/outdata”

setenv AVPIN “$TAXWAREHOME/indata”

setenv AVPOUT “$TAXWAREHOME/outdata”

setenv AVPTEMP “$TAXWAREHOME/temp”

setenv AVPAUDIT “$TAXWAREHOME/audit”

setenv ZIPIN “$TAXWAREHOME/indata”
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setenv ZIPOUT “$TAXWAREHOME/outdata”

setenv ZIPTEMP “$TAXWAREHOME/temp”

setenv ZIPAUDIT “$TAXWAREHOME/audit”

setenv STEPIN “$TAXWAREHOME/indata”

setenv STEPOUT “$TAXWAREHOME/outdata”

setenv STEPTEMP “$TAXWAREHOME/temp”

setenv STEPAUDIT “$TAXWAREHOME/audit”

setenv WTIN “$TAXWAREHOME/indata”

setenv WTOUT “$TAXWAREHOME/outdata”

setenv WTTEMP “$TAXWAREHOME/temp”

setenv WTAUDIT “$TAXWAREHOME/audit”

setenv WTDB “$TAXWAREHOME/outdata”

setenv WTSYSTEM “$TAXWAREHOME/indata”

setenv WTOUT “$TAXWAREHOME/outdata”

setenv WTCOUNTRY “GB”

setenv WTHOME “$TAXWAREHOME”

setenv XUSERFILESEARCHPATH “$TAXWAREHOME/lang/eng/%N”

setenv ERRMSGPATH “$TAXWAREHOME/lang/eng”

5 Add the following to $path: $TAXWAREHOME, $TAXWAREHOME/toolkit, and 
$TAXWAREHOME/utl.

6 Add $TAXWAREHOME/utl to LD_LIBRARY_PATH.

7 For the AIX platform, add $TAXWAREHOME/utl to LIBPATH.

8 Save the .cshrc file.

9 Enter the following command:

source .cshrc
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Setting Up Taxware Applications on UNIX
After installation, certain tasks must be performed, including:

■ Setting an administrator user name and password

■ Checking environment variables

■ Loading files

■ Putting your company information into the system

For more information on setting up Taxware applications, see your Taxware 
documentation.

Setting Up Sales/Use on UNIX
The setup is done using the Sales/Use Tax System Toolkit.

For more information on using the Sales/Use Tax System Toolkit, see your Taxware 
documentation.

To set up Sales/Use

1 Use XStart to run toolkit.

The Sales/Use Tax System Toolkit launches.

2 Click Security to set up an administrator user name and password, for example 
sadmin/sadmin.

3 Close the application and relaunch it.

4 Click Environment to check the environment variables for Sales/Use Tax, STEP, 
and VERAZIP.

5 Click Tools, and then Load Files to load the Product Taxability File, Tax Master 
File, Zip Master File, and County File.

6 Click Nexpro to set up your company information.

7 Within Nexpro, click Nexus to set up the tax for some states, such as California.

8 Click Save to save the company information.
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Setting Up WORLDTAX on UNIX
The setup is done using the WORLDTAX Toolkit.

For more information on using the WORLDTAX Toolkit, see your Taxware 
documentation.

To set up WORLDTAX

1 Use XStart to run wttoolkit.

The WORLDTAX toolkit launches.

2 Set up user names and passwords.

3 Check the environment variables.

4 Choose Tools > Load Files to load the Standard Information and Standard Rate 
Master File and Commodity/Service Master File.

This can take up to an hour and use 400 MB of disk space.

5 Choose Utilities > Company Information File to enter company information.

6 Choose Utilities > Commodity > Service Code Conversion to convert Siebel 
product numbers to Taxware Commodity/Service codes.
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Enabling Tax Calculation
To use Taxware applications with Siebel eSales, certain parameters must be set for 
the eSales Object Manager component of the Siebel Server.

Enabling Tax Calculation with the Sales/Use Tax System
To use the Sales/Use Tax System with Siebel eSales, you need to have company 
information defined in the Sales/Use Tax System Toolkit and on the Siebel Server.

To enable tax calculation with Sales/Use

1 In the Sales/Use Tax System Toolkit, define your Company ID and Company 
Location, for example SIEBEL and SAN MATEO.

2 In your Siebel application, navigate to Server Administration > Components > 
Component Parameters and set the following parameters for the eSales Object 
Manager:

SalesTaxCompanyID = Company ID
SalesTaxCompanyLoc = Company Location
SalesTaxType = Taxware
SalesTaxEnable = TRUE
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Enabling Tax Calculation with WORLDTAX
To use the WORLDTAX System with Siebel eSales, you need to have company 
information defined in the WORLDTAX Toolkit and on the Siebel Server.

To enable tax calculation with WORLDTAX

1 In the WORLDTAX Toolkit, define your Company ID and Business Location, for 
example SIEBEL_FR and FR (France).

2 In your Siebel application, navigate to Server Administration > Components > 
Component Parameters and set the following parameters for the eSales Object 
Manager:

SalesTaxCompanyID = Company ID
SalesTaxCompanyLoc = Company Location
SalesTaxType = Taxware
SalesTaxEnable = TRUE

3 In Siebel Tools, modify the user properties of the Tax - Configuration (Taxware) 
integration object, shown in the following table.

SHIPFROMCOUNTRY can also be passed dynamically by modifying the Tax 
Integration (Siebel Quote Output) integration object and the data map to the Tax 
Integration (Taxware Input) integration object.

Integration Object User Property Value

SHIPFROMCOUNTRY ISO country code of the ship-from country 
(for example, FR for France)

WorldTaxInstalled Y
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Taxing Customizable Products
Tax calculation is more complicated for customizable products because not all 
product components may need to be taxed. By default, for tax calculation, Siebel 
eSales submits the price of the product that is rolled up from its components. This 
means that if some of the component items do not need to be taxed, the tax 
calculation will be inaccurate.

You have the option of calculating tax at the component level for any customizable 
product. For information about how to set up taxation at the component level, see 
Product Administration Guide.
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Taxware Integration with Siebel eSales
Integration of Siebel eSales with third-party taxation applications involves two 
business services:

■ Tax Calculator

■ Taxware Adapter Service

Tax Calculator Business Service
The Tax Calculator business service controls the process shown in Figure 34:

■ Siebel EAI passes data from a quote record and the method name to a Siebel 
output integration object.

■ The Siebel Data Transformation Engine maps the Siebel output integration 
object to a Taxware input integration object.

■ The Siebel EAI XML Converter converts the Taxware input integration object 
into XML, using the CC XML Converter Business Service, and passes the XML 
data and method name to the Taxware Adapter Service.

Figure 34. Tax Calculation Process Flow
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■ The Taxware Adapter Service business service processes the data and uses Siebel 
eScript to call the Taxware API.

■ The Taxware Adapter Service gets the calculated sales tax from Taxware using 
the Taxware API.

■ The Taxware Adapter Service formats the sales tax data into an XML string.

■ The Siebel EAI XML Converter converts the XML into a Taxware output 
integration object.

■ The Siebel Data Transformation Engine maps the Taxware output integration 
object to a Siebel input integration object.

■ Siebel EAI updates the quote record with the calculated sales tax.

The Tax Calculator business service has one method, CalculateTax, with the 
following input arguments:

■ Siebel to Vendor Map Name

■ Vendor to Siebel Map Name

The Tax Calculator business service user properties are used to set the values given 
in Table 22.

For more information on business services, see Siebel Tools Reference.

Table 22. Tax Calculator Business Service User Properties

Business Service User Property Value

Taxware:Adapter Business Service Taxware Adapter Service

Taxware:Configuration Object Tax - Configuration (Taxware)

Taxware:Input IntObject Name Tax Integration (Taxware Input)

Taxware:Output IntObject Name Tax Integration (Taxware Output)
216 Siebel eSales Administration Guide Version 7.5, Rev. A



Using Third-Party Taxation Applications

Taxware Integration with Siebel eSales
Integration Objects
Integration objects are used to pass values, static or dynamic, to the business 
service. The architecture is modular, in that different integration objects can be 
created and used for the same core business service. For example, while the 
preconfigured integration supports the Quote business component, integration 
objects can be created to calculate taxes directly on the Order business component.

The Tax Calculator business service uses the following integration objects:
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■ Tax - Configuration (Taxware). Its user properties are shown in Table 23.

Table 23. Tax - Configuration (Taxware) User Properties

Integration Object User Property Value Comments

AUDFILEIND 2 Audit File Indicator: (1, 2, 3, 4)

■ 1: Audit File/Suspense File

■ 2: No Record stored on file

■ 3: Suspense File

■ 4: Audit File

EXEMPTUSEFLAG Y Exemption Use Flag: (Y, L, P, D, N)

■ Y: Call STEP, use default record.

■ L: Call STEP, do not use default 
record.

■ P: Call STEP, search by product 
code.

■ D: Call STEP, search by reason 
code and accept default 
customer.

■ N: Do not call STEP.

InputIntObjectName Tax 
Integration 
(Taxware 
Input)

OutputIntObjectName Tax 
Integration 
(Taxware 
Output)

SHIPFROMCOUNTRY US

SalesUseInstalled Y

VendorDll taxcommono Name of the shared library.

WorldTaxInstalled N
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■ Tax Integration (Siebel Quote). Its integration components are shown in Table 24.

Table 24. Tax Integration (Siebel Quote Integration Components)

Integration Component Fields

Quote Account Id

Currency Code

Current Quote Ship To City

Current Quote Ship To Country

Current Quote Ship To Postal Code

Current Quote Ship To State

EAI Error Message

Quote Number

Tax Amount

Quote Item Extended Line Total

Extended Quantity

Line Number

Line Total

Part Number

Quantity

Row Id

Sales Product Flag

Sales Service Flag

Tax Amount

Tax Subcomponent Flag

Taxable
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■ Tax Integration (Taxware Input). Its integration components are shown in Table 25.

See your Taxware documentation for more fields that can be passed. For 
information on how to pass more fields to Taxware, see “Passing Data from 
Other Fields in the Siebel Database” on page 226.

Table 25. Tax Integration (Taxware Input) Integration Components

Integration Component Fields That Pass Data from Siebel

Invoice Currency Code

Customer Id

Document Number

Invoice Number

Ship To City

Ship To Country

Ship To Postal Code

Ship To State

Invoice Item Line Number

Line Total

Part Number

Quantity

Sales Product Flag

Sales Service Flag

Ship to City

Ship to Country

Ship to Postal Code

Ship to State
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■ Tax Integration (Taxware Output). Its integration components are shown in 
Table 26.

Table 26. Tax Integration (Taxware Output) Integration Components

Integration Component Fields That Pass Data from Taxware

Invoice City Tax Amount

County Tax Amount

Error Message

Federal Tax Amount

Invoice Number

Secondary City Tax Amount

Secondary County Tax Amount

Secondary State Tax Amount

State Tax Amount
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See your Taxware documentation for more fields that can be passed.

For more information on integration objects, see Integration Platform Technologies: 
Siebel eBusiness Application Integration Volume II and Siebel Tools Reference.

Invoice Item City Basis Amount City Completion 
Code

City Tax Amount

City Tax Rate County Basis 
Amount

County 
Completion Code

County Tax 
Amount

County Tax Rate Federal Basis 
Amount

Federal 
Completion Code

Federal Tax 
Amount

Federal Tax Rate

General 
Completion Code

General 
Completion Code 
Desc

Line Number

Secondary City 
Basis Amount

Secondary City 
Completion Code

Secondary City Tax 
Amount

Secondary City Tax 
Rate

Secondary County 
Basis Amount

Secondary County 
Completion Code

Secondary County 
Tax Amount

Secondary County 
Tax Rate

Secondary State 
Basis Amount

Secondary State 
Completion Code

Secondary State 
Tax Amount

Secondary State 
Tax Rate

State Basis 
Amount

State Completion 
Code

State Tax Amount

State Tax Rate

Table 26. Tax Integration (Taxware Output) Integration Components

Integration Component Fields That Pass Data from Taxware
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Data Maps
Data maps are used to map fields in one integration object to another integration 
object. Data maps can be viewed by navigating to Integration Administration > 
Data Map Browser.

The data maps used in tax calculation, shown in Table 27, are specified in the call 
to the Tax Calculator business service.

For more information on modifying integration objects and data maps, see 
Integration Platform Technologies: Siebel eBusiness Application Integration Volume 
II and Siebel Tools Reference.

Table 27. Tax Calculation Data Maps

Data Map Source Integration Object Target Integration Object

TaxCalculation_QuoteToTaxware Tax Integration (Siebel 
Quote)

Tax Integration (Taxware 
Input)

TaxCalculation_TaxwareToQuote Tax Integration (Taxware 
Output)

Tax Integration (Siebel 
Quote)
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Taxware Adapter Business Service
The Taxware Adapter Service business service:

■ Receives input from the Tax Calculator business service in XML format.

■ Passes information to Taxware:

■ Static information from the Tax - Configuration (Taxware) integration object

■ Dynamic information from the Tax Integration (Taxware Input) integration 
object

■ Receives information back from Taxware.

■ Passes XML data back to the Tax Calculator business service.

The Taxware Adapter Service primarily consists of methods written in C++.

Audit File
Taxware uses an Audit File to store transactional information for tax reporting 
purposes. The Audit File for Sales/Use is a text file that can be edited. There is a 
special editor for the WORLDTAX Audit File that marks transactions that have been 
altered.

When calculating taxes in Siebel eSales, the audit file indicator (AUDFILEIND) 
should be set to 2 (No Record) because the customer has not yet confirmed the 
order.

To write to the audit file, a separate call to Taxware should be made from the order. 
This requires creating Order integration objects and mappings to the Taxware 
integration objects.

The value for AUDFILEIND can be set by changing the value in the
Tax - Configuration (Taxware) integration object user properties. For orders, a 
separate default value can be set in the data mapping.
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Address Verification for Taxware
Completion codes are returned that indicate the status of the process running UTL 
if one of the following occurs:

■ The customer enters an improper city/state/zip combination.

In most cases, the completion code appears, indicating that a jurisdiction error 
occurred, which means something was wrong with the zip/state combination.

■ The customer enters a city/state/zip combination that maps to more than one 
jurisdiction.

Taxware defaults to the most likely match and applies that rate for the 
transaction. The system generally uses the jurisdiction with the highest 
population, as rates for areas with greater population are usually higher than 
those for areas with less population. However, the default rate used is not always 
the highest rate out of the possible matches.
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Customizing Taxware Integration
Siebel eSales integration with Taxware can be customized. Some examples are 
passing more fields to Taxware, and performing tax calculations on data in other 
business components.

Passing Data from Other Fields in the Siebel Database
You can add data fields to those passed to Taxware. You must add the desired field 
to the appropriate integration objects and map the fields from your Siebel 
application to Taxware and from Taxware to your Siebel application.

For more information on modifying integration objects, see Integration Platform 
Technologies: Siebel eBusiness Application Integration Volume II. For more 
information on modifying scripts, see Siebel Tools Reference.

To add a data field

1 In Siebel Tools, add the field to the appropriate integration objects.

2 Activate the appropriate fields in Tax Integration (Taxware Input) and Tax 
Integration (Taxware Output) integration objects.

3 In your Siebel application, navigate to Integration Administration > Data Map 
Editor.

4 Update the data map so that the appropriate Siebel data will be passed to 
Taxware and an appropriate result will be passed back to the Siebel database.

Passing Data from Fields Not in the Siebel Database
There are three ways to pass data from fields that do not exist in the Siebel database:

■ Add the field to the database, add it to the necessary integration object, and then 
update the data map.
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■ Set an existing business service user property in the Tax Calculator business 
service, or create a new one, with a static value for all transactions. These values 
are read at initialization of the business service.

Any data passed dynamically using the integration objects will overwrite the 
value in the business service user property for that particular transaction.

■ Set a value for an integration object field by setting the value in the data map.

You cannot set a default value for an integration object user property because 
the Tax Calculator business service does not look for this value at initialization.

Calling the Tax Calculator Business Service from Other Places in Siebel 
eSales

A business service can be called from any of the following:

■ Button, if the applet the button is in is of the CSSBCBase class

■ Workflow

■ Script, either Siebel eScript or Siebel VB

For information on configuring applications and calling business services, see Siebel 
Tools Reference.

To call the Tax Calculator business service

1 Use the GetService() method to get an instance of the business service.

2 Use Service_InvokeMethod() to invoke a method of the business service.

3 Use SetProperty() to pass values for the business service method arguments that 
need to be set.

See “Tax Calculator Business Service” on page 215 for the arguments of the 
CalculateTax method of the Tax Calculator Business Service.
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Calling the Tax Calculator Business Service from Other Business 
Components

The Tax Calculator business service can be called from other business components 
besides Quote, for example Order. You can use the existing Tax Integration (Taxware 
Input) and Tax Integration (Taxware Output) integration objects for mapping.

To call the Tax Calculator business service from an order

1 Choose where to call the business service (button, workflow, or script).

2 In Siebel Tools, create integration objects for the Order business component to 
pass the correct data to the business service.

3 In your Siebel application, navigate to Integration Administration > Data Map 
Editor.

4 Create integration object maps for the Order integration objects and the Taxware 
integration objects.
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Using Other Third-Party Taxation Applications
The default Taxware Adapter Service uses a C++ business service, but an 
alternative script business service is provided for your use. If you want to use other 
third-party taxation applications, you will need to modify the Taxware Adapter 
Service (eScript) business service or write a new script. The script in the Taxware 
Adapter Service (eScript) is in Siebel eScript and can therefore be easily rewritten.

For more information on Siebel eScripts, see Siebel Tools Online Help. For more 
information on business services and on debugging scripts, see Siebel Tools 
Reference.

NOTE: Before creating the new tax adapter business service, you must create or 
modify integration objects and data maps for it.

To create a new tax adapter business service

1 In Siebel Tools, lock the EAI Tax project.

2 Select the Business Service object.

3 Select the Taxware Adapter Service (eScript) and copy it.

4 Rename the copy, for example New Tax Adapter (eScript).

5 Right-click New Tax Adapter (eScript), and then choose Edit Server Scripts.

The server script editor appears.

6 Rewrite the desired scripts, such as (declarations) and CallTaxware, and then 
close the edit window.

7 Edit the business service user properties of the Tax Calculator business service 
to call the New Tax Adapter (eScript) business service. The user properties 
include the names of the integration objects, the name of business service, and 
the name of the configuration object.

8 Compile the .srf file, selecting the Locked projects radio button.
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Handling Unicode Conversion Errors
For general information about Unicode support in Siebel applications, see Global 
Deployment Guide.

Taxware applications use the ASCII codepage. Fields that are passed from Siebel 
eSales to Taxware applications are therefore converted from Unicode UTF-16 
characters to ASCII characters.

Error Prevention
If non-ASCII characters are entered into a required field, an error will be generated 
during the codepage conversion. The error is contained in the Error Message field 
of the integration object. The order will not be stopped by an error, but tax will have 
to be calculated manually by an employee. It is therefore important to:

■ Generate guidance messages and error messages to prevent customers from 
entering non-ASCII characters in a required field. A list of required fields is given 
in Table 28.

■ Only use lists of values that contain ASCII-compliant values.

Table 28. Fields Required for the Taxware Integration

Taxware Field Siebel Field Siebel Location
Required in 
Sales/Use

Required in 
WorldTax

Company ID Company ID Configuration file Yes Yes

Ship-From 
Country Code

Ship From 
Country

Business service 
integration object

Yes Yes

Destination/Ship-
To Country Code

Ship To Country Database Yes Yes

POO Country 
Code

From Taxware Business service 
integration object

Yes Yes

POA Country 
Code

From Taxware

(Defaulted to 
the setting in 
the Taxware 
Toolkit.)

Business service 
integration object

Yes Yes
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Defining Required Fields
You can define which fields that are passed to Taxware are required and whether a 
field is required for WorldTax, Sales/Use, or both applications.

Line Item 
Amount

Line Total Database Yes Yes

State Code Ship To State Database Yes No

Zip Code Ship To Postal 
Code

Database Yes No

Document 
Number

Quote # Database No Yes

Tax Point Set in Adapter 
business 
service

Set in Adapter 
business service

No Yes

Transaction Type Set in Adapter 
business 
service (value 
of 1)

Set in Adapter 
business service 
(value of 1)

No Yes

Seller Registration From Taxware Set in the Taxware 
Toolkit. You can 
pass dynamic data 
by configuration.

No Yes

WT Code Siebel Sales 
Product Flag 
(set to 01) or 
Siebel Service 
Product Flag 
(set to 23)

Siebel Sales Product 
Flag (set to 01) or 
Siebel Service 
Product Flag (set to 
23)

No Yes

Commodity Code Part Number Database No Yes

Primary Currency 
Code

Currency Code Database No Yes

Table 28. Fields Required for the Taxware Integration

Taxware Field Siebel Field Siebel Location
Required in 
Sales/Use

Required in 
WorldTax
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To define which fields are required

1 In Siebel Tools, from the View menu, select Options.

2 In the Development Tools Options dialog box, select Object Explorer.

3 Move Integration Object to the right pane of the dialog box and click OK.

4 Select the integration object Tax Integration (Taxware Input).

5 Select Integration Component Field from the Object Explorer.

6 To make a field required, check the External Required column.

7 To make a field required for:

■ Both WorldTax and Sales/User, leave the External DataType as String.

■ WorldTax only, change the External DataType to StringWT.

■ Sales/User only, change the External DataType to StringSU.

Configuring Error Messages
You can perform the following configurations related to codepage errors:

■ You can configure the eSales - Complete Checkout Process workflow so that the 
order process will be stopped when a codepage error is returned by Taxware. 
The default behavior is to allow the order process to continue.

■ You can Configure the error messages displayed in the Quote Summary and 
Order Confirmation views of your employee application. For more information 
see Siebel Order Management Guide.

■ You can change the error messages that are displayed to customers on the Quote 
Form applet - Summary (eSales) applet and Order Form Applet - Confirmation 
(eSales) applet of your Siebel eSales Web site.

To configure error messages displayed to customers

1 In Siebel Tools, select either the Quote Form - Summary (eSales) applet or Order 
Form Applet - Confirmation (eSales) applet.

2 Select Applet User Prop in the Object Explorer.
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3 Replace the EAI Error Message text with the text of your choice in the user 
property that has the value LabelTaxNotCalculated.
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This chapter tells you how to set up the ability for consumers and business 
customers to obtain product availability information from your Siebel eSales Web 
site.

Product availability information is stored in third-party product availability 
management systems. When a customer clicks the Check Availability button, 
availability information is passed to the Siebel eSales by a third-party product 
availability fulfillment engine, also known as an availability-to-promise (ATP) 
engine. Siebel eSales displays whatever data the ATP engine returns.

NOTE: Product availability information can also be requested by call center agents, 
sales administrators, and sales representatives using an employee application, such 
as Siebel Sales or Siebel Call Center. For information about how to set up product 
availability requests from an employee application, see Siebel Order Management 
Guide.

Integration with the product availability fulfillment engine uses the business service 
named ATP and a specific, prebuilt Application Services Interface (ASI) named ATP 
Check. Some configuration is required to set up this integration.

For general information about how to set up, use, and modify integrations based on 
ASIs, see Integration Platform Technologies: Siebel eBusiness Application Integration 
Volume II.
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To set up the use of third-party product availability systems, you must:

■ Check the availability fulfillment methods that your ATP engine supports.

■ Set the ATP Action parameter in the Quote business component user properties.

■ Verify the External ATP Check business service user properties.

■ Configure the Web Services.

Checking the Availability Fulfillment Methods
For the integration to work, you must find a method that is supported by your ATP 
engine and which checks availability without reserving it. The Inquire method is 
one possible example. You may want to check other supported methods, such as 
Reserve and Unreserve, to see how you can extend your availability checking 
function.

Setting the ATP Action Parameter in the Quote Business Component User 
Properties

The product availability fulfillment integration is launched from the Quote business 
component. The Quote business component defines method ATPInquireAll, which 
invokes the ATP Check ASI.

You must make sure that the values of the ATP Action parameters of the 
ATPInquireAll method user properties, for both the Quote and Order business 
components, match the commands expected by the ATP engine. If your ATP engine 
expects different commands, you can change the ATP Action parameters in Siebel 
Tools.

To set the business component user properties

1 In Siebel Tools, select the Quote business component.

2 Select Business Component User Prop.
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3 In the Value field, query for *ATP*.

This returns all of the Quote business component user properties that are related 
to the ATP functionality.

4 For the user property that includes the ATPInquireAll method, edit the ATP 
Action parameter so that it exactly matches the command expected by the ATP 
engine. The default value is Inquire.

Verifying the External ATP Check Business Service User Properties
You must verify the External ATP Check business service user properties.

To verify the External ATP Check business service user properties

1 In Siebel Tools, select the External ATP Check business service.

2 Select Business Service User Prop.

3 Verify that the Names and Values of the User Properties match those in the 
following table.

Configuring Web Services
Web services are used to direct the inbound and outbound messages to and from:

■ The third-party ATP engine.

■ A script, called ATP ASI test, that can be used to test your integration setup.

■ A middleware or integration server that will integrate with your fulfillment 
engine.

Name Value

siebel_port_name Default

siebel_web_service_name External ATP Check

siebel_web_service_namespace http://siebel.com/asi/
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ATP ASI test is a testing script that simulates a simple fulfillment engine. The script 
writes the output and response to an XML file on the server machine. By default, 
the output and response are written to ${SIEBEL_HOME}/bin, for example 
D:\Siebel\bin. The script writes an output file, called ATPOutput.xml, which 
represents what you would be sending to your middleware or fulfillment engine. 
Then it generates a real-time response and sends that back to the Web service. The 
generated response is written into a file called ATPFinished.xml, which you can see 
in the file system.

This testing infrastructure allows you to analyze what will be sent to the 
middleware and what Siebel eSales is expecting back. Based on this data, it will 
show you how it populates the data on the UI.

You must make sure that the Web services are correctly configured.

To configure the Web services

1 Navigate to the Web Services Administration screen.

2 From the Show drop-down list, select Outbound Web Services.

3 Select the row with External ATP Check in the Name field.

4 Verify that the fields in the Outbound Web Services list match those in the 
following table.

5 In the Service Ports list, click New, and enter the following values in the fields 
of the new record.

Namespace Name Status

http://siebel.com/asi/ External ATP Check Active

Field Comments

Name Enter a name for the port.

Port Type Enter External ATP Check.
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For more information about configuring Web Services and setting up demonstration 
scripts, see Integration Platform Technologies: Siebel eBusiness Application 
Integration Volume II.

Transport Select from the drop-down list.

If you want to set up testing, for example when you are customizing 
applets or extending the ASI, select Local Business Service.

Address When you select a transport, the field will be populated with a 
template address. Edit the address based on where you are sending 
the data.

If you want to set up testing, for example when you are customizing 
applets or extending the ASI, enter ATP ASI Test.

Binding If a SOAP header is expected by the receiving application, select 
SOAP_RPC.

If you are using ATP ASI Test, select Property Set.

Field Comments
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When setting up the use of third-party product availability management systems, 
you may want to:

■ Turn off computation of the availability summary date.

■ Extend the ASI.

■ Extend the data received from the third-party application.

■ Require user registration.

■ Modify some terms on the user interface.

Preventing Rollup of Availability Information
Product availability information can be displayed for:

■ The entire quote

■ The quote line items

■ The schedule line items

The following information is rolled up:

■ Available status, date, and quantity are rolled up from the promised lines to the 
quote or order lines.

■ Available status and date are rolled up from the quote or order lines to the quote 
or order header.

If your availability fulfillment engine only returns promised schedule lines and does 
not roll up this data to the line or the header, the preconfigured behavior will 
provide you with a rollup of the data. 

If, however, your fulfillment engine already calculates this rollup, or if you do not 
want to roll up these fields, you may want to turn off this behavior.

Following are some examples of the preconfigured rollup of availability information:
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■ Dates: The latest date is rolled up at the parent level. For example, if line 1 has 
an available date of 7/15/02 and line 2 has an available date of 7/23/02, the 
available date for the order is set to 7/23/02. Rollup only occurs on dates if the 
status of the promised line or line is Available.

■ Status: If all lines have an ATP status of Available, the order also has a status of 
Available. However, if one of the lines has a different status, the order status is 
kept blank.

■ Quantity: If schedule line 1 has an availability quantity of 10, Schedule line 2 has 
an available quantity of 20, and both lines have the same ATP status of 
Available, then the quantity rolled up is the sum of both quantities (30). Rollup 
only occurs on quantity if the status of the promised line or line is Available.

To turn off product availability rollup

1 In Siebel Tools, select the ATP business service.

2 Select Business Service User Prop.

3 Select the Rollup Availability user property, and change the value from Y to N.

Extending the ATP Check Interface
If you want to extend the ASI, you must add fields to:

■ The external integration object called ATP Check Interface

■ The following internal integration objects:

■ ATP Check Interface Request - Quotes

■ ATP Check Interface Request - Orders

■ ATP Check Interface Response - Quotes

■ ATP Check Interface Response - Orders
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This will create the necessary mapping between the ATP interface structure and the 
Siebel Quote and Order business components. Make sure that the names of the 
fields in the internal and external integration objects match, as illustrated in the 
following table.

To prevent an added field from being modified by the fulfillment engine

1 In Siebel Tools, select Integration Object in the Object Explorer.

2 Select the integration object ATP Check Interface Response - Quotes.

3 Expand Integration Object in the Object Explorer, and select Integration 
Component.

4 Select the Quote integration component.

5 Expand Integration Component in the Object Explorer and select Integration 
Component Field.

6 Select the name of the added field.

7 Expand Integration Component Field in the Object Explorer and select 
Integration Component Field User Prop.

8 Set the Name of the Integration Component Field User Property to NoUpdate.

9 Set the Value to Y.

Table 29. Naming Fields

Object Name
Integration Component 
Field Name

Integration Component External 
Name

ATP Check Interface NameX none

ATP Check Interface Request - 
Quotes

NameX <Mapping of the NameX field 
to the correct field on the 
Quotes Buscomp>

ATP Check Interface Response - 
Quotes

NameX <Mapping of the NameX field 
to the correct field on the 
Quotes Buscomp>
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For more information about how to extend the integration object, see Integration 
Platform Technologies: Siebel eBusiness Application Integration Volume II.

Requiring User Registration
Siebel eSales does not require the customer to register on the Web site before 
checking product availability. However, you can configure the logic behind the 
Check Availability button to require this by:

■ Hiding the Check Availability button. In this case, anonymous users will not see 
the button unless they explicitly log in.

■ Adding the Explicit Login parameter to the view.

To hide the Check Availability button

1 In Siebel Tools, lock the eSales - Quote project.

2 In the Object Explorer, click Applet and select Quote Form Applet - Current 
(eSales).

3 In the Object Explorer, click Applet User Prop.

4 Create a new user property called Hide Control 4 with the following value: 
‘ButtonInquireAll’,’GetProfileAttr(“Is Anonymous”) = “TRUE”’

To add the Explicit Login parameter to the ATP Fulfillment View (eSales).

1 In Siebel Tools, lock the ATP project.

2 In the Object Explorer, click View and select ATP Fulfillment View (eSales).

3 Right-click on the Views bar at the top of the list and select Columns Displayed.

4 In the Available Columns box, select Explicit Login, move it to the Displayed 
Columns box, and click OK.

5 Scroll to the right of the view and check the Explicit Login column for ATP 
Fulfillment View (eSales).

6 Check in and compile the projects.
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UI Terms
You may want to change the following terms in the user interface to more precisely 
reflect the type of data returned by your particular product availability fulfillment 
engine. Alternatively, you could clarify the terms by adding popups that appear 
when the customer’s cursor moves over them.

Requested Date. This could mean either the date on which the customer wants to 
receive the product or the date on which the customer wants the seller to ship the 
product.

Available Date. This could mean either the date that the customer will receive the 
product or the date that the product will be shipped.

These two fields are designed to work together, reflecting parallel information.
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This chapter tells you how to set up the ability for consumers to track the shipping 
progress of packages that you are sending to them. Each package is scanned by the 
shipping carrier at various checkpoints on its journey, and information about the 
progress of the package is stored in the carrier’s shipment tracking database.

Consumers access the shipment tracking function through the Check Shipment 
button, which appears when there is a shipment. When the consumer clicks the 
button it shows the shipments that are associated with the order. If the shipment 
has a Shipment Identification Number, the Track Shipment button appears. When 
the consumer clicks this button, information in the shipment tracking database is 
delivered to Siebel eSales using a specific, prebuilt Application Services Interface 
(ASI) named External Shipment Tracking. Some configuration is required to set up 
this integration.

Integration also uses the published interfaces called Shipment Tracking Interface 
Request and Shipment Tracking Interface Response. For information about how to 
extend this integration object, and for more information about how to set up, use, 
and modify integrations based on ASIs, see Integration Platform Technologies: Siebel 
eBusiness Application Integration Volume II.

The following terms are used when referring to shipment tracking:

■ Shipment. A part of an order that is shipped using the same carrier and shipment 
method. For example, an order can consist of one air-freight shipment and one 
ground shipment that have the same destination address. A shipment is made 
up of one or more packages. More than one order can be included in a single 
shipment, and a single order can require more than one shipment. In other 
words, there is a many-to-many relationship between orders and shipments.

■ Shipment Tracking Number. Also called Shipment Identification number or Waybill 
number. A unique identifier used to track a shipment through the delivery 
system.
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■ Package. A container for the parts of a shipment. For example, a computer 
shipment may have a package for the monitor and a package for the computer’s 
CPU case.

■ Package Tracking Number. A unique identifier used to track a package through the 
delivery system.

■ Shipment Reference Number. A unique identifier that is defined by the seller and 
used to track shipments. This number can be used in conjunction with a 
package, a set of packages within one or more shipments, or all packages within 
a shipment.
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To set up the use of third-party shipment tracking system, you must:

■ Set the Shipment Tracking - Package Tracking business component user 
properties.

■ Verify the External Shipment Tracking ASI user properties.

■ Configure the Web Services.

Setting the Shipment Tracking-Package Tracking User Properties
The virtual business component from which the shipment tracking application can 
be launched is associated with the Request Action method and its associated 
Request Option. These methods invoke the External Shipment Tracking ASI when 
the Track Shipment button on the Shipment View (eSales) view is clicked. The 
Request Action is Track, and it should match the shipper’s system command. The 
Request Option is Last Package or Last Activity, which should also match the 
shipper’s system.

To set the Shipment Tracking - Package Tracking business component user 
properties

1 In Siebel Tools, select the Shipment Tracking - Package Tracking business 
component.

2 Select Business Component User Prop.
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3 Verify that the Names and Values of the User Properties match those in the 
following table.

NOTE: If you want to support integration with more than one carrier, the user 
property values required by the carriers will probably be different. In this case, you 
will need to employ a middleware adapter that will change the values passed to 
each carrier.

Verifying the External Shipment Tracking ASI User Properties
You must verify the External Shipment Tracking ASI user properties.

To verify the External Shipment Tracking ASI user properties

1 In Siebel Tools, select the External Shipment Tracking business service.

2 Select Business Service User Prop.

3 Verify that the Names and Values of the User Properties match those in the 
following table.

Configuring Web Services
Web services are used to direct the inbound and outbound messages to and from:

Business Component Name Default Value

Shipment Tracking-
Package Tracking

Request Action Track

Request Option Last Activity

Name Value

siebel_port_name Default

siebel_web_service_name External Shipment Tracking

siebel_web_service_namespace http://siebel.com/asi/
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■ The third-party shipment tracking application.

■ A demonstration script that can be used to test your integration setup.

■ A middleware component.

You must make sure that the Web services are correctly configured.

To configure the Web services

1 Navigate to the Web Services Administration screen.

2 From the Show drop-down list, select Outbound Web Services.

3 Select the row with External Shipment Tracking in the Name field.

4 Verify that the fields in the Outbound Web Services list match those in the 
following table. 

5 In the Service Ports list, click New, and enter the following values in the fields 
of the new record.

Namespace Name Status

http://siebel.com/asi/ External Shipment Tracking Active

Field Comments

Name Enter a name for the port.

Port Type Enter External Shipment Tracking.

Transport Select from the drop-down list.

If you want to set up testing, for example when you are customizing 
applets or extending the ASI, select Local Business Service.
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For more information about configuring Web Services and setting up demonstration 
scripts, see Integration Platform Technologies: Siebel eBusiness Application 
Integration Volume II.

Address When you select a transport, the field will be populated with a 
template address. Edit the address based on where you are sending 
the data.

If you want to set up testing, enter Shipment Tracking ASI Test.

Binding If a SOAP header is expected by the receiving application, select 
SOAP_RPC. 

If you are using Shipment Tracking ASI Test, select Property Set.

Field Comments
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To set up the use of third-party shipment tracking application, you may want to:

■ Extend the data received from the third-party application.

■ Change the package sorting order.

■ Turn off package sorting.

Extending Returned Data
You can extend the returned data by adding a field to the response integration object 
and displaying it in the user interface.

To extend the returned data

1 Add the field to the Shipment Tracking Interface Response integration object.

2 Add the field to the Shipment Tracking - Package Tracking business component, 
making sure that the name of the field matches that of the integration object.

3 Add the control to the Shipment Tracking - Package Tracking (eSales) applet, 
which maps to the added field in the business component.

For more information about how to extend the data that is received from the 
shipment tracking application, see Integration Platform Technologies: Siebel 
eBusiness Application Integration Volume II.

Changing the Package Sorting Order
Packages are displayed as a list of records in the Shipment Tracking - Package 
Tracking (eSales) applet. The list is sorted in the order shown in Table 30.

Table 30. Package Sorting Order

Sort Level Value Sorted Sort Order

First Package Tracking Number Ascending
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You can change the order in which packages are listed.

To change the package sorting order

1 In Siebel Tools, select the Shipment Tracking (eSales) business service.

2 Select Business Service User Prop.

The displayed list of user properties includes nine sort fields.

3 Change the values of the fields to change the sorting order for the three levels of 
sort.

Turning Off Package Sorting
You may want to turn off package sorting within Siebel eSales to improve 
performance if:

■ The order in which information is returned does not matter to you.

■ You usually only have one package in a shipment.

■ Sorting is performed in middleware.

■ Sorting is performed by the carrier’s shipment tracking application.

To turn off package sorting

1 In Siebel Tools, select the Shipment Tracking-Package Tracking business 
component.

2 Select Business Component User Prop.

3 Select the Sort Results user property.

4 Change the value from Y to N.

Second Date Descending

Third Time Descending

Table 30. Package Sorting Order

Sort Level Value Sorted Sort Order
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In Siebel eSales, the Shopping Cart and order management use workflows for 
various actions, such as checking out, editing quotes, modifying orders, and so on.

The Shopping Service business service provides methods that can be invoked in the 
workflows. In addition, in Siebel 7 the Add to Cart feature has been moved from the 
Quote business component to the Shopping Service business service. This is 
because business services can be accessed more universally than business 
components.

Therefore, the Shopping Service can support other features such as Add to Favorites, 
Quick Add, and Save Cart As Template. It is also easier for other applications such 
as Siebel eAuction, Siebel eTraining, and Siebel Partner Relationship Management 
to integrate with Siebel eSales order management.

The Shopping Service business service is a collection of methods, written in C++, 
that fall into one of three categories:

■ Methods used in user actions, such as Add To Cart.

■ Methods used in workflows, such as eSales - Checkout Process.

■ Methods used as integration APIs for other applications, such as Siebel 
eAuction.
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User Action Methods
These methods are invoked by actions taken by users of the Siebel eSales Web site, 
such as clicking Add to Cart.

AddToCart
This method is invoked to add an item to the Shopping Cart. It checks the input 
argument Action. Depending on the value of Action, the Shopping Cart takes 
different actions, as described in the Table 31.

What the AddToCart method does is to create one or more (for complex products) 
records in the Quote Item business component in the current quote record 
(indicated by CurrentQuoteId) in the Quote business component.

If the product has extended attributes, it will also copy the extended attribute values 
from the Product XA VBC business component to the Quote Item XA business 
component. The extended attributes for a product are in the XA Attribute Value 
business component. End users can select values for each modifiable attribute; 
these selections are stored in the Product XA VBC business component.

For example, if you add a product with four attributes to the Shopping Cart, you 
create one record in the Quote Item business component and four records in the 
Quote Item XA business component. The mapping is as follows:

■ Product to Quote Item

Table 31. Shopping Cart Actions

Action Method Invoked

AddToCart DefaultAddToCart

Customize DefaultAddToCart

QuickAdd QuickAdd

AddTrainingItem AddTrainingItem

AddEventItem AddTrainingItem

AddEventSessionItem AddTrainingItem
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■ Product XA VBC to Quote Item XA

Expected Preconditions Before the Method Can Be Called
■ Where AddToCart can be called. This method can be called from either an applet 

or a business component. In each case, the caller function needs to call the 
SetBusComp method to set the current business component to the Shopping 
Service instance.

The Shopping Service instance needs to use the current business component to 
get the current business object and all the context information. Therefore, you 
cannot invoke this method from an applet that does not have a business 
component.

■ Quote record. The Shopping Cart is just a quote record whose row ID equals the 
CurrentQuoteId profile attribute. The Quote Type field value for this current 
quote record can be Quotation, Persistent Cart, or Anonymous Quote.

■ If it is Quotation, then the current quote is a normal quote.

■ If it is Persistent Cart, it means this application supports the Persistent 
Shopping Cart and this quote is the Persistent Shopping Cart for that user.

■ If it is Anonymous Quote, it means this application allows anonymous users 
to add items to the Shopping Cart and this user is an anonymous user.

■ Price List Id, Promotion Id, and Campaign Id fields. The current quote record has a 
Price List Id field, a Promotion Id field, and a Campaign Id field. The field value 
for Price List Id cannot be empty. The field values for Promotion Id and 
Campaign Id can be empty or not.

There are also three corresponding profile attributes: PromotionId, CampaignId, 
and PriceListId. These can be set by Siebel eMarketing when a user clicks the 
hyperlink on a Web offer. Therefore, the field values for Price List Id, Campaign 
Id, and Promotion Id in the current quote record can be different from the values 
in the PriceListId, CampaignId, and PromotionId profile attributes. When users 
add items to the Shopping Cart, these three field values in the current quote 
record are set to the value from the corresponding profile attributes.
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■ Internal Product by Price List Optional business component. Underlying product 
business component for AddToCart, QuickAdd, and Customize.

All other business components use this business component as the proxy 
business component for AddToCart. This is because only this business 
component has extended attribute child business components such as Product 
XA VBC and XA Attribute Value. In addition, it is used in attribute pricing.

The user properties for the Internal Product by Price List Optional business 
component are listed in Table 32.

Table 32. Internal Product by Price List Optional BC User Properties

Name Value Explanation

Field:Base Price Catalog Price The C++ code for the Shopping Service 
and attribute pricing refers to certain 
fields. Instead of hard-coding the field 
name in C++, this user property is 
used for mapping between the field to 
which the C++ code refers and the 
actual field name in the business 
component.

For example, this user property indicates 
that the Base Price to which the C++ 
code refers is called Catalog Price in the 
Internal Product by the Price List 
Optional business component.

This way, Base Price in the C++ code 
can be mapped to different fields in 
different business components.

Field:Catalog Price Catalog Price Similar to Field:Base Price. Used in 
attribute pricing.

Field:Reference Price Reference Price Similar to Field:Base Price. Used in 
attribute pricing.

Field:Price Book Id Price Book Id Similar to Field:Base Price. Used in 
attribute pricing.

Field:Promotional Price Promotional 
Price

Similar to Field:Base Price. Used in 
attribute pricing.
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■ AddToCartAutoQuote input argument. When there is no current quote as specified 
by CurrentQuoteId, AddToCart will decide whether to create a new quote 
automatically based on certain conditions:

■ AddToCart checks the AddToCartAutoQuote input argument. If its value is Y 
or TRUE, AddToCart will automatically create a new quote. If its value is N 
or FALSE, AddToCart will not automatically create a new quote.

■ If the AddToCartAutoQuote input argument is empty, AddToCart checks the 
AddToCartAutoQuote server component parameter (Table 33 on page 258).

Field:Quantity Quantity Similar to Field:Base Price. Refers to the 
Quantity field. Used in attribute pricing 
and in the Shopping Service.

Field:Your Price Your Price Similar to Field:Base Price. Used in 
attribute pricing.

Product XA Product XA VBC Indicates that the extended attribute to 
use is Product XA VBC.

SetPriceListSearch Y Indicates that the [Price List Id] = 
GetProfileAttr(“PriceListId”) 
search specification should be applied to 
the business component.

If used, only products that are on the 
current price list are visible in Siebel 
eSales.

Use Promotional Price Y Used in attribute pricing.

When this is Y, the Base Price equals the 
Promotional Price if the Promotional 
Price field is not empty. Otherwise, the 
Base Price equals the Reference Price.

Table 32. Internal Product by Price List Optional BC User Properties

Name Value Explanation
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■ AddToCartGotoView input argument. The calling action can also specify the next 
view to which to navigate after finishing the AddToCart method. This is done 
through the AddToCartGotoView input argument:

■ If this input is not empty, the application will navigate to the specified view.

■ If this input is empty, the Shopping Service will look for the 
AddToCartGotoView server component parameter as defined for 
InfraShoppingService in the repository (Table 33).

■ Server component parameters. The server component parameters used by the 
Shopping Service business service are listed in Table 33. These parameters can 
be changed by navigating to Server Administration > Components > 
Component Parameters or by modifying the application configuration (.cfg) file.

Table 33. Server Component Parameters in the Shopping Service

Name Default Value Explanation

AddToCartAutoQuote TRUE The value can be TRUE or 
FALSE.

If it is TRUE, AddToCart will 
automatically create a new quote 
if there is no current quote.

AddToCartGotoView NONE The value can be NONE or a 
specific view name.

If it is a specific view name, the 
application will navigate the user 
to that view after finishing the 
AddToCart method.

AnonymousQuote TRUE The value can be TRUE or 
FALSE.

If it is TRUE, AddToCart will 
allow anonymous users to add 
items to the Shopping Cart, and 
it will create quotes with quote 
type Anonymous Quote.

If it is FALSE, AddToCart will not 
allow anonymous users to add 
items to the Shopping Cart.
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AutoQuoteDefaultOwner TRUE The value can be TRUE or 
FALSE.

If it is TRUE, when AddToCart 
automatically creates a new 
quote, it will automatically fill in 
the Contact Id and Account Id 
fields with the current user's 
login ID and account ID.

PersistentShoppingCart FALSE The value can be TRUE or 
FALSE.

If it is TRUE, the application will 
support the Persistent Shopping 
Cart. The quote created by 
AddToCart will have type 
Persistent Cart.

When the user logs in to the 
application, the run-time event 
will trigger the eSales Web Login 
Action Set. The SetShoppingCart 
method in that action set will 
load the quote with type 
Persistent Cart for that user.

ProductDetailView Product Detail - 
Features View (eSales)

Specifies the view name for the 
Product Detail view.

ShoppingCartView NONE Specifies the view for the 
Shopping Cart.

Table 33. Server Component Parameters in the Shopping Service

Name Default Value Explanation
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■ Business object must include all necessary business components. The list of 
business components that must be in the business object calling the AddToCart 
method is shown in Table 34, using the Catalog business object as an example.

Table 34. Necessary Business Components in the Business Object

Business Component Link Comment

Internal Product by 
Price List Optional

Underlying business component 
for AddToCart, QuickAdd, and 
Customize.

All other business components by 
default use this business 
component as the AddToCart Proxy 
Buscomp.

Internal Product by 
Price List Optional 2

Catalog Category/
Internal Product by Price 
List Optional 2

Used in the Product list applet for 
AddToCart.

This business component uses 
Internal Product by Price List 
Optional as the AddToCart Proxy 
Buscomp.

XA Attribute Value Internal Product by Price 
List Optional/XA 
Attribute Value

Needed for extended attributes.

Product XA VBC Needed for extended attributes.

Product XA VBC 
Form

Internal Product by Price 
List Optional/Product XA 
VBC Form

Needed for extended attributes.

Quote

Quote Item Quote/Quote Item

Quote Item XA

Training Class 
Registration

Needed for AddTrainingItem.

eEvents Event 
Attendee

Needed for AddTrainingItem.

eEvents Session 
Attendee

Needed for AddTrainingItem.
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Arguments
The AddToCart method has the arguments shown in Table 35.

.

Favorite List Needed for AddToFavoriteList.

Favorite List Item Favorite List/Favorite 
List Item

Needed for AddToFavoriteList.

Table 35. AddToCart Arguments

Name Type Data Type Optional Comments

Action Input String Y Specifies the action to take.

Action can take the following values:

■ AddToCart

■ Customize

■ QuickAdd

■ AddTrainingItem

■ AddEventItem

■ AddEventSessionItem

AddToCart 
Quote Fields

Input String Y Concatenated string of Quote 
business component field name/
value pairs.

AddToCart deconstructs this string 
and sets the corresponding fields in 
the Quote business component.

AddToCart 
AutoQuote

Input String Y Used to decide whether to create a 
new quote automatically if there is 
no current quote.

If empty, AddToCart will look for the 
server component parameter with 
the same name.

Table 34. Necessary Business Components in the Business Object

Business Component Link Comment
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Pseudo-Algorithm for AddToCart
Follow these steps when using a pseudo-algorithm for AddToCart:

1 Call CanAddToCart method to check if can add item to the Shopping Cart:

If the CurrentQuoteId profile attribute is not empty and is a valid quote ID, 
return TRUE;

else if the AddToCartAutoQuote input argument is TRUE, return TRUE;

else if the AddToCartAutoQuote server component parameter is TRUE, return 
TRUE;

else return FALSE.

AddToCart
GotoView

Input String Y Used to decide to which view to 
navigate after completing adding an 
item.

If empty, AddToCart will look for the 
server component parameter with 
the same name.

Source 
Currency 
Code

Input String Y Specifies the currency code for the 
price.

If not empty and not equal to the 
currency code in the quote, 
AddToCart will do the currency 
conversion and set the converted 
Price field in the quote item.

Quote Id Output String Y Returns the quote ID for the current 
quote.

Quote Item Id Output String Y Returns the quote item ID.

ReturnVal Output String Y Returns Success or Fail. Not used.

Table 35. AddToCart Arguments

Name Type Data Type Optional Comments
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2 Check the Action input argument:

If Action = AddTrainingItem or AddEventItem or AddEventSessionItem, call the 
AddTrainingItem method;

Else if Action = QuickAdd, call the QuickAdd method;

Else if Action = AddToCart or Customize:

Call the DefaultAddToCart method.

3 Call the PostAddToCart method.

Pseudo-Algorithm for DefaultAddToCart
Follow these steps when using a pseudo-algorithm for DefaultAddToCart:

1 Get the Quote, Quote Item, and Quote Item XA business components.

2 Call AddHeader to make sure there is a current quote for adding an item, What 
AddHeader is doing is to make sure if there is a current quote, if there is not 
current. AddHeader will create a new quote and set the CurrentQuoteID profile 
attribute value to the Row ID of the newly created quote record. 

3 Create a new record in the Quote Item business component.

4 Populate that line item with information from Product the user has selected. 

5 Check the Action input argument:

If Action = Customize, then call ReConfigCxProd to launch the customizable 
product run-time view.

6 End.

Pseudo-Algorithm for PostAddToCart
Follow these steps when using a pseudo-algorithm for PostAddToCart:

1 Check the Action input argument:

If Action = Customize, End;

Else go to step 2.
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2 Check the AddToCartGotoView input argument:

If not empty, then navigate to that view and End;

Else go to step 3.

3 Check the AddToCartGotoView server component parameter:

If not empty and <> NONE, then navigate to that view and End;

Else End.
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AddToFavoriteList
This method is invoked to add items to the Favorites list.

Expected Preconditions Before the Method Can Be Called
When calling this method, you need to make sure the business components that are 
shown in Table 36 are in the business object, using the Catalog business object as 
an example.

Arguments
The AddToFavoriteList method has the arguments shown in Table 37.

Table 36. Necessary Business Components in the Business Object

Business Component Link Comment

Internal Product by Price 
List Optional

Product business component 
used in Siebel eSales.

Internal Product by Price 
List Optional 2

Catalog Category/Internal 
Product by Price List 
Optional 2

Business component used in 
product list applet.

Favorite List Favorite List business 
component.

Favorite List Item Favorite List/Favorite List 
Item

Favorite List Item business 
component.

Table 37. AddToFavoriteList Arguments

Name Type Data Type Optional Comments

Action Input String Y Equals AddToFavoriteList.

Product Id Input String Y If this input is not empty, add the 
product specified by this ID to the 
Favorites list.

Otherwise, assume the current record 
in the current business component is 
the item to add to the Favorites list.
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Pseudo-Algorithm
1 If the user is an anonymous user, End.

2 Get the Favorite List and Favorite List Item business components.

3 Query the Favorite List business component with the search specification 
[Person Id] = LoginId;

If there is a existing record, go to step 4;

Else create a new record and set [Person Id] to current login ID.

GotoView Input String Y If this input is not empty, 
AddToFavoriteList will navigate to this 
view after completing the 
AddToFavoriteList action.

ReturnVal Output String Y Returns Success or Fail. Not used.

Table 37. AddToFavoriteList Arguments

Name Type Data Type Optional Comments
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4 Query the Favorite List Item business component with the search specification 
[Product Id] = input product ID;

If there is an existing record, go to step 5;

Else create a new record and set [Product Id] to input product ID.

5 If GotoView input argument is not empty, navigate to the specified view and 
End;

Else check the Favorite List View user property in the Shopping Service business 
service:

If this value is empty, End;

Else navigate to this view and End.

SetShoppingCart
This method is used in run-time event action sets to support the Persistent Shopping 
Cart and anonymous users adding items to the Shopping Cart.

SetShoppingCart is used in the eSales WebLogin Action Set. This action set is 
associated with the WebLogin run-time event for the Siebel eSales application 
object. When a Siebel eSales user logs in, the WebLogin run-time event is triggered. 
This in turn triggers the eSales Web Login Action Set and executes the 
SetShoppingCart method.

The method checks if there is already a current quote in the session as indicated by 
the CurrentQuoteId profile attribute:

■ If this profile attribute is empty, it determines if there is any quote of type 
Persistent Cart associated with the user. If there is one, it loads that quote and 
sets the CurrentQuoteId profile attribute to that quote ID.

■ If CurrentQuoteId is already set, it checks if the quote type is Anonymous Quote 
and converts it to Persistent Cart if it is.
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Expected Preconditions Before the Method Can Be Called
■ The following server component parameters must be set to TRUE:

■ PersistentShoppingCart

■ AnonymousQuote

■ To use this method, you need to create an action set with an action that invokes 
this method. For example, the actions in the eSales Web Login Action Set are 
shown in Table 38.

After that, you need to associate this action set with the WebLogin run-time 
event for the application. The following applications use the eSales WebLogin 
Action Set:

■ Siebel Partner Relationship Management

■ Siebel eCustomer

■ Siebel eSales

Arguments
None.

Pseudo-Algorithm
1 If the Is Anonymous profile attribute = TRUE, End.

2 Check the CurrentQuoteId profile attribute:

If empty or = EMPTY_CART, there is no current quote. Go to step 3;

Else go to step 4.

Table 38. eSales Web Login Action Set Actions

Action Business Service InvokeMethod

SetPriceList Pricing Manager SetPriceList

SetShoppingCart Shopping Service SetShoppingCart
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3 Get the Catalog business object and the Quote, Quote Item, and Quote Item XA 
business components. Query the Quote business component with the search 
specification [Contact Id] = LoginId () AND [Quote Type] = 
LookupValue ('QUOTE_TYPE', 'Persistent Cart') to find the quote record 
of type Persistent Cart for that user. One or zero records will be returned.

If one record is returned, the user has a Persistent Cart. Set the CurrentQuoteId 
profile attribute to the record ID, then go to step 8.

4 Get the Catalog business object and the Quote, Quote Item, and Quote Item XA 
business components. Query the Quote business component with the search 
specification [Id] = GetProfileAttr(“CurrentQuoteId”) to get the current 
quote. Check the Quote Type field value:

If [Quote Type]= LookupValue ('QUOTE_TYPE', 'Anonymous Quote'), the 
current quote is an anonymous user’s Shopping Cart. Go to step 5;

Else, go to step 6.

5 Before converting Anonymous Quote to Persistent Cart, it is necessary to check 
if the user already has a Persistent Shopping Cart. Get a second instance of the 
Catalog business object and the Quote, Quote Item, and Quote Item XA business 
components. Query the second instance of the Quote business component with 
the search specification [Contact Id] = LoginId () AND [Quote Type] = 
LookupValue ('QUOTE_TYPE', 'Persistent Cart'). It will return one or 
zero records.

If it returns no records, go to step 6;

If it returns one record, it is necessary to resolve the conflict between the 
anonymous quote and an existing persistent Shopping Cart. Go to step 7.

6 Convert Anonymous Quote to Persistent Cart:

Set [Account Id] to the account ID of the current user;

Set [Contact Id] to the login ID of the current user;

Set [Quote Type] to LookupValue ('QUOTE_TYPE', 'Persistent Cart');

Set [Price List Id] to the current price list ID;

End.
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7 There are two quote records: the quote record in the first Quote instance is the 
Anonymous Quote; the record in the second Quote instance is the previous 
Persistent Shopping Cart. Save the previous Persistent Shopping Cart as a quote 
with a name.

8 If the price list in the current quote is different from the current price list, set 
[Price List Id] to the current price list ID in the system.

SetApplicationName
This method sets the ApplicationName profile attribute, which is used in workflow 
branching conditions and in Siebel Personalization to hide or show an applet in a 
view for various applications.

SetApplicationName is used in the eSales WebSessionStart Action Set. This action 
set is associated with the WebSessionStart run-time event for the Siebel eSales 
application object. When a Web session starts (usually the first time a user visits 
the Web site), this event is triggered. This in turn triggers the eSales Web Session 
Start Action Set, executing the SetApplicationName method. The ApplicationName 
profile attribute is set to the name for the application that is running.

Expected Preconditions Before the Method Can Be Called
To use this method, you need to create an action set and invoke this method from 
an action in the action set, as shown for the eSales WebSessionStart Action Set in 
Table 39.

The following applications use the eSales WebSessionStart Action Set:

■ Siebel Call Center

■ Siebel Partner Relationship Management

■ Siebel eCustomer

Table 39. Sales WebSessionStart Action Set

Action Business Service InvokeMethod

SetApplicationName Shopping Service SetApplicationName
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■ Siebel eEvents Management

■ Siebel eSales

■ Siebel eService

■ Siebel eTraining

■ Siebel Marketing

Arguments
None.

Pseudo-Algorithm
Get the application name and set the ApplicationName profile attribute.

OrderTemplate
OrderTemplate copies all the line items from a template to the Shopping Cart. The 
behavior is similar to AddToCart; the difference is that when you order a template, 
you add several line items to the Shopping Cart. Each line item will have the 
quantity specified in the template.

A template is a quote of type Template, so template records are a subset of quote 
records. Templates have a similar structure to quotes: there is a 1:1 mapping 
between template and quote business components:

■ Quote Template to Quote

■ Quote Template Item to Quote Item

■ Quote Template Item XA to Quote Item XA
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Expected Preconditions Before the Method Can Be Called
OrderTemplate uses field maps defined in the Shopping Service business service 
user properties to copy field values from Quote Template Item to Quote Item and 
from Quote Template Item XA to Quote Item XA. The field maps are shown in 
Table 40 and Table 41.

Table 40. Quote Template Item to Quote Item Field Map

Name Value

Quote Template Item|Quote Item FieldMap 100 Product Id|Product Id

Quote Template Item|Quote Item FieldMap 101 Quantity Requested|Quantity 
Requested

Quote Template Item|Quote Item FieldMap 102 Adjusted Reference Price|Adjusted 
Reference Price

Quote Template Item|Quote Item FieldMap 103 Base Price|Base Price

Quote Template Item|Quote Item FieldMap 104 Unit Price|Unit Price

Quote Template Item|Quote Item FieldMap 105 Product|Product

Quote Template Item|Quote Item FieldMap 106 Product Port Id|Product Port Id

Quote Template Item|Quote Item FieldMap 107 End

Table 41. Quote Template Item XA to Quote Item XA Field Map

Name Value

Quote Template Item XA|Quote Item XA FieldMap 100 Attribute Id|Attribute Id

Quote Template Item XA|Quote Item XA FieldMap 101 Name|Name

Quote Template Item XA|Quote Item XA FieldMap 102 Display Name|Display Name

Quote Template Item XA|Quote Item XA FieldMap 103 Read Only|Read Only

Quote Template Item XA|Quote Item XA FieldMap 104 Data Type|Data Type

Quote Template Item XA|Quote Item XA FieldMap 105 LOV Type|LOV Type
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The OrderTemplate method has the arguments shown in Table 42.

Pseudo-Algorithm
1 Get the Quote Template, Quote Template Item, Quote Template Item XA, Quote, 

Quote Item, and Quote Item XA business components.

The Quote Template business component is already positioned on the correct 
record, as the OrderTemplate method is row-sensitive.

2 Call the AddHeader method to make sure there is a Shopping Cart.

Quote Template Item XA|Quote Item XA FieldMap 106 Value|Value

Quote Template Item XA|Quote Item XA FieldMap 107 End

Table 42. OrderTemplate Arguments

Name Type Data Type Optional Comments

Template Id Input String Y Not used, as OrderTemplate is 
always row-sensitive.

ReturnVal Output String Y Returns Success or Fail depending 
on whether AddItem succeeds or 
not.

Table 41. Quote Template Item XA to Quote Item XA Field Map

Name Value
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3 Loop through each record in the Quote Template Item business component and 
create a corresponding record in the Quote Item business component. Use the 
field maps to copy fields from Quote Template Item to Quote Item, then copy the 
child records from Quote Template Item XA to Quote Item XA.

NOTE: As Quote Item and Quote Template Item have hierarchies, you cannot 
simply loop through the records in Quote Template Item and copy them to Quote 
Item. You need to maintain the hierarchical relationship. To do this, you need to 
copy the parent record before you copy its child records.

In the Shopping Service implementation, records are first loaded from Quote 
Template Item and a tree in the memory is generated. The tree is then traversed 
from the root, so the parent record is copied before the child records.
274 Siebel eSales Administration Guide Version 7.5, Rev. A



Shopping Service API

Workflow Methods
Workflow Methods
These methods are invoked by Siebel eSales workflows.

SaveCartAsTemplate
SaveCartAsTemplate generates a template from a quote. The implementation is 
Template (see “OrderTemplate” on page 271) with some special considerations, 
such as you cannot copy a Siebel eAuction, Siebel eTraining, or Siebel eEvents 
Management line item into a template.

Expected Preconditions Before the Method Can Be Called
Field maps are used to copy fields from the Quote to Quote Template, Quote Item 
to Quote Template Item, and Quote Item XA to Quote Template Item XA business 
components.

Example sample field maps are shown in Table 43. See the Shopping Service 
business service user properties in Siebel Tools for more details.

Table 43. Sample Field Maps for the SaveCartAsTemplate Method

Name Value

Quote|Quote Template FieldMap 100 Contact Id|Contact Id

Quote Item|Quote Template Item FieldMap 100 Product Id|Product Id

Quote Template Item XA|Quote Item XA FieldMap 100 Attribute Id|Attribute Id
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Arguments
The SaveCartAsTemplate method has the arguments shown in Table 44.

Pseudo-Algorithm
1 Get the Quote Template, Quote Template Item, Quote Template Item XA, Quote, 

Quote Item, and Quote Item XA business components.

The Quote Template business component is already positioned on the correct 
record, as the OrderTemplate method is row-sensitive.

Table 44. SaveCartAsTemplate Arguments

Name Type Data Type Optional Comments

Quote Name Input String Y Saves the Shopping Cart as a 
template with this name.

Quote Name Field Input String Y Tells the Shopping Service 
which field is the quote name.

By default, it is Name if this 
input argument is not used.

Return Error Code Input String Y If equal to N, the method will 
not return errors.

When a method returns an 
error, the workflow stops. In 
order not to kill the workflow, 
you can set this input to N. 
This way, the Shopping 
Service will not return an 
error but instead will save the 
error message in the output 
argument Error Message. You 
can then handle the error 
message as you wish.

Error Message Output String Y Stores error messages.

ReturnVal Output String Y Returns Success or Fail. Not 
used.
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2 Check the Quote Name input argument. Query the Quote business component 
to see if there is an existing record with the same name.

If there is, go to step 3;

Else go to step 4.

As Quote Template is a special type of Quote, the Quote business component can 
be used to search both Quote and Quote Template.

3 Set Error Message to indicate there is a duplicate name. Check the Return Error 
Code input argument.

If Return Error Code = N, do not return an error;

Else return an error.

4 Create a record in the Quote Template business component. Use the Quote to 
Quote Template field maps to copy fields from the record in the Quote business 
component to the record in the Quote Template business component. Set the 
Name to the Quote Name input argument.

5 Copy each record in the Quote Item business component to the Quote Template 
Item business component, but skip line items that are Siebel eAuction or Siebel 
eTraining items by checking the Class Registration Id and Auction Item Id.

NOTE: As in the OrderTemplate method, make sure the hierarchical relationship 
is copied correctly by copying each parent record before its child records. Also 
copy the child records from Quote Item XA to Quote Template XA.
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SaveCartAsQuote
SaveCartAsQuote saves the Shopping Cart (current quote record) as a quote.

Expected Preconditions Before the Method Can Be Called
■ This method is invoked in the following workflows:

■ eSales - Save Cart Process

■ eSales - Edit Quote Process

■ eSales - Order Quote Process

■ eSales - Modify Order Process

■ eSales - Reorder Process

■ The field value of Quote Type for the current quote record can be Persistent Cart, 
Auction Quote, Quotation, or Anonymous Quote. Anonymous users cannot call 
SaveCartAsQuote, so only the first three quote types can be saved.

If the quote type is Persistent Cart, SaveCartAsQuote changes the type to 
Quotation. Otherwise, it does not change the quote type.

Arguments
The SaveCartAsQuote method has the arguments shown in Table 45.

Table 45. SaveCartAsQuote Arguments

Name Type Data Type Optional Comments

Quote Name Input String Y Saves the Shopping Cart as a quote 
with this name.

Quote Name Field Input String Y Tells the Shopping Service which 
field is the quote name.

By default, it is Name if this input 
argument is not used.
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Pseudo-Algorithm
1 Get the Quote business component.

2 Get the Id of the current record in the Quote business component:

If Id <> CurrentQuoteId profile attribute, go to step 3;

Else go to step 4.

3 SaveCartAsQuote is being invoked from the eSales - Edit Quote Process,
eSales - Order Quote Process, eSales - Modify Order Process, or eSales - Reorder 
Process workflow. The current record in the Quote business component is the 
quote being acted upon, and it is not the current quote in the Shopping Cart.

Get another instance of the Catalog business object and the Quote business 
component, and position the second instance of the Quote business component 
on the quote record as indicated by the CurrentQuoteId profile attribute. As the 
first instance of the Quote business component is not being acted upon, from 
now on Quote means the second instance of the Quote business component.

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.

ReturnVal Output String Y Returns Success or Fail. Not used.

Table 45. SaveCartAsQuote Arguments

Name Type Data Type Optional Comments
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4 Check the Quote Name input argument. Query the Quote business component 
to see if there is an existing record with the same name:

If there is, go to step 5;

Else go to step 6.

5 Set the Error Message output argument to indicate that there is a duplicate name. 
Check the Return Error Code input argument:

If Return Error Code = N, do not return an error;

Else return an error.

6 Set the Name field with the Quote Name input argument. Check the field value 
of [Quote Type]:

If it is Persistent Cart, then change it to Quotation.

DiscardCart
DiscardCart discards the Current Quote and clears the CurrentQuoteId profile 
attribute. If the current quote type is Persistent Cart or Anonymous Quote, it will 
also delete the record from the Quote business component.

Expected Preconditions Before the Method Can Be Called
■ This method is invoked in the following workflows:

■ eSales - Edit Quote Process

■ eSales - Order Quote Process

■ eSales - Modify Order Process

■ eSales - Reorder Process

It is also invoked by the Empty Cart button in the Shopping Cart.

■ The field value of Quote Type for the current quote record can be Persistent Cart, 
Auction Quote, Quotation, or Anonymous Quote. When the quote type is 
Persistent Cart or Anonymous Quote, the quote record is deleted.
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Arguments
The DiscardCart method has the arguments shown in Table 46.

Pseudo-Algorithm
1 Get the Quote business component.

2 Get the Id of the current record in the Quote business component:

If Id <> CurrentQuoteId profile attribute, go to step 3;

Else go to step 4.

3 DiscardCart is being invoked from the eSales - Edit Quote Process,
eSales - Order Quote Process, eSales - Modify Order Process, or eSales - Reorder 
Process workflow. The current record in the Quote business component is the 
quote being acted upon, and it is not the current quote in the Shopping Cart.

Get another instance of the Catalog business object and the Quote business 
component, and position the second instance of the Quote business component 
on the quote record as indicated by the CurrentQuoteId profile attribute. As the 
first instance of the Quote business component is not being acted upon, from 
now on Quote means the second instance of the Quote business component.

Table 46. DiscardCart Arguments

Name Type Data Type Optional Comments

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.

ReturnVal Output String Y Returns Success or Fail. Not used.
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4 Set the CurrentQuoteId profile attribute = EMPTY_CART.

5 Check the field value of [Quote Type]:

If it is Persistent Cart or Anonymous Quote, then delete the record.

OrderQuote
OrderQuote is called in the eSales - Checkout Process workflow. It checks if there 
are any line items in the Shopping Cart. It returns an error if the Shopping Cart does 
not have any line items. It also sets the CurrentCheckOutQuoteId profile attribute.

Expected Preconditions Before the Method Can Be Called
This method is invoked in the eSales - Checkout Process workflow. The sequence 
called is OrderQuote, then ValidQuote (see “ValidQuote” on page 283), and then 
RemoveInvalidItems (see “RemoveInvalidItems” on page 285).

Arguments
The OrderQuote method has the arguments shown in Table 47.

Table 47. OrderQuote Arguments

Name Type Data Type Optional Comments

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.

Quote Id Input String Y Not used.

ReturnVal Output String Y Returns Success or Fail. Not used.
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Pseudo-Algorithm
1 Get the Quote and Quote Item business components.

2 If there are any records in the Quote Item business component, go to step 3;

Else go to step 4.

3 Set the CurrentCheckOutQuoteId profile attribute.

4 Set the Error Message output argument if there is any error;

If Return Error Code = N, do not return an error;

Else return an error.

ValidQuote
ValidQuote is called in the eSales - Checkout Process workflow to validate the line 
items in the Shopping Cart. Valid line items are those that do not have an empty 
Base Price field in the Quote Item business component.

ValidQuote sets the Invalid output argument to Y if there are any line items that are 
invalid, and also sets Invalid Flag field for each line item that is invalid. The Invalid 
Flag field is a virtual field in the Quote Item business component that is persistent 
in the session.

Expected Preconditions Before the Method Can Be Called
■ This method is invoked in the eSales - Checkout Process workflow. The 

sequence called is OrderQuote (see “OrderQuote” on page 282), then 
ValidQuote, and then RemoveInvalidItems (see “RemoveInvalidItems” on 
page 285).

■ This method only checks the Base Price field in the Quote Item business 
component. If this field is empty for a record, then the record is invalid. You can 
override this method to do your own validity checking.
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Arguments
The ValidQuote method has the arguments shown in Table 48.

Pseudo-Algorithm
1 Get the Quote and Quote Item business component. Create a variable 

invalidFlag=N.

2 For each record in the Quote Item business component, check the Base Price 
field:

If this field is empty, set invalidFlag = Y and set the Invalid Flag field = Y for 
that record.

3 Set the Invalid output argument = invalidFlag.

Table 48. ValidQuote Arguments

Name Type Data Type Optional Comments

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.

Invalid Output String Y Returns Y if there are any invalid 
items in the Shopping, Cart. Else 
returns N.

Quote Id Input String Y Not used.

ReturnVal Output String Y Returns Success or Fail. Not used.
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4 Set the Error Message output argument if there is any error;

If Return Error Code = N, do not return an error;

Else return an error.

RemoveInvalidItems
RemoveInvalidItems is called in Check Out workflow. It deletes each record in the 
Quote Item business component whose Invalid Flag is Y.

Expected Preconditions Before the Method Can Be Called
■ This method is invoked in the eSales - Checkout Process workflow. The 

sequence called is OrderQuote (see “OrderQuote” on page 282), then ValidQuote 
(see “ValidQuote” on page 283), and then RemoveInvalidItems.

■ This method only checks the Base Price field in the Quote Item business 
component. If this field is empty for a record, then the record is invalid. You can 
override this method to do your own validity checking.

Arguments
The RemoveInvalidItems method has the arguments shown in Table 49.

Table 49. RemoveInvalidItems Arguments

Name Type Data Type Optional Comments

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.
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Pseudo-Algorithm
1 Get the Quote and Quote Item business components.

2 Check the Invalid input argument:

If Invalid = N, go to step 4.

3 For each record in the Quote Item business component, check the Invalid Flag 
field:

If the field value is Y, delete the record.

4 Set the Error Message output argument if there is any error;

If Return Error Code = N, do not return an error;

Else return an error.

CreateOrder
CreateOrder method creates an order from the current quote. It creates a record in 
the Order Entry - Orders business component. It copies records from the child 
business component Quote Item to Order Entry - Line Items and from the grandchild 
business component Quote Item XA to Order Item XA.

Expected Preconditions Before the Method Can Be Called
Field maps are used to copy fields from the Quote to Order Entry - Orders, Quote 
Item to Order Entry - Line Items, and Quote Item XA to Order Item XA business 
components.

Invalid Input String Y If equal to N, do nothing.

Else loop through each line item to 
delete invalid items.

Quote Id Input String Y Not used.

ReturnVal Output String Y Returns Success or Fail. Not used.

Table 49. RemoveInvalidItems Arguments

Name Type Data Type Optional Comments
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Example sample field maps are shown in Table 50. See the Shopping Service 
business service user properties in Siebel Tools for more details.

Arguments
The CreateOrder method has the arguments shown in Table 51.

Table 50. Sample Field Maps for the CreateOrder Method

Name Value

Quote|Order FieldMap 100 Contact Id|Contact Id

Quote Item|Order Item FieldMap 100 Class Registration Id|Class Registration Id

Quote Item XA|Order Item XA FieldMap 101 Name|Name

Table 51. CreateOrder Arguments

Name Type Data Type Optional Comments

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.

Quote Id Input String Y Not used.

Order Id Output String Y ID of the order record that is created.

ReturnVal Output String Y Returns Success or Fail. Not used.
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Pseudo-Algorithm
1 Get the Quote, Quote Item, Quote Item XA, Order Entry - Orders, Order Entry - 

Line Items, and Order Item XA business components.

The Quote business component is already positioned on the correct record, as 
the CreateOrder method is row-sensitive.

2 Create a record in the Order Entry - Orders business component. Use 
Quote|Order FieldMap n to copy fields from the Quote business component to 
the Order Entry - Orders business component.

3 For each record in the Quote Item business component, copy it to the Order 
Entry - Line Items business component using the Quote Item|Order Item 
FieldMap n field maps. To maintain hierarchical relationships, copy the parent 
record before copying its child records. Also copy records from the grandchild 
business component Quote Item XA to Order Item XA.

NOTE: As Quote Item and Order Entry - Line Items have hierarchies, you cannot 
simply loop through the records in Quote Item and copy them to Order Entry - 
Line Items. You need to maintain the hierarchical relationship. To do this, you 
need to copy the parent record before you copy its child records.

In the Shopping Service implementation, records are first loaded from Quote 
Item and a tree in the memory is generated. The tree is then traversed from the 
root, so the parent record is copied before the child records.

4 When doing step 3, for each record in the Quote Item business component:

If the record is a Siebel eTraining item, confirm the registration record in the 
eTraining business component.

5 Set the CurrentOrderId profile attribute to the order that is created;

Set the Order Id output argument;

Clear the CurrentCheckOutQuoteId profile attribute;

If the Id of the quote record equals the CurrentQuoteId profile attribute, clear the 
CurrentQuoteId profile attribute by setting it = EMPTY_CART.
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6 Set the Error Message output argument if there is any error;

If Return Error Code = N, do not return an error;

Else return an error.
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Reorder
Reorder is the reverse of CreateOrder. It creates a quote from an existing order.

Expected Preconditions Before the Method Can Be Called
■ You cannot reorder Siebel eAuction or Siebel eTraining items. The Shopping 

Service skips those line items in the order.

■ Because of this, if you are also using Siebel eTraining or Siebel eAuction, you 
must make sure that the eSales - Cancel Order Process and eSales - Modify Order 
Process workflows are not available for orders that contain Siebel eTraining or 
Siebel eAuction items. You should also disable the Cancel and Modify Order 
buttons in the My Orders view for orders that contain Siebel eTraining or Siebel 
eAuction items.

■ Field maps are used to copy fields from the Order to Quote and Order Entry - 
Line Items to Quote Item business components, in the reverse of the CreateOrder 
method. Field maps are used to copy records from the Order Item XA to the 
Quote Item XA business component.

Example sample field maps are shown in Table 52. See the Shopping Service 
business service user properties in Siebel Tools for more details.

Table 52. Sample Field Maps for the Reorder Method

Name Value

Quote|Order FieldMap 100 Contact Id|Contact Id

Quote Item|Order Item FieldMap 100 Class Registration Id|
Class Registration Id

Quote Template Item XA|Quote Item XA FieldMap 100 Attribute Id|Attribute Id
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Arguments
The Reorder method has the arguments shown in Table 53.

Pseudo-Algorithm
1 Get the Order Entry - Orders, Order Entry - Line Items, and Order Item XA 

business components. Get an instance of the Catalog business object and of the 
Quote, Quote Item, and Quote Item XA business components from this Catalog 
business object instance.

The Order Entry - Orders business component is already positioned on the 
correct record, as the Reorder method is row-sensitive.

2 Create a record in the Quote business component. Use Quote|Order FieldMap n 
to copy fields from the Order Entry - Orders business component to Quote.

Table 53. Reorder Arguments

Name Type Data Type Optional Comments

Return Error Code Input String Y If equal to N, the method will not 
return errors.

When a method returns an error, the 
workflow stops. In order not to kill 
the workflow, you can set this input 
to N. This way the Shopping Service 
will not return an error, but instead 
will save the error message in the 
output argument Error Message. You 
can then handle the error message as 
you wish.

Error Message Output String Y Stores error messages.

Quote Id Output String Y ID of the quote that is created.

Order Id Output String Y Not used.

ReturnVal Output String Y Returns Success or Fail. Not used.
Version 7.5, Rev. A Siebel eSales Administration Guide 291



Shopping Service API

Workflow Methods
3 For each record in the Order Entry - Line Items business component, copy it to 
the Quote Item business component using Quote Item|Order Item FieldMap n 
field maps. To maintain hierarchical relationships, copy the parent record before 
copying its child records. Also copy records from the grandchild business 
component Order Item XA to Quote Item XA.

NOTE: As Order Entry - Line Items and Quote Item have hierarchies, you cannot 
simply loop through the records in Order Entry - Line Items and copy them to 
Quote Item. You need to maintain the hierarchical relationship. To do this, you 
need to copy the parent record before you copy its child records.

In the Shopping Service implementation, records are first loaded from Order 
Entry - Line Items and a tree in the memory is generated. The tree is then 
traversed from the root, so the parent record is copied before the child records.

4 When doing step 3, for each record in the Order Entry - Line Items business 
component:

If the record is a Siebel eTraining item, confirm the registration record in the 
eTraining business component.

5 Set the Error Message output argument if there is any error;

If Return Error Code = N, do not return an error;

Else return an error.
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GetShoppingCartStatus
GetShoppingCartStatus is called to get the status of the Shopping Cart (current 
quote as indicated by the CurrentQuoteId profile attribute). It returns three output 
arguments: Status, Quote Type, and Count.

Expected Preconditions Before the Method Can Be Called
None.

Arguments
The GetShoppingCartStatus method has the arguments shown in Table 54.

Table 54. GetShoppingCartStatus Arguments

Name Type Data Type Optional Comments

Quote Type Output String Y Type of the current quote record.

If Persistent Cart, check Status and Count to 
determine whether the quote is empty or 
not.

If not Persistent Cart, Status will always be 
Empty and Count will always be 0 even 
though the current quote record might 
contain line items.

Status Output String Y Can be Empty or Not Empty.

Count Output String Y Number of line items in the Shopping Cart.

Quote Id Input String Y Not used.

ReturnVal Output String Y Returns Success or Fail. Not used.
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Pseudo-Algorithm
1 If CurrentQuoteId is empty or equals to EMPTY_CART:

Set Quote Type = Quotation;

Set Status = Empty;

Set Count = 0;

End.

2 If Quote Type is not Persistent Cart:

Set Quote Type accordingly;

Set Status = Empty;

Set Count = 0;

End.

3 Loop through the Quote Item business component. Set Status and Count 
accordingly.

MoveToCart
MoveToCart moves a quote record into the Shopping Cart. By doing this, it sets the 
CurrentQuoteId profile attribute to the quote record ID. It also sets the Price List Id 
field value of this quote to the current price list for the session as indicated by the 
PriceListId profile attribute, for users associated with an account that has a default 
price list, and by DefaultPriceListId for users who are not associated with such an 
account. This will trigger a reprice if the price list for this quote has been changed.

In addition, if the field value of Quote Type is not Auction Quote, it will change the 
quote type to Persistent Cart if the application supports persistent Shopping Carts. 
For applications that do not support Shopping Carts, the Shopping Service will not 
change the quote type.
294 Siebel eSales Administration Guide Version 7.5, Rev. A



Shopping Service API

Workflow Methods
Expected Preconditions Before the Method Can Be Called
■ This method is invoked in the following workflows:

■ eSales - Edit Quote Process

■ eSales - Order Quote Process

■ eSales - Modify Order Process

■ eSales - Reorder Process

■ The field value of Quote Type for the current quote record can be Persistent Cart, 
Auction Quote, or Quotation. When the quote type is not Auction Quote, if the 
application supports persistent Shopping Carts, the quote type is changed to 
Persistent Cart.

Arguments
The MoveToCart method has the arguments shown in Table 55.

Pseudo-Algorithm
1 Set the CurrentQuoteId profile attribute to the quote record ID. As the 

MoveToCart method is row-sensitive, the current record in the Quote business 
component is the record to move to the Shopping Cart.

2 If the PriceListId profile attribute is not empty and if the Price List Id field in this 
quote record <> PriceListId profile attribute, then change the Price List Id for 
this quote. This triggers a reprice. Note that you need to use DefaultPriceListId 
instead of PriceListId if the user is not associated with an account that has a 
default price list.

3 If Quote Type is not Persistent Cart or Auction Quote, change it to Persistent Cart.

Table 55. MoveToCart Arguments

Name Type Data Type Optional Comments

Quote Id Input String Y Not used.

ReturnVal Output String Y Returns Success or Fail. Not 
used.
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RepriceQuote
RepriceQuote reprices the quote.

Expected Preconditions Before the Method Can Be Called
None.

Arguments
The RepriceQuote method has the arguments shown in Table 56.

Pseudo-Algorithm
1 Position the Quote business component on the record indicated by the Quote Id 

input argument.

2 Call Pricing Manager to get the current price list ID:

If this price list ID is different from the quote record's price list Id, then change 
the quote record's price list ID.

Table 56. RepriceQuote Arguments

Name Type Data Type Optional Comments

Quote Id Input String Y ID for the quote record to be 
repriced.

Error Message Output String Y Error message, if any.

Return Error Code Input String Y Does not return an error if 
equal to N.

ReturnVal Output String Y Returns Success or Fail. Not 
used.
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SelectPrimary
This method is used to select a row from the picklist.

Expected Preconditions Before the Method Can Be Called
None.

Arguments
The SelectPrimary method has the arguments shown in Table 57.

Pseudo-Algorithm
1 Get and check the input arguments.

2 Get the picklist business component from the Quote business component with 
the PickList Field input argument.

3 Set the search specification using either the Primary Row Id or Primary ID Field 
input argument.

4 Pick the first row if an active row exists;

Else clear the picklist.

5 Write and refresh the business component.

Table 57. SelectPrimary Arguments

Name Type Data Type Optional Comments

PickList Field Input String Y Name of the field that has the 
picklist.

Primary ID Field Input String Y Primary Id field.

Primary Row Id Input String Y Row ID for the picklist.

ReturnVal Output String Y Returns Success or Fail. Not 
used.
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SetBusCompFields
This method is used to set a list of fields in a business component.

Expected Preconditions Before the Method Can Be Called
None.

Arguments
The SetBusCompFields method has the arguments shown in Table 58.

Pseudo-Algorithm
1 Get the required inputs to get an instance of the business component.

2 Get the search specification fields:

If they are passed, then set the search specification on the business component.

3 Query the business component if it has not been queried or if the search 
specification is passed.

4 Go through all the input arguments for <Field Name n> and set the value to 
the business component.

Table 58. SetBusCompFields Arguments

Name Type Data Type Optional Comments

Business Object Input String N Business object.

Business 
Component

Input String N Business component.

Search Field Input String Y Field on the business 
component.

Search Value Input String Y Value to be set to the search 
specification.

<Field Name1> Input String Y Name/value pair.

<Field Name2> Input String Y Name/value pair.
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5 Write to the record.

ValidatePayment
This method is used to validate the payment information for either a purchase order 
or a credit card.

Expected Preconditions Before the Method Can Be Called
None.

Arguments
The ValidatePayment method has the arguments shown in Table 59.

NOTE: If you want to perform credit card validation on a business component other 
than Quote, the business component must be either based on the CSSBCBase class, 
based on a class that is itself based on the CSSBCBase class, or based on a class that 
inherits from the CSSBCBase class, such as CSSBCQuote. For more information, see 
the section on credit card user properties in Siebel Tools Reference.

Table 59. ValidatePayment Arguments

Name Type Data Type Optional Comments

PO Number Input String N Purchase order number.

Credit Card Number Input String Y Credit card number.

Credit Card Type Input String Y Credit card type.

Expiration Month Input String Y Expiration month.

Expiration Year Input String Y Expiration year.

Return Error Code Input String N Does not return an error 
if equal to N.

Error Message Output String N Error message, if any.
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Pseudo-Algorithm
1 Check what kind of payment is entered by checking the PO Number and Credit 

Card Number input arguments.

2 If PO Number has a value, then the payment information is valid.

3 If Credit Card Number has a value, then get all the required fields.

4 Pass the credit card information to the Credit Card Transaction Service business 
service to validate the information.

ValidateAddress
This method is used to validate the address information by checking to see that the 
necessary information has been entered. Input argument names are used in any 
error messages.

Expected Preconditions Before the Method Can Be Called
None.

Arguments
The ValidateAddress method has the arguments shown in Table 60.

Table 60. ValidateAddress Arguments

Name Type Data Type Optional Comments

Street Address Input String N

State Input String N

City Input String N

Country Input String N

Postal Code Input String N

Return Error Code Input String N Do not return an error if equal 
to N.

Error Message Output String N Error message, if any.
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Shopping Service API

Workflow Methods
Pseudo-Algorithm
Go through all the input arguments and make sure that the values are not null.
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Shopping Service API

Siebel eAuction Integration Methods
Siebel eAuction Integration Methods
The following methods are used in integration with Siebel eAuction. As they are not 
used in workflows and should not be customized, they are described here only 
briefly.

Siebel eAuction needs to call three methods sequentially to create a quote:

■ CreateAuctionQuote. Called by Siebel eAuction to create a quote for auction 
items. The quote type used is Auction Quote.

■ AddAuctionQuoteItem. Adds an auction item to the quote created in the 
CreateAuctionQuote method. AddAuctionQuoteItem might be called several 
times, once for each auction item.

■ CommitAuctionQuote. Commits the auction quote.

For more information on Siebel eAuction, see Siebel eAuction Guide.
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A
access groups

catalog, associating with an access 
group 54

category, associating with an access 
group 67

defined and relationship to user 32
accounts

auto-approval limit, setting 151
credit auto-approval limit, setting 151
credit checks for, skipping 152
customer account, associating price lists 

with 148
customer account, associating users 

with 148
customer account, creating 147
purchase order approval, allowing 

for 150
AddToCart method

arguments (table) 261
expected preconditions before calling 

method 255
pseudo-algorithm for AddToCart, steps to 

using 262
pseudo-algorithm for DefaultAddToCart, 

steps to using 263
pseudo-algorithm for PostAddToCart, step 

to using 263
AddToFavorteList method

arguments (table) 265
expected preconditions 265
pseudo-algorithm 266

administrative tasks
account credit auto-approval limit, 

setting 151

anonymous quotes deletion, setting age 
for 145

anonymous Shopping Carts, about 
managing 145

credit card charges, cardholder 
information displayed 153

credit checks for an account, 
skipping 152

customer account, allowing purchase 
order approval 150

customer account, associating price lists 
with 148

customer account, associating users 
with 148

customer account, creating an 
account 147

customer account, setting auto-approval 
limit 151

customer account, setting credit auto-
approval limit 151

quote expiration dates, setting 144
anonymous quote type, described 131
anonymous Shopping Carts, managing

See also Shopping Cart
about 145
anonymous quotes deletion, setting the 

age for 145
API, Shopping Service

See also individual method name
detailed description 253
User Action methods 254
workflow methods 275

applets, conditional expressions used to 
hide (table of) 36
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Approve Order Process workflow, diagram 
and description 113

ATP Check Interface
added field, preventing from being 

modified by fulfillment engine 242
extending, about and naming fields 

(table) 241
ATP Fulfilllment View (eSales), adding the 

Explicit Login parameter 243
attributes, making searchable 79
auctions

categories, about associating with 62
home page link, described 20
quote type, described and process of 

converting to order 132
Silent Authorize Order workflow 125, 

126
Audit File, about and writing to 224
AuthCharge, Credit Card Transaction 

Service business method, 
described 167

Authorization, Credit Card Transaction 
Service business method, 
described 167

Authorize and Settle credit card charge 
modification, about 154

Authorize credit card charge modification, 
about 153

Authorize Order Process, workflow 
described and diagram 105

auto-approval limit, setting for an 
account 151

Available Date user interface term, 
defined 244

B
buttons, used to build catalog 

hierarchies 69

C
CalculateShippingCost script, about 44
Cancel Order Process workflow 116

Catalog Category business component, 
predefined search definition 40

Catalog page, home page link, 
described 20

catalogs
See also categories; server-based catalogs
about and deployment options 

(table) 50
access group, associating with a 

catalog 54
catalog defined and hierarchy 

diagram 50
catalog hierarchies, buttons used to 

build 69
creating catalogs 52
language for translation, choosing 55
removing category item count 63
subcategories, creating 69
updating category count 63

categories
See also catalogs; display templates
access group, associating with a 

category 67
auctions, about associating with 62
catalogs, as part of (hierarchy 

diagram) 51
creating categories 57
display templates, about creating 

new 71
display templates, setting for a 

category 65
display templates, table of 65
language for translation, choosing 68
literature, associating with 61
products, associating with 59
removing item count 63, 64

Category Detail View, creating 71
Charge, Credit Card Transaction Service 

business method, described 168
Check Availability button

about using 235
hiding 243

Check Shipment button, about using 245
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checkout
Authorize Order Process, workflow 105
Checkout Process, workflow 95
Complete Checkout Process, 

workflow 103
Credit Check-Quotes, workflow, about 

and diagram 97
Credit Check-Quotes, workflow, 

modifying 98
Current User Type, workflow 111
Enter Payment Details Process, 

workflow 101
Enter Shipping Details Process, 

workflow 99
Save Account Shipping Address, 

workflow 109
Save Credit Card, workflow 107
Save Shipping Address, workflow 108
Set Primary Account Address, 

workflow 109
Setting PO Status, workflow 110

communications drivers, about setting 
up 47

Complete Checkout Process, described and 
diagram 103

conditional expressions, used to hide 
applets 36

CreateOrder method
about 286
arguments (table) 287
expected preconditions 286
pseudo-algorithm 288

credit auto-approval limit for an account
about setting 151
setting for an account 151

credit card charges
authorizing 155
combining authorizing and settling 156
credit card authorization, about querying 

for 156
credit card authorization, querying for 

Siebel Response messages 156
modifications allowed (list of) 153

modifying, table of fields 153
refund (procedure) 158
reversing charges 158
settling a credit card charge 155

Credit Card Transaction Service
business service methods, list of 167
business service user properties, table 

of 169
process flow, diagram and 

described 166
credit card validation, about performing on 

business component other than 
quote 299

credit cards
data, about encrypting and eSales 

fields 46
payments, workflow for authorizing 105
transaction service, calling from other 

business components 184
transaction service, calling from other 

places in eSales 184
transactions, data maps used in 178
transactions, enabling with 

CyberSource 165
credit checking, turning off 194
Current User Type workflow described and 

diagram 111
customer accounts

auto-approval limit, setting 151
creating an account 147
credit auto-approval limit, setting 

(procedure) 151
price lists, associating with 148
purchase order approval, allowing 

for 150
users, associating with 148

CyberSource
See also CyberSource, customizing; 

CyberSource, integrating with eSales
credit card transactions, enabling 165
eSales, about accessing 

CyberSource 160
installing, steps for 161
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merchant ID, obtaining 161
UNIX, downloading onto 163
UNIX, installing on 164
Web site 160
Windows, downloading 162
Windows, installing on 162

CyberSource Adapter Service
See also CyberSource; CyberSource, 

customizing
about and methods 179
scripts, examining 180
scripts, list of 180
scripts, using to modify 182

CyberSource Support Center, 
accessing 160

CyberSource, customizing
See also CyberSource; CyberSource, 

integrating with eSales
Credit Card Transaction Service, calling 

from other business 
components 184

Credit Card Transaction Service, calling 
from other places in eSales 184

fields not in Siebel database, passing data 
from 183

fields not in Siebel database, passing data 
to 183

scripts, modifying in CyberSource 
Adapter Service 182

third-party payment applications, 
using 185

CyberSource, integrating with eSales
See also CyberSource; CyberSource, 

customizing; data maps; integration 
objects

address verification, about 181
business service methods, lists of 167
business service user properties, table 

of 169
Credit Card Transaction Service, process 

flow diagram and described 166

CyberSource Adapter Service, about, 
methods, user properties, and 
scripts 179

D
data maps

CyberSource, about using and 
viewing 178

CyberSource, credit card transactions, 
used with (table) 178

Taxware, about using and viewing 223
Taxware, used in (table) 223

DAVSNO reply code, returned by 
CyberSource 181

(declarations) script, about 44
DefaultAddToCart, steps to using pseudo-

algorithm 263
DiscardCart method

arguments (table) 281
expected preconditions 280
pseudo-algorithm 281

Display Error Process, workflow described 
and diagram 121

display templates
See also categories
application, adding to 74
detail view, creating 71
drilldown objects for view, creating 73
new display templates for categories, 

about creating 71
setting for a category 65
table of 65
Web layout, editing 74

drilldown objects, creating for view 73

E
eAdvisor. See Siebel eAdvisor
eAuction Auction Item business 

component, predefined search 
definition 40

email notification, customizing
about and tasks involved 47
306 Siebel eSales Administration Guide Version 7.5, Rev. A



Index
communications driver profiles, about 
setting up 47

email template, modifying 48
email workflows, list of (diagram) 112
workflows, about using to control 

notification 47
email notifications workflows, about 85
Enter Payment Details Process, 

workflow 101
Enter Shipping Details Process, 

workflow 99
error messages

configuring error messages 232
credit card authorizations, about 

querying for 156
credit card authorizations, querying for 

Siebel Response message 156
Display Error Process workflow, 

described and diagram 121
errors, prevention of Unicode conversion 

errors 230
eSales

See also personalization
implementing without frames 27
Siebel eAdvisor, views to remove 

(table) 26
Tax Calculator Business Service, process 

flow 215
eSales home page. See home page
eSales Web site, obtaining product 

availability information
about 235
availability fulfillment methods, 

checking 236
External ATP Check business service, 

verifying 237
Quote business component, setting the 

ATP action parameter 236
Web services, configuring 

(procedure) 238
Web services, configuring, about 237

eSales, modifying workflows
order workflows, list of 85

External ATP Check business service, 
verifying user properties 237

External Shipment Tracking ASI user 
properties, setting 248

F
favorites list

item, about making unavailable to 
user 21

not allowing user to order item from, 
about 21

frames, implementing Siebel eSales 
without 27

G
GetShippingMethodCost script, about 44
GetShippingRate script, about 44
GetShoppingCartStatus method

about 293
arguments (table) 293
expected preconditions 293
pseudo-algorithm 294

guide, organization of 14

H
home page

about and screen example 19
hyperlinks and tabs, described 20

Hummingbird SearchServer, about 39

I
installing

Cybersource, steps for 161
required Siebel applications 25
Taxware on UNIX 208
Taxware on Windows 200

integration objects
See also CyberSource, integrating with 

eSales
about 172
authorization integration components 

(output) 173
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authorize and settle (CyberSource Input) 
integration components 176

authorize and settle (CyberSource 
Output) integration components 176

configuration user properties 172
CreditCard authorization (CyberSource 

Input) 173
CreditCard authorization (CyberSource 

Output) 173
CreditCard Payments authorization 174
CreditCard-Quote authorization (Siebel 

Input) 174
CreditCard-Quote authorization (Siebel 

Output) 174
refund (CyberSource Input) integration 

components 176
refund (CyberSource Output) integration 

components 177
settle-charge (CyberSource Input) 

integration components 175
settle-charge (CyberSource Output) 

integration components 175
shipping charge calculation, using to set 

up 43
Tax Calculation Business Service 

integration objects 217

L
language

catalog translation, choosing 55
category translation, choosing 68

literature, associating categories with 61
Login View workflow, described and 

diagram 122
LOV cache (List of Values), about clearing 

for new expiration date 144

M
magnifying glass. See parametric search
merchant ID, obtaining to install 

Cybersource 161

Modify Order Process workflow, description 
and diagram 117

MoveToCart method
about 294
arguments (table) 295
expected preconditions 295
pseudo-algorithm 295

My Account page, home page described 21
My Company applet, about hiding applet 

using conditional expression 36

N
notification, customizing

about and tasks involved 47
communications driver profiles, about 

setting up 47
email templates, modifying 48
email workflows, list of and diagram 112
workflows, about using to control 

notification 47

O
object manager parameters

default object manager parameters, 
viewing 139

Mobile Web Client, modifying 
parameters 141

Web client, modifying parameters 
in 139

Order Confirmation View workflow, 
described and diagram 123

Order Quote Process workflow, described 
and diagram 89

Order Template method
expected preconditions 272
pseudo-algorithm 273

order workflows
See also order workflows, modifying
auction quotes to orders 125
Authorize Order Process workflow 105
Checkout Process 95
Complete Checkout Process 103
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Credit Check-Quotes workflow, about and 
diagram 97

Credit Check-Quotes workflow, 
modifying 98

Current User Type, about and 
diagram 111

email workflow, list of (diagram) 112
Enter Payment Details Process 101
Enter Shipping Details Process 99
error messages 121
features built using Siebel Business 

Process Designer 85
modifying processes, about 127
Process Designer, accessing 84
purchase order approval, workflow, 

diagram and description 113
Save Account Shipping Address, about 

and diagram 109
Save Cart Process, workflow 91
Save Credit Card, about and 

diagram 107
Save Shipping Address, about and 

diagram 108
Set Primary Account Address, about and 

diagram 109
Setting PO Status, about and 

diagram 110
order workflows, modifying

See also order workflows
Modify Order Process, workflow 

described and diagram 117
order modification workflow 116
Reorder Process, workflow 119

OrderQuote method
arguments (table) 282
expected preconditions 282
pseudo-algorithm 283

orders, modifying. See email notification, 
customizing

OrderTemplate method, about 271
organization of guide 14

P
package sorting

order, changing 251
turning off 252

Package Tracking Number, defined 246
package, defined 246
parametric search

about and accessing 21
about setting up 77
attribute, making searchable 79
class, making searchable 77
List Price field, removing from search 80
product family, initiating search with 

product family selected 80
products, determining searchability 79

part numbers, finding 199
payment applications, using third-

party 185
Payment tab, cardholder information 

displayed 153
persistent cart quote type, about and 

process overview 131
personalization

See also eSales
about 36
applets, conditional expressions used to 

hide (table of) 36
PostAddToCart method, steps to using 

pseudo-algorithm 263
price lists

customer accounts, associating 
with 148

default price list, about setting 34
default, setting (procedure) 35
row number, finding 34
Set PriceList WebLogin action, 

about 138
setting up, about 33

Process Designer, accessing 84
Process, Credit Card Transaction Service 

business method, described 168
product availability information
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modified by fulfillment engine 242
ATP Check Interface, extending 241
availability fulfillment methods, 

checking 236
External ATP Check business service 

verifying 237
Quote business component, setting the 

ATP action parameter 236
rollup of availability information, about 

and examples 240
rollup of availability information, turning 

off 241
user interface terms, list of 244
user registration, requiring 243
Web services, about configuring 237
Web services, configuring 

(procedure) 238
Product business component, predefined 

search category 40
product family, initiating search with 

product family selected 80
products

categories, associating with 59, 60
defining, list of tasks involved in 38
note, viewing on price list and in 

catalogs 59
searching, determining searchability 79

purchase approval process, workflow 
about 85

purchase order credit checking applications
about using 188
credit auto-approval limit, changing 194
Credit Check - Quotes workflow, about 

customizing 194
credit check interface request, 

extending 195
Credit Check Service business service, 

modifying 193
credit checking, restricting which 

employees can administer 195

credit checking, turning off 194
credit checks for an account, 

skipping 194
External Credit Check ASI user properties, 

verifying 190
quote or order, about making from 

employee application 189
Web services, configuring 190
workflows that control process 188
workflows, activating 192

purchase orders
approval, allowing for an account 150
Approve Order Process workflow, 

diagram and description 113
Reject Order Process, workflow 114
workflow for authorizing 105

Q
quotation quote type, described 132
Quote business parameter, setting the ATP 

action parameter 236
Quote Empty Form applet, about hiding 

applet using conditional 
expression 36

Quote Form Applet - Current, about hiding 
applet using conditional 
expression 36

Quote Item List Applet, about hiding applet 
using conditional expression 37

quotes
expiration dates, setting 144
Order Quote Process workflow, described 

and diagram 89
Reprice Process, workflow described and 

diagram 90
types, new quote types described 131

R
rapid checkout workflow, about 85
Recommended Product List Applet, about 

hiding applet using conditional 
expression 37
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Refund credit card charge modification, 
about 154

refund credit card charge, procedure 158
Refund, Credit Card Transaction Service 

business method, described 168
Reject Order Process, workflow 114
release, what’s new 14
RemoveInvalidItems method

arguments (table) 285
expected preconditions 285
pseudo-algorithm 286

Reorder method
arguments (table) 291
expected preconditions 290
pseudo-algorithm 291

Reorder Process, workflow, description and 
diagram 119

Reprice Process workflow, description and 
diagram 90

RepriceQuote method
arguments (table) 296
expected preconditions 296
pseudo-algorithm 296

Requested Date user interface term, 
defined 244

responsibilities
and user types (table) 31
predefined, list of 30

returned data, extending 251
Reverse, Credit Card Transaction Service 

business method, described and 
arguments 168

reversing charges 158
rollup of availability information

about and examples 240
turning off 241

RSA encryption, about regularly backing up 
data 46

run-time events, about configuring 
Shopping Cart behavior 137, 138

S
Sales/Use Taxware module

described 198
installing 200
setting up 205
tax calculation, enabling 212

Save Account Shipping Address 
workflow 109

Save Cart Process workflow, description and 
diagram 91

Save Credit Card workflow, description and 
diagram 107

Save Shipping Address workflow, 
description and diagram 108

SaveCartAsQuote method
arguments (table) 278
expected preconditions 278
pseudo-algorithm 279

SaveCartAsTemplate method
arguments (table) 276
expected preconditions 275
pseudo-algorithm 276

scripts
business service scripts, setting up 

shipping charge calculation 44
CyberSource Adapter Service, using to 

modify scripts 182
search

about 39
attribute, making searchable 79
class, making searchable 77
implementing Siebel Search, about 39
List Price field, removing from search 80
parametric search, about and 

accessing 21
parametric search, about setting up 77
product family, initiating search with 

product family selected 80
products, about determining 

searchability 79
search definitions, predefined (table 

of) 40
SelectPrimary method

arguments (table) 297
expected preconditions 297
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pseudo-algorithm 297
Send Order Accepted Email (eSales), email 

workflow 112
Send Order Awaiting Approval Email 

(eSales), email workflow 112
Send Order Failed Email (eSales), email 

workflow 112
Send Order Rejected Email (eSales), email 

workflow 112
Send Order Shipped Email (eSales), email 

workflow 112
server-based catalogs

See also categories
about (table) 50
catalog defined and hierarchy 

diagram 50
Set Primary Account Address workflow, 

description and diagram 109
SetApplicationName method

about 270
arguments (table) 271
expected preconditions 270
pseudo-algorithm 271

SetApplicationName WebSessionStart 
action, about 137

SetBusCompFields method
arguments (table) 298
expected preconditions 298
pseudo-algorithm 298

SetPriceList WebLogin action, about 138
SetShoppingCart method

about 267
arguments (table) 268
expected preconditions 268
pseudo-algorithm 268

SetShoppingCart WebLogin action, 
about 138

Setting PO Status workflow, description and 
diagram 110

Settle credit card charge modification, 
about 154

Shipment Identification Number, 
about 245

Shipment Identification number, 
defined 245

Shipment Reference Number, defined 246
Shipment Tracking Interface Request, 

about 245
Shipment Tracking Interface Response, 

about 245
Shipment Tracking Number, defined 245
Shipment Tracking-Package Tracking user 

properties, setting 247
Shipment, defined 245
shipping charge calculation, setting up

See also checkout; order workflows
about 41
business service scripts, list of 44
business services, arguments used in 

process 42
integration objects, about using and list 

of 43
modifying shipping charge 

calculation 44
workflows, about and diagram 41

Shipping Cost Service business service, list 
of scripts used 44

shipping tracking
External Shipment Tracking ASI user 

properties, setting 248
package sorting order, changing 251
package sorting, turning off 252
returned data, extending 251
Shipment Tracking-Package Tracking user 

properties, setting 247
terms, list of 245
Web services, configuring 249

ShippingCost - Quote (Siebel Input), 
integration object component 43

ShippingCost - Quote (Siebel Output), 
integration object components 43

Shopping Cart
See also anonymous Shopping Carts, 

managing; Shopping Service business 
service

about 130
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customizing, about 133
default object manager parameters, 

viewing 139
home page described 20
object manager parameters in Mobile 

Web Client, modifying in 141
object manager parameters, modifying in 

the Web client 139
quote types, new 131
run-time events, about configuring 

application behavior 137
Save Cart Process workflow, described 

and diagram 91
Shopping Cart View workflow, described 

and diagram 124
Shopping Service business service 

method, invoked by WebLogin 138
Shopping Service business service 

method, invoked by 
WebSessionStart 137

Shopping Service business service 
methods, table of 134

Shopping Service business service
See also Shopping Cart and individual 

method name
customizing, about 133
methods, detailed description 253
methods, table of 134, 136
methods, User Action 254
methods, workflow 275
WebLogin, invoked by 138
WebSessionStart, invoked by 137

Siebel 7.5, upgrading and credit card 
encryption 46

Siebel applications, about installing 25
Siebel catalog, about and deployment 

options (table) 50
Siebel eAdvisor applet

views to remove, procedure 26
views to remove, table of 26

Siebel eSales
implementing without frames 27

Siebel eAdvisor, views to remove, 
procedure 26

Siebel Response Messages, table of 156
Siebel Search. See search
Siebel Web Engine, about installing 25
STEP Taxware module

described 198
installing 201
setting up 206
transaction and reason files, 

loading 206, 207
subcategories, creating

See also catalogs
buttons for modifying (table) 69
creating (procedure) 69

T
Tax Calculation Business Service

Tax - Configuration (Taxware) 218
Tax Integration (Siebel Quote) 219
Tax Integration (Taxware Input) 220
Tax Integration (Taxware Output) 221

tax calculation, using other than 
Taxware 229

Tax Calculator business service
eSales, calling from other business 

components 228
eSales, calling from other places in 227

taxes
See also Taxware
calculated, about 198
tax calculation services, using other than 

Taxware 229
tax calculation, enabling with Sales/Use 

Taxware module 212
tax calculation, enabling with 

WORLDTAX Taxware module 213
Taxware

See also Taxware, integrating with eSales; 
Taxware, customizing

data maps, about using and viewing 223
data maps, used in Tax Calculator 

Business service 223
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free disk space, required amount 208
modules, about 198
tax calculation with Sales/Use 212
tax calculation with WORLDTAX 213
UNIX, installing on 208
UNIX, setting up on 210
Windows environment, setting system 

Path variable 204
Windows, installing on 200
Windows, setting up on 205

Taxware Adapter Business Service, about 
and method 224

Taxware, customizing
data, passing from other fields in the 

Siebel database 226
fields not in Siebel database, adding to 

fields that pass data 226
Tax Calculator business service, calling 

from eSales 227
Tax Calculator business service, calling 

from other business 
components 228

Taxware, integrating with eSales
See also Taxware; Taxware, customizing
Audit File, about and writing to 224
completion codes indicating status, list 

of 225
Tax Calculator Business Service 

integrated objects 217
Tax Calculator Business service, method 

and arguments 216
Taxware Adapter Service, about and 

method 224
templates

display template, setting for a 
category 65

email templates, modifying 48
not allowing user to order item from, 

about 21
third-party applications. See CyberSource; 

Taxware
third-party payment applications, modifying 

CyberSource 185

third-party shipping tracking applications. 
See shipping tracking

U
Unicode conversion errors

error messages, configuring 232
error prevention, about and list of 

fields 230
required fields, defining 232

Universal Tax Link (UTL) Taxware module
described 198
installing 202

UNIX
CyberSource, downloading onto 163
CyberSource, installing on 164
Taxware, installing on 208
Taxware, setting up 210

user access, list of tasks to control 
access 29

User Action methods. See individual 
method name

user interface
list of terms 244
Siebel eSales, implementing without 

frames 27
user profile, SetApplicationName 

WebSessionStart action, about 137
user registration, requiring 243
user types and responsibilities (table) 31
users, associating with customer 

accounts 148

V
Validate, Credit Card Transaction Service 

business method, described and 
arguments 168

ValidateAddress method
about 300
arguments (table) 300
expected preconditions 300
pseudo-algorithm 301

ValidatePayment method
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arguments (table) 299
expected preconditions 299
pseudo-algorithm 300

ValidQuote method
about 283
arguments (table) 284
expected preconditions 283
pseudo-algorithm 284

VERAZIP Taxware module, described 198
views

drilldown objects, creating 73
Siebel eAdvisor applet, removing from 

views 26
workflows for displaying 121

W
Waybill number, defined 245
Web anonymous user, responsibility 

described 30
Web corporate user, responsibility 

described 30
Web delegated customer administrator

new responsibility visible to, about 
adding 31

responsibility, described 30
Web layout, editing display templates 74
Web purchasing manager, responsibility 

described 30
Web registered user, responsibility 

described 30
Web services

configuring (procedure) 238
configuring, about 237
shipping tracking, configuring 249

Web site
CyberSource 160
multilingual, about deploying 28

WebLogin run-time event, about 
configuring Shopping Cart 
behavior 138

WebSessionStart run-time event, about 
configuring Shopping Cart 
behavior 137

Windows 2000
CyberSource, downloading 162
CyberSource, installing 162
Taxware, installing 200
Taxware, setting system path 

variable 204
Taxware, setting up on 205

Windows NT
CyberSource, downloading 162
CyberSource, installing on 162
Taxware, installing 200
Taxware, setting system path 

variable 204
Taxware, setting up on 205

workflows
Anonymous Quote records, about 

deleting 131
auction quote type, converting to 

order 132
modifying processes, about 127

WORLDTAX Taxware module
described 198
installing 203
setting up 207
tax calculation, enabling 213
Version 7.5, Rev. A Siebel eSales Administration Guide 315



Index
316 Siebel eSales Administration Guide Version 7.5, Rev. A


	Contents
	Introduction
	How This Guide Is Organized
	What’s New in This Release
	Revision History
	November 2002 Bookshelf


	Siebel eSales Overview
	Siebel eSales
	The Siebel eSales Web Site

	Setup Tasks
	Introduction
	Installing Siebel Applications
	Customizing the Framed and Unframed User Interface
	Removing the Siebel eAdvisor Applet from Siebel eSales Web Pages
	Implementing Siebel eSales Without Frames

	Creating a Multilingual Web Site
	Controlling User Access
	Setting Up Default Responsibilities and User Types
	Defining Access Groups
	Setting Up Price Lists
	Setting the Default Price List for the Siebel Application
	Finding the Row ID of a Price List
	Setting the Default Price List

	Using Siebel Personalization
	Defining Products
	Full-Text Search
	Implementing Siebel eSearch
	Predefined Search Definitions for Siebel eSales

	Setting Up Shipping Charge Calculation
	Shipping Calculation Process Workflow
	Business Services
	Integration Objects
	Business Service Scripts
	Modifying Shipping Charge Calculations

	Encrypting Credit Card Data Using RC2 Encryption
	Customizing Notifications
	Setting Up Communications Driver Profiles
	Modifying Email Workflows
	Modifying Email Templates


	Creating and Managing Catalogs
	Siebel Catalog
	Setting Up Catalogs
	Creating Catalogs
	Assigning Access to Catalogs
	Selecting Languages for Catalog Translation

	Setting Up Categories
	Creating Categories
	Associating Products with Categories
	Associating Literature with Categories
	Associating Auctions with Categories
	Updating the Category Item Count
	Removing the Category Item Count
	Setting Display Templates for Categories
	Assigning Access to Categories
	Selecting Languages for Category Translation

	Building Catalog Hierarchies
	Creating New Display Templates for Categories
	Creating a Category Detail View
	Creating Drilldown Objects for the View
	Editing the Web Layout of the New Display Template
	Adding the New Display Template to the Application

	Creating Unstructured Content
	Setting Up Parametric Search
	Making Classes Searchable
	Making Attributes Searchable
	Determining Which Products Are Returned from a Parametric Search
	Initiating Parametric Search with a Product Family Selected
	Removing the List Price Field from Parametric Search


	Modifying Order Workflows
	Introduction
	Siebel eSales Order Workflows
	Quotes and Templates
	eSales - Edit Quote Process
	eSales - Order Quote Process
	eSales - Reprice Process
	eSales - Save Cart Process
	eSales - Add To Template Process
	eSales - Delete Old Anonymous Quotes

	Checkout
	eSales - Checkout Process
	Credit Check - Quotes
	eSales - Enter Shipping Details Process
	eSales - Enter Payment Details Process
	eSales - Complete Checkout Process
	eSales - Authorize Order Process
	eSales - Save Credit Card
	eSales - Save Shipping Address
	eSales - Save Account Shipping Address
	eSales - Set Primary Account Address
	eSales - Setting PO Status
	eSales - Current User Type
	Shipping Calculation Process

	Notifications
	Purchase Approval
	eSales - Approve Order Process
	eSales - Reject Order Process

	Order Modification
	eSales - Cancel Order Process
	eSales - Modify Order Process
	eSales - Reorder Process

	Error Messages and Views
	eSales - Display Error Process
	eSales - Login View
	eSales - Order Confirmation View
	eSales - Shopping Cart View

	Auctions

	Modifying Workflows

	Shopping Cart
	Introduction
	Quote Types Used in Siebel eSales
	Shopping Service Business Service
	Customizing the Shopping Service
	Shopping Service Business Service Methods

	Run-Time Events
	Object Manager Support
	Viewing Default Object Manager Parameters
	Modifying Object Manager Parameters in the Web Client
	Modifying Object Manager Parameters in the Mobile Web Client


	Administrative Tasks
	Setting Quote Expiration Dates
	Managing Anonymous Shopping Carts
	Setting Up Customer Accounts
	Creating Accounts
	Associating Users with Accounts
	Associating Price Lists with Accounts
	Allowing Accounts and Contacts to Use Purchase Orders
	Setting PO Auto-Approval Limits for Accounts
	Setting the Credit Auto-Approval Limit For an Account
	Setting the Skip Credit Check Field For an Account

	Modifying Credit Card Charges
	Authorizing Charges
	Settling Charges
	Combining the Authorization and Settlement of Charges
	Querying For Transactions With Error Messages
	Giving Refunds
	Reversing Charges


	Using Third-Party Payment Applications
	CyberSource Internet Commerce Suite
	Installing CyberSource Software
	Obtaining a Merchant ID
	Downloading CyberSource onto Windows
	Installing CyberSource on Windows
	Downloading CyberSource onto UNIX
	Installing CyberSource on UNIX

	Enabling Credit Card Transactions with CyberSource
	CyberSource Integration with Siebel eSales
	Credit Card Transaction Service Business Service
	Business Service Methods
	Business Service User Properties

	Integration Objects
	Configuration
	Authorization
	Settle (Charge)
	Authorize and Settle (AuthCharge)
	Refund

	Data Maps
	CyberSource Adapter Service Business Service
	Address Verification with CyberSource

	Customizing Cybersource Integration
	Modifying the Scripts in the CyberSource Adapter Service
	Passing Data from Other Fields in the Siebel Database
	Passing Data from Fields Not in the Siebel Database
	Calling the Credit Card Transaction Service from Other Places in Siebel eSales
	Calling the Credit Card Transaction Service from Other Business Components
	Using Other Third-Party Payment Applications


	Using Purchase Order Credit Checking Applications
	About Using Purchase Order Credit Checking Applications
	Required Setup Procedures
	Verifying the External Credit Check ASI User Properties
	Configuring Web Services
	Activating the Workflows

	Optional Setup Procedures
	Modifying the Credit Check Service Business Service User Properties
	Turning Off Credit Checking
	Customizing the Credit Check - Quotes Workflow
	Changing the Credit Auto-Approval Limit For Accounts
	Skipping Credit Checks For an Account
	Restricting Which Employees Can Administer Credit Checking
	Extending the Credit Check Interface Request


	Using Third-Party Taxation Applications
	Introduction
	Taxware Applications

	Installing Taxware Applications on Windows
	Installing Sales/Use on Windows
	Installing STEP on Windows
	Installing UTL on Windows
	Installing WORLDTAX on Windows
	Setting Up the Windows Environment

	Setting Up Taxware Applications on Windows
	Setting Up Sales/Use on Windows
	Setting Up STEP on Windows
	Setting Up WORLDTAX on Windows

	Installing Taxware Applications on UNIX
	Setting Up Taxware Applications on UNIX
	Setting Up Sales/Use on UNIX
	Setting Up WORLDTAX on UNIX

	Enabling Tax Calculation
	Enabling Tax Calculation with the Sales/Use Tax System
	Enabling Tax Calculation with WORLDTAX

	Taxing Customizable Products
	Taxware Integration with Siebel eSales
	Tax Calculator Business Service
	Integration Objects
	Data Maps
	Taxware Adapter Business Service
	Audit File
	Address Verification for Taxware

	Customizing Taxware Integration
	Passing Data from Other Fields in the Siebel Database
	Passing Data from Fields Not in the Siebel Database
	Calling the Tax Calculator Business Service from Other Places in Siebel eSales
	Calling the Tax Calculator Business Service from Other Business Components
	Using Other Third-Party Taxation Applications

	Handling Unicode Conversion Errors
	Error Prevention
	Defining Required Fields
	Configuring Error Messages


	Using Third-Party Product Availability Management Applications
	Required Setup Procedures
	Checking the Availability Fulfillment Methods
	Setting the ATP Action Parameter in the Quote Business Component User Properties
	Verifying the External ATP Check Business Service User Properties
	Configuring Web Services

	Optional Setup Procedures
	Preventing Rollup of Availability Information
	Extending the ATP Check Interface
	Requiring User Registration
	UI Terms


	Using Third-Party Shipment Tracking Applications
	Required Setup Procedures
	Setting the Shipment Tracking-Package Tracking User Properties
	Verifying the External Shipment Tracking ASI User Properties
	Configuring Web Services

	Optional Setup Procedures
	Extending Returned Data
	Changing the Package Sorting Order
	Turning Off Package Sorting


	Shopping Service API
	User Action Methods
	AddToCart
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm for AddToCart
	Pseudo-Algorithm for DefaultAddToCart
	Pseudo-Algorithm for PostAddToCart

	AddToFavoriteList
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	SetShoppingCart
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	SetApplicationName
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	OrderTemplate
	Expected Preconditions Before the Method Can Be Called
	Pseudo-Algorithm


	Workflow Methods
	SaveCartAsTemplate
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	SaveCartAsQuote
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	DiscardCart
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	OrderQuote
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	ValidQuote
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	RemoveInvalidItems
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	CreateOrder
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	Reorder
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	GetShoppingCartStatus
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	MoveToCart
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	RepriceQuote
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	SelectPrimary
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	SetBusCompFields
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	ValidatePayment
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm

	ValidateAddress
	Expected Preconditions Before the Method Can Be Called
	Arguments
	Pseudo-Algorithm


	Siebel eAuction Integration Methods

	Index

